This user manual includes detailed usage instructions for your camera. Please read this manual thoroughly.
Health and safety information

Always comply with the following precautions and usage tips to avoid dangerous situations and ensure peak performance of your camera.

⚠️ **Warning**—situations that could cause injury to yourself or others

Do not disassemble or attempt to repair your camera.
This may result in electric shock or damage to the camera.

Do not use your camera near flammable or explosive gases and liquids.
This may cause a fire or explosion.

Do not insert flammable materials into the camera or store these materials near the camera.
This may cause a fire or electric shock.

Do not handle your camera with wet hands.
This may result in electric shock.

Prevent damage to subjects’ eyesight.
Do not use the flash in close proximity (closer than 1 m/3 ft) to people or animals. If you use the flash too close to your subject’s eyes, this can cause temporary or permanent eyesight damage.

Keep your camera away from small children and pets.
Keep your camera and all accessories out of the reach of small children and animals. Small parts may cause choking or serious injury if swallowed. Moving parts and accessories may present physical dangers as well.

Do not expose the camera to direct sunlight or high temperatures for an extended period of time.
Prolonged exposure to sunlight or extreme temperatures can cause permanent damage to your camera’s internal components.
Avoid covering the camera or charger with blankets or clothes. The camera may overheat, which may distort the camera or cause a fire.

Do not handle the power supply cord or go near the charger during a thunderstorm. This may result in electric shock.

If liquid or foreign objects enter your camera, immediately disconnect all power sources, such as the battery or charger, and then contact a Samsung service center.

Comply with any regulations that restrict the use of a camera in a certain area.
• Avoid interference with other electronic devices.
• Turn off the camera when in an aircraft. Your camera can cause interference with aircraft equipment. Follow all airline regulations and turn off your camera when directed by airline personnel.
• Turn off the camera near medical equipment. Your camera can interfere with medical equipment in hospitals or health care facilities. Follow all regulations, posted warnings, and directions from medical personnel.

Avoid interference with pacemakers. Maintain a minimum of 15 cm (6 inches) between this camera and all pacemakers to avoid potential interference, as recommended by the manufacturer and the independent research group, Wireless Technology Research. If you have any reason to suspect that your camera is interfering with a pacemaker or other medical device, turn off the camera immediately and contact the manufacturer of the pacemaker or medical device for guidance.
Health and safety information

Caution—situations that could cause damage to your camera or other equipment

Remove the batteries from your camera when storing it for an extended period of time. Installed batteries may leak or corrode over time and cause serious damage to your camera.

Use only authentic, manufacturer-recommended, Lithium-ion replacement batteries. Do not damage or heat the battery. Inauthentic, damaged, or heated batteries may cause a fire or personal injury.

Use only Samsung-approved batteries, chargers, cables and accessories.

- Using unauthorized batteries, chargers, cables or accessories can cause batteries to explode, damage your camera, or cause injury.
- Samsung is not responsible for damage or injuries caused by unapproved batteries, chargers, cables or accessories.

Use the battery only for its intended purpose. Misusing the battery may cause a fire or electric shock.

Do not touch the flash while it fires. The flash is very hot when fired and may burn your skin.

When you use the AC charger, turn off the camera before you disconnect the power to the AC charger. Failing to do so may result in fire or electric shock.

Disconnect the charger from the wall socket when not in use. Failing to do so may result in fire or electric shock.

Do not use a damaged power supply cord, plug, or loose outlet when you charge batteries. This may cause a fire or electric shock.

Do not allow the AC charger to come in contact with the +/- terminals on the battery. This may cause a fire or electric shock.

Do not drop or subject the camera to strong impacts. Doing so may damage the screen or external or internal components.
Exercise caution when you connect cables or adapters and install batteries and memory cards.
If you force the connectors, improperly connect cables, or improperly install batteries and memory cards, you can damage ports, connectors, and accessories.

Keep cards with magnetic strips away from the camera case.
Information stored on the card may be damaged or erased.

Never use a damaged charger, battery, or memory card.
This may result in electric shock or camera malfunction or cause a fire.

Do not place the camera in or near magnetic fields.
Doing so may cause the camera to malfunction.

Do not use the camera if the screen is damaged.
If the glass or acrylic parts are broken, visit a Samsung Electronics Service Center to have the camera repaired.

Check that the camera is operating properly before use.
The manufacturer takes no responsibility for any loss of files or damage that may result from camera malfunction or improper use.

You must plug the small end of the USB cable into your camera.
If the cable is reversed, it may damage your files. The manufacturer is not responsible for any loss of data.

Avoid interference with other electronic devices.
Your camera emits radio frequency (RF) signals that may interfere with unshielded or improperly shielded electronic equipment, such as pacemakers, hearing aids, medical devices, and other electronic devices in homes or vehicles. Consult the manufacturers of your electronic devices to solve any interference problems you experience. To prevent unwanted interference, use only Samsung-approved devices or accessories.

Use your camera in the normal position.
Avoid contact with your camera’s internal antenna.

Data transference and your responsibilities
- Data transferred via WLAN could be leaked, so avoid transferring sensitive data in public areas or on open networks.
- The camera manufacturer is not liable for any data transfers that infringe on copyrights, trademarks, intellectual property laws, or public decency ordinances.
Copyright information

- Microsoft Windows and the Windows logo are registered trademarks of the Microsoft Corporation.
- Mac is a registered trademark of the Apple Corporation.
- microSD™, microSDHC™, and microSDXC™ are registered trademarks of the SD Association.
- HDMI, the HDMI logo and the term “High Definition Multimedia Interface” are trademarks or registered trademarks of HDMI Licensing LLC.
- Wi-Fi®, the Wi-Fi CERTIFIED logo, and the Wi-Fi logo are registered trademarks of the Wi-Fi Alliance.
- Trademarks and trade names used in this manual are the property of their respective owners.

- Camera specifications or contents of this manual may be changed without prior notice due to upgrade of camera functions.
- We recommend using your camera within the country where you purchased it.
- Use this camera responsibly and adhere to all laws and regulations concerning its use.
- You are not allowed to reuse or distribute any part of this manual without prior permission.

Outline of the User Manual

Basic functions 14
Learn about your camera’s layout, icons, and basic functions for shooting.

Extended functions 40
Learn how to capture a photo and record a video by selecting a mode.

Shooting options 64
Learn how to set the options in Shooting mode.

Playback/Editing 95
Learn how to play back photos or videos, and edit photos or videos. Also, learn how to connect your camera to your computer, TV, HDTV, or 3D TV.

Wireless network 126
Learn how to connect to wireless local area networks (WLANs) and use functions.

Settings 148
Refer to options to configure your camera’s settings.

Appendixes 154
Get information about error messages, specifications, and maintenance.
Indicators used in this manual

<table>
<thead>
<tr>
<th>Shooting mode</th>
<th>Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart Auto</td>
<td>SMART</td>
</tr>
<tr>
<td>Program</td>
<td>P</td>
</tr>
<tr>
<td>Aperture Priority</td>
<td>A</td>
</tr>
<tr>
<td>Shutter Priority</td>
<td>S</td>
</tr>
<tr>
<td>Manual</td>
<td>M</td>
</tr>
<tr>
<td>Magic Plus</td>
<td>†</td>
</tr>
<tr>
<td>Movie</td>
<td>‡</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>Wi-Fi</td>
</tr>
</tbody>
</table>

Shooting mode icons
These icons appear in the text when a function is available in a mode. See the example below.
Note: The † mode may not support functions for all scenes or modes.

For example:

**Adjusting the exposure manually (EV)**

Depending on the intensity of the ambient light, your photos may be too bright or dark. In these cases, you can adjust the exposure to get a better photo.

- Darker (-)
- Neutral (0)
- Brighter (+)

Available in Program, Aperture Priority, Shutter Priority, and Movie modes.

Icons used in this manual

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>Additional information</td>
</tr>
<tr>
<td>⚠</td>
<td>Safety warnings and precautions</td>
</tr>
<tr>
<td>[ ]</td>
<td>Camera buttons. For example, [Shutter] represents the shutter button.</td>
</tr>
<tr>
<td>( )</td>
<td>Page number of related information</td>
</tr>
<tr>
<td>→</td>
<td>The order of options or menus you must select to perform a step; for example: Select <strong>Face Detection → Normal</strong> (represents Select <strong>Face Detection</strong>, and then select <strong>Normal</strong>).</td>
</tr>
<tr>
<td>*</td>
<td>Annotation</td>
</tr>
</tbody>
</table>
Expressions used in this manual

Pressing the shutter
- Half-press [Shutter]: press the shutter halfway down
- Press [Shutter]: press the shutter all the way down

Subject, background, and composition
- **Subject**: the main object in a scene, such as a person, animal, or still life
- **Background**: the objects around the subject
- **Composition**: the combination of a subject and background

Exposure (Brightness)
The amount of light that enters your camera determines the exposure. You can alter the exposure with shutter speed, aperture value, and ISO sensitivity. By altering the exposure, your photos will be darker or lighter.
Basic troubleshooting
Learn to solve common problems by setting shooting options.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The subject’s eyes appear red.</td>
<td>Red eye occurs when the subject’s eyes reflect light from the camera flash.</td>
</tr>
<tr>
<td></td>
<td>• Set the flash option to ☻ Red-eye or ☻ Red-eye Fix. (p. 68)</td>
</tr>
<tr>
<td></td>
<td>• If the photo has already been captured, select ☻ Red-eye Fix in the edit menu. (p. 109)</td>
</tr>
<tr>
<td>Photos have dust spots.</td>
<td>If dust particles are present in the air, you may capture them in photos when you use the flash.</td>
</tr>
<tr>
<td></td>
<td>• Turn off the flash or avoid capturing photos in a dusty place.</td>
</tr>
<tr>
<td></td>
<td>• Set ISO sensitivity options. (p. 71)</td>
</tr>
<tr>
<td>Photos are blurred.</td>
<td>Blurring can occur if you capture photos in low light conditions or hold the camera incorrectly.</td>
</tr>
<tr>
<td></td>
<td>Use the Image Stabilization function or half-press [Shutter] to ensure the subject is focused.</td>
</tr>
<tr>
<td></td>
<td>• Select Scene → Night in ✡ mode. (p. 48)</td>
</tr>
<tr>
<td></td>
<td>• Turn on the flash. (p. 69)</td>
</tr>
<tr>
<td></td>
<td>• Set ISO sensitivity options. (p. 71)</td>
</tr>
<tr>
<td></td>
<td>• Use a tripod to prevent your camera from shaking.</td>
</tr>
<tr>
<td>Photos are blurred when shooting at night.</td>
<td>As the camera tries to let in more light, the shutter speed slows. This can make it difficult to</td>
</tr>
<tr>
<td></td>
<td>hold the camera steady long enough to take a clear picture and may result in camera shake.</td>
</tr>
<tr>
<td></td>
<td>• Select Scene → Night in ✡ mode. (p. 48)</td>
</tr>
<tr>
<td></td>
<td>• Turn on the flash. (p. 69)</td>
</tr>
<tr>
<td></td>
<td>• Set ISO sensitivity options. (p. 71)</td>
</tr>
<tr>
<td></td>
<td>• Use a tripod to prevent your camera from shaking.</td>
</tr>
<tr>
<td>Subjects come out too dark because of</td>
<td>When the light source is behind the subject or when there is a high contrast between light and</td>
</tr>
<tr>
<td>backlighting.</td>
<td>dark areas, the subject may appear too dark.</td>
</tr>
<tr>
<td></td>
<td>• Avoid shooting toward the sun.</td>
</tr>
<tr>
<td></td>
<td>• Select Scene → Backlight in ✡ mode. (p. 48)</td>
</tr>
<tr>
<td></td>
<td>• Set the flash option to ☯ Fill in. (p. 69)</td>
</tr>
<tr>
<td></td>
<td>• Adjust the exposure. (p. 82)</td>
</tr>
<tr>
<td></td>
<td>• Set the metering option to ☰ Spot if a subject is in the center of the frame. (p. 84)</td>
</tr>
</tbody>
</table>
Quick reference

Capturing photos of people
• ★ mode > Scene > Beauty Shot ► 49
• ★ mode > Picture in Picture ► 55
• Red-eye/Red-eye Fix (to prevent or correct red-eye) ► 68
• Face Detection ► 77
• Self-Portrait ► 77

Capturing photos at night or in the dark
• ★ mode > Scene > Night, Sunset, Dawn ► 48
• Flash options ► 68
• ISO sensitivity (to adjust the sensitivity to light) ► 71

Capturing action photos
• S mode ► 46
• High-speed burst mode ► 87
• Precapture ► 88

Capturing photos of text, insects, or flowers
• ★ mode > Scene > Text ► 48
• Macro ► 72

Capturing panoramic action photos
• ★ mode > Panorama > Action Panorama ► 52

Adjusting the exposure (brightness)
• ★ mode > HDR ► 57
• ISO sensitivity (to adjust the sensitivity to light) ► 71
• EV (to adjust exposure) ► 82
• Metering ► 84
• WB BKT ► 88
• AE BKT ► 88

Capturing photos of scenery
• ★ mode > Scene > Landscape ► 48
• ★ mode > Panorama ► 50

Capturing 3D photos
• ★ mode > Scene > 3D Photo ► 50
• ★ mode > Panorama > 3D Panorama ► 50

Reducing camera shake
• Image Stabilization ► 37

Applying effects to photos
• ★ mode > Magic Frame ► 53
• ★ mode > Split Shot ► 54
• ★ mode > Artistic Brush ► 56
• Smart Filter effects ► 90
• Image Adjust (to adjust Contrast, Sharpness, or Saturation) ► 93

- Viewing files by category in Smart Album ► 99
- Viewing files as thumbnails ► 100
- Deleting all files on the memory card ► 101
- Viewing files as a slide show ► 104
- Viewing files on a TV, HDTV, or 3D TV ► 112
- Connecting your camera to a computer ► 115
- Using photo or video sharing websites ► 135
- Sending photos or videos via email ► 139
- Adjusting sound and volume ► 150
- Adjusting the brightness of the display ► 150
- Changing the display language ► 150
- Setting the date and time ► 151
- Before contacting a service center ► 170
## Contents

### Basic functions
- Unpacking ............................................. 15
- Camera layout ......................................... 16
  - Using the Smart Link button ......................... 19
  - Using the screen ........................................ 20
  - Attaching a strap ...................................... 20
  - Attaching a lens cap ................................... 21
- Inserting the battery and memory card ................ 22
- Charging the battery and turning on your camera .... 23
  - Charging the battery ................................... 23
  - Turning on your camera ................................ 23
- Performing the initial setup ........................... 24
- Learning icons ......................................... 26
- Using the Mode screen ................................ 27
  - Selecting a Mode Screen .............................. 27
  - Icons on the Mode screen ............................ 27
- Selecting options or menus ............................ 29
  - Using [MENU] ........................................... 29
  - Using [Fn] .............................................. 31
- Setting the display and sound ......................... 32
  - Setting the display type ............................. 32
  - Setting the sound ..................................... 33
- Capturing photos ...................................... 34
  - Zooming .............................................. 35
  - Reducing camera shake ............................... 37
- Tips for getting a clearer photo ...................... 38

### Extended functions
- Using the Smart Auto mode .......................... 41
- Using the Program mode .............................. 43
- Using the Aperture Priority, Shutter Priority, or Manual mode .......................... 44
  - Using the Aperture Priority mode .................... 45
  - Using the Shutter Priority mode ..................... 46
  - Using the Manual mode ................................ 47
- Using the Magic Plus mode .......................... 48
  - Using the Scene mode ................................ 48
  - Using the Beauty Shot mode ......................... 49
  - Using the 3D Photo mode ............................ 50
  - Using the 2D or 3D Panorama mode .................. 50
  - Using the Action Panorama mode .................... 52
  - Using the Magic Frame mode ....................... 53
  - Using the Split Shot mode ........................... 54
  - Using the Picture-in-Picture mode ................... 55
  - Using the Artistic Brush mode ....................... 56
  - Using the HDR mode ................................. 57
  - Using the Creative Movie Maker mode ................ 58
- Using the Movie mode ................................ 60
  - Recording high-speed videos ....................... 62
  - Using the Smart Scene Detection mode ............... 63
# Contents

**Shooting options** .............................................................. 64
  Selecting a resolution and quality ........................................... 65
    Selecting a resolution ......................................................... 65
    Setting the photo quality .................................................... 66
  Using the timer ...................................................................... 67
**Shooting in the dark** ............................................................ 68
  Preventing red-eye ................................................................. 68
  How to use the flash .................................................................. 68
  Using the flash .......................................................................... 69
  Adjusting the ISO sensitivity ..................................................... 71
**Changing the camera’s focus** .................................................. 72
  Using macro ............................................................................. 72
  Using auto focus ....................................................................... 72
  Focusing on a selected area ...................................................... 74
  Using tracking auto focus .......................................................... 75
  Adjusting the focus area ............................................................ 76

**Using Face Detection** ............................................................ 77
  Detecting faces .......................................................................... 77
  Capturing a self portrait shot ..................................................... 77
  Capturing a smile shot ............................................................... 78
  Detecting eye blinking ............................................................... 79
  Using Smart Face Recognition ................................................... 79
  Registering faces as your favorites (My Star) .............................. 80
  Tips for detecting faces ............................................................ 81

**Adjusting brightness and color** ............................................... 82
  Adjusting the exposure manually (EV) ........................................ 82
  Locking the exposure value ....................................................... 83
  Changing the metering option .................................................... 84
  Selecting a White Balance setting .............................................. 84

**Using burst modes** ................................................................. 87
  Capturing photos in the High-speed burst mode ............................ 87
  Capturing photos in the Precapture mode ................................... 88
  Capturing bracketed photos ...................................................... 88

**Applying Smart Filter effects** ................................................ 90
**Applying the ND filter effect** ................................................ 92
**Adjusting your photos** .......................................................... 93
**Reducing the sound of the zoom** ............................................ 94
Playback/Editing ............................................................... 95
  Viewing photos or videos in Playback mode ............. 96
    Starting Playback mode ...................................... 96
    Viewing photos ............................................. 102
    Playing a video ............................................. 105
  Editing a photo .................................................. 107
    Resizing photos ............................................ 107
    Rotating a photo ............................................ 107
    Applying Smart Filter effects ............................. 108
    Adjusting your photos ................................... 109
    Creating a print order (DPOF) ............................ 110
  Viewing files on a TV, HDTV, or 3D TV ............... 112
  Transferring files to your computer .................. 115
    Transferring files to your Windows OS computer ...... 115
    Transferring files to your Mac OS computer ........... 116
  Using programs on the computer ....................... 117
    Installing CD-provided programs ....................... 117
    Using iLauncher ............................................ 118
    Using Samsung RAW Converter ........................... 121

Wireless network .......................................................... 126
  Connecting to a WLAN and configuring network settings ........................................ 127
    Connecting to a WLAN ..................................... 127
    Using the login browser ................................... 129
    Network connection tips .................................. 129
    Entering text .................................................. 130
  Sending photos or videos to a smart phone ........... 132
  Using a smart phone as a remote shutter release .... 133
  Using photo or video sharing websites ................. 135
    Accessing a website ....................................... 135
    Uploading photos or videos .............................. 135
  Sending photos or videos via email .................... 137
    Changing email settings ................................... 137
    Sending photos or videos via email .................... 139
  Uploading photos to a cloud server .................... 140
  Using Auto Backup to send photos or videos ........ 141
    Installing the program for Auto Backup on your PC 141
    Sending photos or videos to a PC ....................... 141
  Viewing photos or videos on a TV Link-enabled TV .......... 143
  Sending photos using Wi-Fi Direct ..................... 145
  About the Wake on LAN (WOL) feature .................. 146
Contents

Settings ................................................................. 148
  Settings menu .................................................. 149
    Accessing the settings menu ......................... 149
    Using the settings menu ................................. 150

Appendixes .......................................................... 154
  Error messages ............................................... 155
  Camera maintenance ......................................... 157
    Cleaning your camera ..................................... 157
    Using or storing the camera ............................. 158
    About memory cards ...................................... 160
    About the battery .......................................... 163
  Using optional accessories ............................... 167
    Using optional flash units ......................... 167
    Using an optional optical viewfinder .............. 167
    Using an optional conversion lens ............... 168
    Using the shutter release ......................... 169
    Using the microphone .................................. 169
  Before contacting a service center ................ 170
  Camera specifications ...................................... 173
  Glossary ....................................................... 178
  FCC notice ..................................................... 183
  Declaration sentence in official languages ....... 186
  Index ............................................................. 188
Basic functions
Learn about your camera’s layout, icons, and basic functions for shooting.

Unpacking ........................................... 15
Camera layout ................................. 16
   Using the Smart Link button ............. 19
   Using the screen ......................... 20
   Attaching a strap ......................... 20
   Attaching a lens cap ..................... 21
Inserting the battery and memory card  ... 22
Charging the battery and turning on your camera  .... 23
   Charging the battery ................... 23
   Turning on your camera ............... 23
Performing the initial setup ............... 24
Learning icons .............................. 26
Using the Mode screen ...................... 27
   Selecting a Mode Screen ............... 27
   Icons on the Mode screen ............. 27
Selecting options or menus ............... 29
   Using [MENU] ......................... 29
   Using [Fn] ............................. 31
Setting the display and sound .......... 32
   Setting the display type .............. 32
   Setting the sound .................... 33
Capturing photos ......................... 34
   Zooming ............................. 35
   Reducing camera shake .............. 37
Tips for getting a clearer photo ......... 38
Unpacking

The following items are included in your product box.

- Camera
- AC adapter/USB cable
- Rechargeable battery
- Strap
- User Manual CD-ROM
- Quick Start Guide
- Lens cap/Lens cap strap

Optional accessories

- Optical viewfinder
- Flash
- Camera case
- HDMI cable/AV cable
- Battery charger
- Memory card
- Memory card/Memory card adapter
- Microphone
- Shutter release

• The illustrations may differ slightly from the items shipped with your product.
• You can purchase optional accessories at a retailer or a Samsung service center. Samsung is not responsible for any problems caused by using unauthorized accessories.
Before you start, familiarize yourself with your camera’s parts and their functions.

Camera layout

- **Drive mode dial** (p. 19)
- **Mode dial** (p. 18)
- **Shutter button**
- **Microphone**
- **Lens**
- **AF-assist light/Timer lamp**
- **Front wheel**
- **Battery chamber cover**
- **POWER button**
- **Flash**
- **Eyelet for camera strap** (p. 20)
- **Camera ring**
- **Camera ring**
- **Internal antenna***
  - Avoid contact with the internal antenna while using the wireless network.
- **Tripod mount**

* Insert a memory card and battery.
Basic functions

**Status lamp**

- **Blinking**: When the camera is saving a photo or video, being read by a computer, when the image is out of focus, there is a problem charging the battery, when the camera is connecting to WLAN or sending a photo, or when the Auto Display Off mode is activated.
- **Steady**: When the camera is connected to a computer, charging the battery, or when the image is in focus.

**Zoom button**

- **In Shooting mode**: Zoom in or out
- **In Playback mode**: Zoom in on part of a photo or view files as thumbnails, or adjust the volume.

**Accessories**

- ** occasionally shoe cover**
- **Flash release**
- **Display**
- **Buttons (p. 18)**
- **USB and A/V port**
  Accepts USB cable and A/V cable
- **HDMI port**
  Accepts HDMI cable
Camera layout

Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start recording a video.</td>
<td></td>
</tr>
<tr>
<td>Lock the adjusted exposure value in Shooting mode.</td>
<td></td>
</tr>
<tr>
<td>Protect the displayed file in Playback mode.</td>
<td></td>
</tr>
<tr>
<td>Access options or menus.</td>
<td></td>
</tr>
<tr>
<td>Access options in Shooting mode.</td>
<td></td>
</tr>
</tbody>
</table>

When pressing the navigation button:

<table>
<thead>
<tr>
<th>Basic functions</th>
<th>Other functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISP</td>
<td>Change the display option.</td>
</tr>
<tr>
<td>Change the macro option.</td>
<td></td>
</tr>
<tr>
<td>Change the flash option.</td>
<td></td>
</tr>
<tr>
<td>Smart Link button: Launch a preset Wi-Fi function.</td>
<td></td>
</tr>
<tr>
<td>Move up</td>
<td></td>
</tr>
<tr>
<td>Move down</td>
<td></td>
</tr>
<tr>
<td>Move left</td>
<td></td>
</tr>
<tr>
<td>Move right</td>
<td></td>
</tr>
</tbody>
</table>

When rotating the navigation button:

- Scroll to an option or menu.
- Adjust the aperture value in Shooting mode.
- Scroll through files in Playback mode.

OK

Confirm the highlighted option or menu.

Enter Playback mode.

Delete files in Playback mode.

Mode dial

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART</td>
<td>Smart Auto: Capture a photo with a scene mode selected automatically by the camera.</td>
</tr>
<tr>
<td>Program: Capture a photo by setting options except the shutter speed and aperture value which the camera sets automatically.</td>
<td></td>
</tr>
<tr>
<td>Aperture Priority: The camera selects a shutter speed based on the aperture value you have set manually.</td>
<td></td>
</tr>
<tr>
<td>Shutter Priority: The camera selects an aperture value based on the shutter speed you have set manually.</td>
<td></td>
</tr>
<tr>
<td>Manual: Adjust various camera settings including shutter speed and aperture value.</td>
<td></td>
</tr>
<tr>
<td>Magic Plus: Capture a photo with various effects.</td>
<td></td>
</tr>
<tr>
<td>Movie: Customize settings to record a video.</td>
<td></td>
</tr>
<tr>
<td>Wi-Fi: Connect to wireless local area networks and use functions.</td>
<td></td>
</tr>
</tbody>
</table>
**Camera layout**

### Drive mode dial

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Capture a single photo.</td>
</tr>
<tr>
<td>2</td>
<td>Capture a photo after a 2-second delay.</td>
</tr>
<tr>
<td>10</td>
<td>Capture a photo after a 10-second delay.</td>
</tr>
</tbody>
</table>
| BKT | According to a bracketing option,  
• Capture 3 photos with different white balance.  
• Capture 3 photos with different exposures. |
| ![Icon] | In Shooting mode, the camera captures up to 10 photos consecutively while you are pressing [Shutter].  
• In Video recording mode, the camera records high-speed videos. |
| ![Icon] | Capture shots before pressing [Shutter] all the way down. |

### Using the Smart Link button

You can turn on the Wi-Fi feature conveniently with [Smart Link].

- Press [Smart Link] to activate the Wi-Fi function that you have designated. The camera will activate the designated function.

### Setting a Smart Link button option

You can select a Wi-Fi function to launch when you press [Smart Link].

1. In Shooting or Playback mode, press [MENU].
2. Select ![Icon] → Smart Link (Wi-Fi Button).
3. Select a desired Wi-Fi feature. (p. 152)
Camera layout

Using the screen
Swing the screen outwards 180° and rotate it up or down for high- and low-angle photos or self portraits. You can rotate the screen a maximum of 90° downward or 180° upward.

Attaching a strap
Attach a strap to carry your camera conveniently.

- Fold the screen when not in use.
- Rotate the screen only within the angle allowed. Or, the camera may be damaged.
Camera layout

Attaching a lens cap
Attach a lens cap with a lens cap strap to protect the camera lens.

If you want to attach a lens cap and strap at the same time, first attach the strap to the eyelet, and then attach the lens cap to the camera strap.
Inserting the battery and memory card

Learn how to insert the battery and an optional memory card into the camera.

**Inserting the battery and memory card**

Insert a memory card with the gold-colored contacts facing down.

Insert the battery with the Samsung logo facing down.

**Removing the battery and memory card**

Push the card gently until it disengages from the camera, and then pull it out of the slot.

Slide the lock down to release the battery.

**Using the memory card adapter**

To use micro memory cards with this product, a PC, or a memory card reader, insert the card into an adapter.

If a memory card is not inserted, you cannot use your camera properly. Insert a memory card before using the camera.
Charging the battery and turning on your camera

Charging the battery
Before you use the camera for the first time, you must charge the battery. Plug the small end of the USB cable into your camera, and then plug the other end of the USB cable into the AC adapter.

Turning on your camera
Press [POWER] to turn your camera on or off.
- The initial setup screen appears when you turn on the camera for the first time. (p. 24)

Turning on your camera in Playback mode
Press [P]. The camera turns on and immediately accesses Playback mode.

Status lamp
- Red light on: Charging
- Red light off: Fully charged
- Red light blinking: Error

Use only the AC adapter and USB cable supplied with your camera. If you use another AC adapter (such as SAC-48), the camera battery may not charge or work properly.

If you turn on your camera by pressing and holding [P] for about 5 seconds, the camera does not emit any sounds.
Performing the initial setup

When you turn on your camera for the first time, the initial setup screen appears. Follow the steps below to configure the camera’s basic settings. The language is preset for the country or region where the camera is sold. You can change the language as desired.

1. Press [ DISP] to select Time Zone, and then press [ OK].

2. Press [DISP/ ] to select Home, and then press [ OK].
   - When you travel to another country, select Visit, and then select a new time zone.

3. Press [ / ] to select a time zone, and then press [OK].
   - To set daylight-savings time, press [DISP].

4. Press [ ] to select Date/Time Set, and then press [ ] or [OK].

5. Press [ / ] to select an item.

6. Rotate the navigation button or press [DISP/ ] to set the date and time, and then press [OK].
Performing the initial setup

7 Press [ cautious] to select **Date Type**, and then press [ cautious] or [OK].

8 Press [DISP/ cautious] to select a date type, and then press [OK].

9 Press [ cautious] to select **Time Type**, and then press [ cautious] or [OK].

10 Press [DISP/ cautious] to select a time type, and then press [OK].

11 Press [MENU] to switch to Shooting mode.
# Learning icons

The icons the camera displays on the screen change according to the mode you select or the options you set after blinking in yellow.

## 1 Shooting options (left)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Shooting mode" /></td>
<td>Shooting mode</td>
</tr>
<tr>
<td><img src="image" alt="ISO sensitivity" /></td>
<td>ISO sensitivity</td>
</tr>
<tr>
<td><img src="image" alt="White balance" /></td>
<td>White balance</td>
</tr>
<tr>
<td><img src="image" alt="Smart filter" /></td>
<td>Smart filter</td>
</tr>
<tr>
<td><img src="image" alt="Image adjustment" /></td>
<td>Image adjustment (contrast, sharpness, and saturation)</td>
</tr>
<tr>
<td><img src="image" alt="Face detection" /></td>
<td>Face detection</td>
</tr>
<tr>
<td><img src="image" alt="Face retouch" /></td>
<td>Face retouch</td>
</tr>
<tr>
<td><img src="image" alt="Face tone" /></td>
<td>Face tone</td>
</tr>
<tr>
<td><img src="image" alt="Single shot mode" /></td>
<td>Single shot mode</td>
</tr>
<tr>
<td><img src="image" alt="High-speed burst mode" /></td>
<td>High-speed burst mode</td>
</tr>
<tr>
<td><img src="image" alt="Precapture mode" /></td>
<td>Precapture mode</td>
</tr>
</tbody>
</table>

## 2 Shooting options (right)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bracket mode" /></td>
<td>Bracket mode</td>
</tr>
<tr>
<td><img src="image" alt="ND filter on" /></td>
<td>ND filter on</td>
</tr>
<tr>
<td><img src="image" alt="Focus area" /></td>
<td>Focus area</td>
</tr>
<tr>
<td><img src="image" alt="Continuous Auto Focus on" /></td>
<td>Continuous Auto Focus on</td>
</tr>
<tr>
<td><img src="image" alt="Photo quality" /></td>
<td>Photo quality</td>
</tr>
<tr>
<td><img src="image" alt="Video resolution" /></td>
<td>Video resolution</td>
</tr>
<tr>
<td><img src="image" alt="Metering" /></td>
<td>Metering</td>
</tr>
<tr>
<td><img src="image" alt="Frame rate" /></td>
<td>Frame rate</td>
</tr>
<tr>
<td><img src="image" alt="Flash" /></td>
<td>Flash</td>
</tr>
<tr>
<td><img src="image" alt="Sound Alive on" /></td>
<td>Sound Alive on</td>
</tr>
<tr>
<td><img src="image" alt="Optical Image Stabilization (OIS)" /></td>
<td>Optical Image Stabilization (OIS)</td>
</tr>
<tr>
<td><img src="image" alt="Auto focus option" /></td>
<td>Auto focus option</td>
</tr>
<tr>
<td><img src="image" alt="Timer" /></td>
<td>Timer</td>
</tr>
</tbody>
</table>

## 3 Shooting information

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Aperture value" /></td>
<td>F3.2</td>
</tr>
<tr>
<td><img src="image" alt="Shutter speed" /></td>
<td>1/30</td>
</tr>
<tr>
<td><img src="image" alt="Available recording time" /></td>
<td>00:00:10</td>
</tr>
<tr>
<td><img src="image" alt="Exposure value" /></td>
<td>REL</td>
</tr>
<tr>
<td><img src="image" alt="Available number of photos" /></td>
<td>1</td>
</tr>
<tr>
<td><img src="image" alt="Memory card not inserted" /></td>
<td>NO CARD</td>
</tr>
<tr>
<td><img src="image" alt="Fully charged" /></td>
<td>•</td>
</tr>
<tr>
<td><img src="image" alt="Partially charged" /></td>
<td>•</td>
</tr>
<tr>
<td><img src="image" alt="Empty (Recharge)" /></td>
<td>•</td>
</tr>
<tr>
<td><img src="image" alt="Charger connected*" /></td>
<td>•</td>
</tr>
<tr>
<td><img src="image" alt="Current time and date" /></td>
<td>2012/07/01 10:00 AM</td>
</tr>
<tr>
<td><img src="image" alt="Auto focus frame" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Camera shake" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Zoom indicator" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Zoom ratio" /></td>
<td>X132</td>
</tr>
<tr>
<td><img src="image" alt="Histogram (p. 32)" /></td>
<td></td>
</tr>
</tbody>
</table>

* The battery will not charge if the camera is on.
Using the Mode screen

Select a Mode Screen by turning the mode dial, and then select a mode in the Mode Screen by selecting an icon.

Selecting a Mode Screen
In Shooting or Playback mode, turn the mode dial to display a Mode Screen.

Icons on the Mode screen

<Magic Plus>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Scene icon" /></td>
<td><strong>Scene</strong>: Capture a photo with options that are preset for a specific scene. (p. 48)</td>
</tr>
<tr>
<td><img src="image" alt="Panorama icon" /></td>
<td><strong>Panorama</strong>: Capture and combine a series of photos to create a panoramic image. (p. 50)</td>
</tr>
<tr>
<td><img src="image" alt="Magic Frame icon" /></td>
<td><strong>Magic Frame</strong>: Capture a photo with various frame effects. (p. 53)</td>
</tr>
<tr>
<td><img src="image" alt="Split Shot icon" /></td>
<td><strong>Split Shot</strong>: Capture several photos and arrange them with preset layouts. (p. 54)</td>
</tr>
<tr>
<td><img src="image" alt="Picture in Picture icon" /></td>
<td><strong>Picture in Picture</strong>: Capture a background photo and insert a smaller photo or video into the foreground. (p. 55)</td>
</tr>
<tr>
<td><img src="image" alt="Artistic Brush icon" /></td>
<td><strong>Artistic Brush</strong>: Capture a photo and view and save a video that shows how to apply the filter effect. (p. 56)</td>
</tr>
<tr>
<td><img src="image" alt="HDR icon" /></td>
<td><strong>HDR</strong>: Capture scenes with emphasis on mid-tones, by minimizing the dark and bright areas. (p. 57)</td>
</tr>
<tr>
<td><img src="image" alt="Creative Movie Maker icon" /></td>
<td><strong>Creative Movie Maker</strong>: Create a movie simply with photos or videos. (p. 58)</td>
</tr>
</tbody>
</table>

No. | Description |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current Mode screen&lt;br&gt;• Rotate the mode dial to go to another mode screen.</td>
</tr>
<tr>
<td>2</td>
<td>Mode icons&lt;br&gt;• Rotate the navigation button or press [DISP/ / / / ] to scroll to a desired mode, and then press [OK] to access the mode.</td>
</tr>
</tbody>
</table>
## Using the Mode screen

### <Wi-Fi>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="MobileLink" /></td>
<td><strong>MobileLink</strong>: Send photos or videos to a smart phone. (p. 132)</td>
</tr>
<tr>
<td><img src="image" alt="Remote Viewfinder" /></td>
<td><strong>Remote Viewfinder</strong>: Use a smart phone as a remote shutter release and see a preview on your smart phone of an image from your camera. (p. 133)</td>
</tr>
<tr>
<td><img src="image" alt="Social Sharing" /></td>
<td><strong>Social Sharing</strong>: Upload photos or videos to file sharing websites. (p. 135)</td>
</tr>
<tr>
<td><img src="image" alt="Email" /></td>
<td><strong>Email</strong>: Send photos or videos stored on the camera via email. (p. 139)</td>
</tr>
<tr>
<td><img src="image" alt="Cloud" /></td>
<td><strong>Cloud</strong>: Upload photos to a cloud server. (p. 140)</td>
</tr>
<tr>
<td><img src="image" alt="Auto Backup" /></td>
<td><strong>Auto Backup</strong>: Send photos or videos that you captured with the camera to a PC wirelessly. (p. 141)</td>
</tr>
<tr>
<td><img src="image" alt="TV Link" /></td>
<td><strong>TV Link</strong>: View photos or videos that you captured with the camera on a widescreen TV. (p. 143)</td>
</tr>
</tbody>
</table>
## Selecting options or menus

To select an option or a menu, press [MENU] or [Fn].

### Using [MENU]

To select options, press [MENU], and then rotate the navigation button or press [DISP/①/②/③] or [OK].

1. In Shooting mode, press [MENU].

2. Rotate the navigation button or press [DISP/①/②/③] to scroll to a menu or an option.

3. Press [OK] to confirm the highlighted option or menu.

### Going back to the previous menu

Press [MENU] again to go back to the previous menu.

- Half-press [Shutter] to return to Shooting mode.
For example, to select a White Balance option in Program mode:

1Rotate the mode dial to P.

2Press [MENU].

3Rotate the navigation button or press [DISP/ ‡] to select ♂, and then press [ ‡] or [OK].

4Rotate the navigation button or press [DISP/ ‡] to select White Balance, and then press [ ‡] or [OK].

5Rotate the navigation button or the front wheel, or press [∥/ ‡] to select a White Balance option.

6Press [OK] to save your settings.

7Press [MENU] to return to Shooting mode.
Using [Fn]
You can access shooting options by pressing [Fn], but some options are not available.

For example, to select a White Balance option in Program mode:

1. Rotate the mode dial to P.

2. Press [Fn].

3. Rotate the navigation button or press [DISP/]// to scroll to .

4. Rotate the front wheel to adjust a White Balance option.

   - Press [OK], rotate the navigation button or press [DISP/]/, and then press [OK] to save your settings.

5. Press [MENU] to return to Shooting mode.
Setting the display and sound

Learn how to change the basic display information and sound settings.

Setting the display type

You can select a display type for the Shooting or Playback mode. Each type displays different shooting or playback information. See the table below.

Press [DISP] repeatedly to change the display type.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Display type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Hide all information about shooting.</td>
</tr>
<tr>
<td></td>
<td>• Hide information about shooting, except the information on the top line.</td>
</tr>
<tr>
<td></td>
<td>• Display all information about shooting.</td>
</tr>
<tr>
<td></td>
<td>• Display histogram.</td>
</tr>
<tr>
<td>Shooting</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hide all information about the current file.</td>
</tr>
<tr>
<td></td>
<td>• Display information about the current file, except the shooting settings and histogram.</td>
</tr>
<tr>
<td></td>
<td>• Display all information about the current file.</td>
</tr>
<tr>
<td>Playback</td>
<td></td>
</tr>
</tbody>
</table>

About histograms

A histogram is a graph that illustrates how light is distributed in your photo. If the histogram has a high peak on the left, the photo is underexposed and will appear dark. A peak on the right of the graph means that the photo is overexposed and will appear washed out. The height of the peaks is related to color information. The more of a particular color, the taller the peak.

- ▲ Under-exposed
- ▲ Well-exposed
- ▲ Over-exposed
Setting the display and sound

Setting the option display view
You can hide or show the option display appearing in the Magic plus mode.

- Hide the option display.
- Show the option display.

Setting the sound
Turn on or off the sound your camera emits when you perform functions.

1 In Shooting or Playback mode, press [MENU].
2 Select [ ] → Sounds → Beep Sound.
3 Select an option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The camera does not emit any sounds.</td>
</tr>
<tr>
<td>On</td>
<td>The camera emits sounds.</td>
</tr>
</tbody>
</table>

▲ For example, in Scene mode
Capturing photos
Learn how to capture photos easily and quickly in Smart Auto mode.

1 Rotate the mode dial to **SMART**.

2 Align your subject in the frame.

3 Half-press [Shutter] to focus.
   - A green frame means the subject is in focus.
   - A red frame means the subject is out of focus.

4 Press [Shutter] to capture a photo.

5 Press [ ] to view the captured photo.
   - To delete the photo, press [ ], and then select **Yes**.

6 Press [ ] to return to Shooting mode.

See page 38 for tips to get clearer photos.
Capturing photos

### Zooming
You can capture close-up photos by adjusting the zoom.

![Zooming illustration]

#### Digital zoom

The Digital zoom is supported by default in Shooting mode. If you zoom in on a subject in Shooting mode and the zoom indicator is in the digital range, your camera is using the Digital zoom. By using both the 3.3X Optical zoom and 4X Digital zoom, you can zoom in up to 13.2 times.

#### Notes:
- The Digital zoom is not available with the Face detection option, Smart Filter effect, Tracking AF option, or Manual Focus.
- If you capture a photo with the Digital zoom, the photo quality may be lower than normal.

- The wider you rotate the zoom button, the faster the camera zooms in or out.
- When you rotate the zoom button, the zoom ratio shown on the screen may change inconsistently.
Capturing photos

**Smart zoom**

You can use 4.4X Smart zoom which lets you zoom in with less degradation of picture quality than the Optical zoom and Digital zoom. By using the Optical zoom, Smart zoom, and Digital zoom, you can zoom in up to 13.2 times.

- **Optical range + Smart range**
- **Digital range**

Smart zoom is not available with the Face detection option, Smart Filter effect, Tracking AF option, or Manual Focus.

- You cannot use this function when the drive mode dial is set to Continuous, Precapture, or Bracket.
- If you capture a photo with the Smart zoom, the photo quality may be lower than normal.

**Setting Smart zoom**

1. In Shooting mode, press [MENU].
2. Select 📷 → Smart Zoom.
3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷 🟢</td>
<td>Off: The Smart zoom is deactivated.</td>
</tr>
<tr>
<td>📷 🟡</td>
<td>On: The Smart zoom is activated.</td>
</tr>
</tbody>
</table>
Capturing photos

Reducing camera shake

Reduce camera shake and prevent blurred photos with Optical and Digital Image Stabilization functions.

1. In Shooting mode, press [MENU].
2. Select 📸 or 🦄 → Image Stabilizer.
3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🦄</td>
<td>Off: Optical Image Stabilization function is deactivated.</td>
</tr>
<tr>
<td>🦄</td>
<td>OIS: Optical Image Stabilization function is activated.</td>
</tr>
<tr>
<td>🦄</td>
<td>DUAL IS: Optical and Digital Image Stabilization functions are activated.</td>
</tr>
</tbody>
</table>

Available options may differ depending on the shooting conditions.

- Image Stabilization function may not function properly when:
  - you move your camera to follow a moving subject
  - you use the Digital zoom
  - there is too much camera shake
  - the shutter speed is slow (for example, when you capture night scenes)
  - the battery is low
  - you capture a close-up shot
- If you use the Image Stabilization function with a tripod, your images may be blurred by the vibration of the Image Stabilization sensor. Deactivate the Image Stabilization function when you use a tripod.
- If the camera is hit or dropped, the display will be blurry. If this occurs, turn off the camera, and then turn it on again.
Tips for getting a clearer photo

😊 Holding your camera correctly

Ensure nothing is blocking the lens, flash, or microphone.

😊 Half-pressing the shutter button

Half-press [Shutter] and adjust the focus. The camera adjusts the focus and exposure automatically.

The camera sets the aperture value and shutter speed automatically.

Focus frame
- Press [Shutter] to capture the photo if the focus frame appears in green.
- Change the composition and half-press [Shutter] again if the focus frame appears in red.

😊 Reducing camera shake

Set the Image Stabilization option to reduce camera shake optically. (p. 37)

😊 When 🥇 is displayed

Camera shake

When you shoot in the dark, avoid setting the flash option to Slow Sync or Off. The aperture remains open longer and it may be harder to hold the camera steady long enough to capture a clear photo.
- Use a tripod or set the flash option to Fill in. (p. 69)
- Set ISO sensitivity options. (p. 71)
Preventing your subject from being out of focus

It may be difficult to get your subject in focus when:
- there is little contrast between the subject and background (for example, when your subject is wearing clothing that is similar in color to the background)
- the light source behind the subject is too bright
- the subject is shiny or reflective
- the subject includes horizontal patterns, such as blinds
- the subject is not positioned in the center of the frame

Using the focus lock

Half-press [Shutter] to focus. When the subject is in focus, you can reposition the frame to change the composition. When you are ready, press [Shutter] to capture your photo.

• When you capture photos in low light
  Turn on the flash. (p. 69)

• When subjects are moving rapidly
  Use the High-speed burst mode or Precapture function. (p. 87)
Extended functions
Learn how to capture a photo and record a video by selecting a mode.

Using the Smart Auto mode .................. 41
Using the Program mode .................. 43
Using the Aperture Priority, Shutter Priority, or Manual mode .......... 44
  Using the Aperture Priority mode .......... 45
  Using the Shutter Priority mode .......... 46
  Using the Manual mode .......... 47
Using the Magic Plus mode ................. 48
  Using the Scene mode ................. 48
  Using the Beauty Shot mode ................. 49
  Using the 3D Photo mode ................. 50
Using the 2D or 3D Panorama mode ...... 50
Using the Action Panorama mode ........ 52
Using the Magic Frame mode .......... 53
Using the Split Shot mode .......... 54
Using the Picture-in-Picture mode .......... 55
Using the Artistic Brush mode .......... 56
Using the HDR mode .......... 57
Using the Creative Movie Maker mode ...... 58
Using the Movie mode .................. 60
  Recording high-speed videos ............. 62
  Using the Smart Scene Detection mode ... 63
Using the Smart Auto mode

In Smart Auto mode, your camera automatically chooses the appropriate camera settings based on the type of scene it detects. The Smart Auto mode is helpful if you are not familiar with the camera settings for various scenes.

1. Rotate the mode dial to **SMART**.

2. Align your subject in the frame.
   - The camera automatically selects a scene. An appropriate scene icon appears at the top left of the screen. The icons are listed below.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Portraits with backlighting</td>
</tr>
<tr>
<td>🧑‍🎨</td>
<td>Portraits</td>
</tr>
<tr>
<td>🌿</td>
<td>Close-up photos of objects</td>
</tr>
<tr>
<td>📽️</td>
<td>Close-up photos of text</td>
</tr>
<tr>
<td>🍃</td>
<td>Sunsets</td>
</tr>
<tr>
<td>🌊</td>
<td>Blue skies</td>
</tr>
<tr>
<td>🌳</td>
<td>Forested areas</td>
</tr>
<tr>
<td>🌤️</td>
<td>Close-up photos of colorful subjects</td>
</tr>
<tr>
<td>🕒</td>
<td>Camera is stabilized or on a tripod (when shooting in the dark)</td>
</tr>
<tr>
<td>⚽️</td>
<td>Actively moving subjects</td>
</tr>
<tr>
<td>🎆</td>
<td>Fireworks (when using a tripod)</td>
</tr>
<tr>
<td>🕰️</td>
<td>Indoors, dark</td>
</tr>
<tr>
<td>🔌</td>
<td>Partially lit</td>
</tr>
<tr>
<td>🕒</td>
<td>Close-up with spot lighting</td>
</tr>
<tr>
<td>🧑‍🎨</td>
<td>Portraits with spot lighting</td>
</tr>
</tbody>
</table>
3 Half-press [Shutter] to focus.

4 Press [Shutter] to capture the photo.

- If the camera does not recognize an appropriate scene mode, it uses the default settings for the SMART mode.
- Even if it detects a face, the camera may not select a portrait mode depending on the subject's position or lighting.
- The camera may not select the correct scene depending on the shooting conditions, such as camera shake, lighting, or distance to the subject.
- Even if you use a tripod, the camera may not detect the mode if the subject is moving.
- In SMART mode, the camera consumes more battery power, because it changes settings often to select appropriate scenes.
Using the Program mode

In Program mode, you can set most options, except the shutter speed and aperture value, which the camera sets automatically.

1 Rotate the mode dial to P.

2 Set the desired options.
   - For a list of options, refer to "Shooting options". (p. 64)

3 Align your subject in the frame, and then half-press [Shutter] to focus.

4 Press [Shutter] to capture the photo.
Using the Aperture Priority, Shutter Priority, or Manual mode

Adjust the aperture value or shutter speed to control the exposure of your photos. You can use these options in the Aperture Priority, Shutter Priority, and Manual modes.

Aperture value
The aperture is a hole that lets light into the camera. The aperture housing contains thin, metal plates that open and close, widening or narrowing the aperture, and controlling the amount of light that enters the camera. The size of the aperture is closely related to the brightness of a photo: the larger the aperture, the brighter the photo; the smaller the aperture, the darker the photo. Note that the larger the aperture value, the smaller the aperture size. For example, an aperture set to 5.6 is larger than an aperture set to 11.

Shutter speed
Shutter speed, which is an important factor in the brightness of a photo, refers to the amount of time it takes to open and close the shutter. A slow shutter speed allows more time to let light in. All things being equal, photos are brighter, but fast moving objects tend to blur. On the other hand, a fast shutter speed allows less time to let light in. Photos are darker, but objects in motion are captured more clearly.

▲ Slow shutter speed  ▲ Fast shutter speed
Using the Aperture Priority mode

The Aperture Priority mode allows you to set the aperture value manually while the camera automatically selects an appropriate shutter speed.

1 Rotate the mode dial to A.

2 Rotate the navigation button to adjust the aperture value.
   • See page 44 for more information about the aperture value.

3 Set options.
   • For a list of options, refer to “Shooting options”. (p. 64)

4 Align your subject in the frame, and then half-press [Shutter] to focus.

5 Press [Shutter] to capture the photo.

When you set the ISO option to Auto, the shutter speed may not change automatically to match the aperture value. In this case, the camera finds an appropriate exposure value by changing the ISO option automatically when you capture a photo. To set the ISO option manually, press [MENU], and then select ISO → an option.
Using the Aperture Priority, Shutter Priority, or Manual mode

Using the Shutter Priority mode
The Shutter Priority mode allows you to set the shutter speed manually while the camera automatically selects an appropriate aperture value.

1 Rotate the mode dial to S.

2 Rotate the front wheel to adjust the shutter speed.
   • See page 44 for more information about the shutter speed.

3 Set options.
   • For a list of options, refer to “Shooting options”. (p. 64)

4 Align your subject in the frame, and then half-press [Shutter] to focus.

5 Press [Shutter] to capture the photo.

When you set the ISO option to Auto, the aperture value may not change automatically to match the shutter speed. In this case, the camera finds an appropriate exposure value by changing the ISO option automatically when you capture a photo. To set the ISO option manually, press [MENU], and then select [ISO] → an option.
Using the Manual mode

The Manual mode allows you to adjust both the aperture value and the shutter speed manually.

1 Rotate the mode dial to M.
2 Rotate the front wheel to adjust the shutter speed.
3 Rotate the navigation button to adjust the aperture value.

4 Set options.
   • For a list of options, refer to “Shooting options”. (p. 64)
5 Align your subject in the frame, and then half-press [Shutter] to focus.
6 Press [Shutter] to capture the photo.
Using the Magic Plus mode

In the Magic Plus mode, you can capture a photo with various effects.

Option Description
Landscape Capture still-life scenes and landscapes.
Text Clearly capture text from printed or electronic documents.
Sunset Capture scenes at sunset, with natural-looking reds and yellow.
Dawn Capture scenes at sunrise.
Backlight Capture backlit subjects.
Beach & Snow Reduce underexposure of subjects caused by sunlight reflected from sand or snow.
3D Photo Capture scenes with a 3D effect (the 3D effect works only on a 3D TV or 3D monitor).

Using the Scene mode

In Scene mode, you can capture a photo with options that are preset for a specific scene.

1 Rotate the mode dial to 🌌.
2 Select 📸.
3 Select a scene.
   • If the option display does not appear, press [OK], or press [MENU] → 🌌 → Select Scene, and then select a scene.

4 Align your subject in the frame, and then half-press [Shutter] to focus.
5 Press [Shutter] to capture the photo.
Using the Beauty Shot mode

In Beauty Shot mode, you can capture a portrait with options to hide facial imperfections.

1. Rotate the mode dial to 🌟.
2. Select SCN.
3. Select Beauty Shot.
4. Press [MENU].
5. Select 📷 → Face Tone.
6. Select an option.
   - For example, increase the face tone setting to make skin appear lighter.
7. Select Face Retouch.
8. Select an option.
   - For example, increase the face retouch setting to hide more imperfections.
9. Align your subject in the frame, and then half-press [Shutter] to focus.
10. Press [Shutter] to capture the photo.

When you use the Beauty Shot mode, the focus distance will be set to Auto Macro.
Using the Magic Plus mode

Using the 3D Photo mode
In 3D Photo mode, you can capture scenes with a 3D effect.

1. Rotate the mode dial to 3D Photo mode.
2. Select 3D Photo.
3. Align your subject in the frame, and then half-press [Shutter] to focus.
4. Press [Shutter] to capture the photo.
   • The camera captures 2 photos in both JPEG and MPO file formats.
   • In 3D Photo mode, the resolution is automatically set to 3D.
   • In 3D Photo mode, some shooting options are not available.
   • You can view an MPO file that supports the 3D effect only on an MPO-compatible display, such as a 3D TV or 3D monitor. On your camera’s display, you can view only JPEG files.
   • Use proper 3D glasses when you view an MPO file on a 3D TV or 3D monitor.

Using the 2D or 3D Panorama mode
In Panorama mode, you can capture a wide panoramic scene in a single photo. Capture and combine a series of photos to create a panoramic image.

1. Rotate the mode dial to 2D or 3D Panorama mode.
2. Select 2D or 3D Panorama.
3. Press [MENU].
4. Select 2D or 3D Panorama.
5. Press [MENU] to return to Shooting mode.
6. Align your subject in the frame, and then half-press [Shutter] to focus.
   • Align the camera with the far left or the far right, or very top or bottom, of the scene you want to capture.
Using the Magic Plus mode

7 Press and hold [Shutter] to start shooting.

8 With [Shutter] pressed, slowly move the camera in the direction that will let it capture the rest of the panorama.
   • In 3D Panorama mode, you can capture a scene only in horizontal directions.
   • When the viewfinder is aligned with the next scene, the camera captures the next photo automatically.

9 When you are finished, release [Shutter].
   • When you have captured all the necessary shots, the camera combines them into one panoramic photo.

- For best results when capturing panoramic photos, avoid the following:
  - moving the camera too quickly or too slowly
  - moving the camera too little to capture the next image
  - moving the camera at irregular speeds
  - shaking the camera
  - changing the camera direction while capturing a photo
  - shooting in dark places
  - capturing moving subjects nearby
  - shooting conditions where the brightness or color of light is changing

- Photos taken are automatically saved, and shooting is stopped under the following conditions:
  - if you change the shooting direction while shooting
  - if you move the camera too rapidly
  - if you do not move the camera

- Selecting Panorama mode will disable the digital and optical zoom functions. If you select Panorama mode while the lens is zoomed in, the camera automatically zooms out to the default position.

- In Panorama mode, some shooting options are not available.

- The camera may stop shooting due to the shooting composition or movement within the scene.

- In Panorama mode, your camera may not capture the last scene in its entirety if you stop moving the camera exactly where you want the scene to end. To capture the entire scene, move your camera slightly beyond the point where you want the scene to end.
Using the Magic Plus mode

• In 3D Panorama mode, your camera may not capture the very beginning or end of a scene due to the nature of the 3D effect. To capture the entire scene, move slightly beyond the beginning and end points you want to capture.
• In 3D Panorama mode, photos are captured in both JPEG and MPO file formats.
• You can view an MPO file that supports the 3D effect only on an MPO-compatible display, such as 3D TV or 3D monitor. On your camera’s display, you can view only JPEG files.
• Use proper 3D glasses when you view an MPO file on a 3D TV or 3D monitor.

Using the Action Panorama mode

In Action Panorama mode, you can capture and combine a series of photos of a moving subject.

1. Rotate the mode dial to 🌟.
2. Select 📸.
3. Press [MENU].
5. Press [MENU] to return to Shooting mode.
6. Align your subject in the frame, and then half-press [Shutter] to focus.
   • Align the camera with the far left or the far right side of the scene you want to capture.
7. Press and hold [Shutter] to start shooting.
Using the Magic Plus mode

With [Shutter] pressed, slowly move the camera in the direction that will let it capture the rest of the panorama.

- If there is more than one moving subject, the camera may not recognize the correct subject.
- If subjects are outside of the guide frame while capturing, the camera does not capture the movement of the subjects.

When you are finished, release [Shutter].
- The camera automatically combines the shots into one photo.

Using the Magic Frame mode

In Magic Frame mode, you can apply various frame effects to your photos. The shape and the feel of the photos will change according to the frame you select.

1. Rotate the mode dial to 🌟.
2. Select 🏛.
3. Select an option.

4. Align your subject in the frame, and then half-press [Shutter] to focus.

5. Press [Shutter] to capture the photo.

In Magic Frame mode, the resolution is automatically set to 📷.
Using the Magic Plus mode

Using the Split Shot mode
In Split Shot mode, you can capture several photos and arrange them with preset layouts.

1. Rotate the mode dial to 🌟.
2. Select 📌.
3. Select a split style.
   - To adjust the sharpness of the dividing line, press [MENU], and then select 📌 → Line Blur → a desired value.
   - To apply a Smart Filter effect to part of the shot, press [MENU], and then select 📌 → Smart Filter → a desired option. You can apply different Smart Filter effects to each part of the shot.

4. Align your subject in the frame, and then half-press [Shutter] to focus.
5. Press [Shutter] to capture a photo.
   - Repeat steps 4 and 5 to capture the rest of the photos.
   - To recapture a photo, press 💢.

- In Split Shot mode, the resolution is automatically set to 5M or less.
- In Split Shot mode, the available smart filter options are limited.
Using the Magic Plus mode

In Picture-in-Picture mode, you can capture or select a full-sized background photo, and then insert a smaller photo or video into the foreground.

1. Rotate the mode dial to P.

2. Select Picture-in-Picture mode.
   - To set the final video size when inserting a video, press [MENU], and then select Movie Size → a desired video size.

3. Half-press [Shutter] to focus, and then press [Shutter] to capture a background photo.
   - To select a background photo from your saved photos, press [MENU], and then select Open Image → a desired photo. You cannot select a video file or a photo captured in Live Panorama mode.

4. Press [OK] to set the photo as the background image.
   - To recapture a background photo, press [MENU].

5. Press [OK], and rotate the navigation button or press [DISP/ / / /] to change the insertion point.

6. Rotate the front wheel to change the insertion size.

7. Press [OK] to save the setting.

8. Half-press [Shutter] to focus, and then press [Shutter] to capture and insert a photo.
   - The insertion window appears larger when you half-press [Shutter], so that you can determine whether or not the subject is in focus.
   - To record a video, press (Video recording). To stop recording and insert the video, press (Video recording) again.
Using the Magic Plus mode

Using the Artistic Brush mode

In Artistic Brush mode, you can capture a photo, and then view a video that shows how to apply the filter effect.

1. Rotate the mode dial to 🌟.
2. Select 🌟.
3. Select a filter.

![Ink Painting]

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Painting</td>
<td>Apply a watercolor painting effect.</td>
</tr>
<tr>
<td>Cartoon</td>
<td>Apply a cartoon painting effect.</td>
</tr>
<tr>
<td>Sketch</td>
<td>Apply a pen sketch effect.</td>
</tr>
</tbody>
</table>
Using the Magic Plus mode

4 Align your subject in the frame, and then half-press [Shutter] to focus.

5 Press [Shutter] to capture a photo.
   • After capturing the photo, the video that shows how to apply the filter will begin automatically.

Using the HDR mode

In HDR (High Dynamic Range) mode, your camera captures two photos with different exposures, and then overlays the bright area of the underexposed photo and the dark area of the overexposed photo. You can capture photos with soft, rich colors.

1 Rotate the mode dial to 🌟.
2 Select 🌟.
3 Align your subject in the frame, and then half-press [Shutter] to focus.
4 Press [Shutter] to capture the photo.
   • The camera captures 2 photos, and then automatically merges them into a single photo.
Using the Magic Plus mode

- The HDR effect may be affected by camera shake, lighting, movement of the subject, and the shooting environment.
- You cannot use the flash when you use the HDR mode.
- It may take longer to save a photo using the HDR mode.
- When you use the HDR mode, the preview image on the screen and the captured photo may appear slightly larger than a photo captured without this effect.
- When you capture a moving subject using the HDR mode, an afterimage may appear.

Using the Creative Movie Maker mode

In the Creative Movie Maker mode, you can easily make movies from the photos and videos stored on your memory card.

**Making a movie with the Creative Movie Maker**

1. Rotate the mode dial to 🌟.
2. Select 🎥.
3. Select + Movie Creation.

4. Select **Select**, and then select files.
   - You must select at least 2 files.
   - If you select a folder, every photo in the folder will be selected.
   - If you select a 🎥 video, every photo captured while recording the video will be selected.
   - Select **Shuffle** to let the camera select photos and videos randomly. The movie cannot exceed 3 minutes in length.

5. Press [Fn] to confirm the selection.
6. Press [📞] to select **Theme**, and then select a theme.

- You cannot select videos made in Creative Movie Maker mode.
- You cannot select RAW format files.
- If you select the RAW+JPEG format, only JPEG files will be used to make movies in Creative Movie Maker mode.
- You can select up to 60 photos and 10 videos.
Using the Magic Plus mode

7 Press [Music] to select Music, and then select music.

8 Press [Movie Size] to select Movie Size, and then select a movie size.

9 Press [Creation] to select Creation, and then select Creation Start.
   • If your camera does not have enough available memory to store the movie, you cannot select Creation Start. Delete files from the memory card to make more memory available. (p. 101)
   • If the pop-up message appears when you select Creation Start, select a smaller movie size in the Movie Size option.
   • The video rendering may take longer depending on the number and size of the selected files.
   • Press [MENU] to cancel the video rendering.

View a movie made in Creative Movie Maker mode

1 Rotate the mode dial to 🎬.

2 Select 🎬.

3 Press [DISP/.toLocaleString] to select a movie.

4 Press [OK] to play the movie.

To view the movie in Playback mode, press [ ]. (p. 96)
Using the Movie mode

In Movie mode, you can customize settings to record full HD (1920 X 1080) videos of up to 20 minutes in length. The camera saves recorded videos as MP4 (H.264) files.

- MP4 (H.264) is a high-compression video format established by the international standards organizations ISO-IEC and ITU-T.
- If you use memory cards with slow write speeds, the camera may not save videos properly. Video recordings may be corrupted or fail to play back correctly.
- Memory cards with slow writing speeds will not support high-resolution videos and high-speed videos. To record high-resolution or high-speed videos, use memory cards with faster write speeds.
- If you activate the Image Stabilization function while recording a video, the camera may record the operating sound of the Image Stabilization function.
- If you use the zoom function when recording a video, the camera may record the noise of the zoom operating. To decrease zoom noise, use the Sound Alive function. (p. 94)

1. Rotate the mode dial to Video.
2. Set desired options.
   - For a list of options, refer to "Shooting options". (p. 64)
3. Press (Video recording) to start recording.
4. Press (Video recording) again to stop recording.

- You can start recording a video in some modes by pressing (Video recording) without having to rotate the mode dial to Video.
- The video frame size may appear smaller while you are recording a video depending on the video resolution and frame rate.
- If you perform no operations for approximately 3 minutes while recording a video, the screen will become dim. To activate the screen, perform any camera operation. If you operate POWER, Zoom, Shutter, or Video recording button, the camera will carry out the assigned function, even when the screen is dim.
Using the Movie mode

**Pause recording**
The camera allows you to temporarily pause a video while recording. With this function, you can record separate scenes as a single video.

- Press [OK] to pause while recording.
- Press [aturas] not to continue to automatic focusing.
- Press [OK] to resume.

**Capturing still images while recording a video**
You can capture still images while recording a video without switching to the photo shooting modes (up to 6 photos).

- Press [Shutter] to capture images while recording a video.
- Captured images will be saved automatically.

- Captured images will be automatically resized, depending on the size of the recorded video.
- You cannot capture still images while recording high-speed videos.
- You cannot capture still images when you pause the video recording.
- The quality of images captured while recording a video may be lower than those captured normally.
Using the Movie mode

Recording high-speed videos
You can record high-speed videos by setting frame rates. High-speed videos will be played in slow motion at 30 FPS, regardless of the frame rate of the video.

- Memory cards with slow write speeds do not support high-speed videos.
- You cannot set Smart Filter effects or Smart Scene Detection mode when recording high-speed videos.
- The camera does not record audio when recording high-speed videos.
- The image quality of high-speed video may be lower than normal speed video.

1 Rotate the mode dial to 🎥.
   - You can record a high-speed video only in 🎥 mode.

2 Rotate the drive mode dial.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥</td>
<td>192 X 144 (480fps): Record 480 frames per second (for up to 10 seconds).</td>
</tr>
<tr>
<td>🎥</td>
<td>384 X 288 (240fps): Record 240 frames per second (for up to 10 seconds).</td>
</tr>
<tr>
<td>🎥</td>
<td>640 X 480 (120fps): Record 120 frames per second (for up to 10 seconds).</td>
</tr>
</tbody>
</table>

3 Press (Video recording) to start recording.

4 Press (Video recording) again to stop recording.
Using the Movie mode

Using the Smart Scene Detection mode
In Smart Scene Detection mode, your camera automatically chooses the appropriate camera settings based on the scene it has detected.

1. Rotate the mode dial to 🎥.
2. Press [MENU].
3. Select 📸 → Smart Scene Detection → On.
4. Press [MENU] to return to Shooting mode.
5. Align your subject in the frame.
   • The camera automatically selects a scene. An appropriate scene icon will appear at the top left of the screen.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏔️</td>
<td>Landscapes</td>
</tr>
<tr>
<td>🌅</td>
<td>Sunsets</td>
</tr>
<tr>
<td>🌅</td>
<td>Blue skies</td>
</tr>
<tr>
<td>🌳</td>
<td>Forested areas</td>
</tr>
</tbody>
</table>

6. Press 🎥 (Video recording) to start recording.
7. Press 🎥 (Video recording) again to stop recording.
   • If the camera does not recognize an appropriate scene mode, it uses the default settings for the Smart Scene Detection mode.
   • The camera may not select the correct scene depending on the shooting conditions, such as camera shake, lighting, and distance to the subject.
   • Smart Filter effects are not available in Smart Scene Detection mode.
Shooting options
Learn how to set the options in Shooting mode.

Selecting a resolution and quality ............ 65
  Selecting a resolution  ...................... 65
  Setting the photo quality .................. 66
Using the timer .................................. 67
Shooting in the dark ............................ 68
  Preventing red-eye  ........................... 68
  How to use the flash  ....................... 68
  Using the flash  ............................. 69
  Adjusting the ISO sensitivity ............... 71
Changing the camera’s focus .................. 72
  Using macro  ............................... 72
  Using auto focus  ........................... 72
  Focusing on a selected area ............... 74
  Using tracking auto focus .................. 75
  Adjusting the focus area ............... 76
Using Face Detection ....................... 77
  Detecting faces  ........................... 77
  Capturing a self portrait shot .......... 77
  Capturing a smile shot .................... 78
  Detecting eye blinking .................... 79
  Using Smart Face Recognition ............ 79
  Registering faces as your favorites (My Star) ........................................ 80
  Tips for detecting faces .................. 81
Adjusting brightness and color ............. 82
  Adjusting the exposure manually (EV) .... 82
  Locking the exposure value ............... 83
  Changing the metering option ............. 84
  Selecting a White Balance setting ........ 84
Using burst modes ................................ 87
  Capturing photos in the High-speed burst mode .................................. 87
  Capturing photos in the Precapture mode ................................ 88
  Capturing bracketed photos ............... 88
Applying Smart Filter effects ................ 90
  Applying the ND filter effect .......... 92
Adjusting your photos ....................... 93
  Reducing the sound of the zoom ........ 94
Selecting a resolution and quality

Learn how to change the image resolution and quality settings.

Selecting a resolution

As you increase the resolution, your photo or video will include more pixels, so it can be printed on larger paper or displayed on a larger screen. When you use a high resolution, the file size will also increase.

Setting the photo resolution

1. In Shooting mode, press [MENU].
2. Select 📸 → Photo Size.
3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📸 4000 X 3000</td>
<td>Print on an A1 paper.</td>
</tr>
<tr>
<td>📸 4000 X 2672</td>
<td>Print on an A2 paper in wide ratio (3:2).</td>
</tr>
<tr>
<td>📸 4000 X 2248</td>
<td>Print on an A2 paper in panorama ratio (16:9) or play back on an HDTV.</td>
</tr>
<tr>
<td>📸 3264 X 2448</td>
<td>Print on an A2 paper.</td>
</tr>
<tr>
<td>📸 2832 X 2832</td>
<td>Print on an A3 paper in 1:1 ratio.</td>
</tr>
<tr>
<td>📸 2592 X 1944</td>
<td>Print on an A4 paper.</td>
</tr>
<tr>
<td>📸 1984 X 1488</td>
<td>Print on an A5 paper.</td>
</tr>
</tbody>
</table>

Setting the video resolution

1. In Shooting mode, press [MENU].
2. Select 📸 → Movie Size.
3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥 1920 X 1080</td>
<td>Print on an A5 paper in panorama ratio (16:9) or play back on an HDTV.</td>
</tr>
<tr>
<td>🎥 1024 X 768</td>
<td>Attach to an email.</td>
</tr>
<tr>
<td>🎥 1920X1080</td>
<td>High-quality HD files to play back on an HDTV.</td>
</tr>
<tr>
<td>🎥 1280X720</td>
<td>HD files to play back on an HDTV.</td>
</tr>
<tr>
<td>🎥 640X480</td>
<td>SD files to play back on an analog TV.</td>
</tr>
<tr>
<td>🎥 For Sharing</td>
<td>Post on a website using the wireless network (30 seconds maximum).</td>
</tr>
</tbody>
</table>
Setting the photo quality

Set the photo quality setting. Higher image quality settings will result in larger file sizes. The camera compresses and saves the photos you capture in the JPEG format.

1. In Shooting mode, press [MENU].
2. Select 📸 → Quality.
3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📸SF</td>
<td>Super Fine: Capture photos in super high quality.</td>
</tr>
<tr>
<td>📸F</td>
<td>Fine: Capture photos in high quality.</td>
</tr>
<tr>
<td>📸N</td>
<td>Normal: Capture photos in normal quality.</td>
</tr>
<tr>
<td>📸RAW</td>
<td>RAW: Capture photos and save them without any changes.</td>
</tr>
<tr>
<td>📸RAW+SF</td>
<td>RAW + S.Fine: Capture photos in super high quality and RAW format.</td>
</tr>
<tr>
<td>📸RAW+F</td>
<td>RAW + Fine: Capture photos in high quality and RAW format.</td>
</tr>
<tr>
<td>📸RAW+N</td>
<td>RAW + Normal: Capture photos in normal quality and RAW format.</td>
</tr>
</tbody>
</table>

What are RAW files?

Photos captured by a camera are often transformed to JPEG format and stored in the memory according to the settings of the camera at the time of shooting. RAW files are not transformed to JPEG format and are stored in the memory without any changes. RAW files have the file extension “SRW” (For example: “SAM_0001.SRW”). To adjust and calibrate exposures, white balances, tones, contrasts, and colors of the RAW files, use the Samsung RAW Converter program supplied in the software CD-ROM. (See page 121.)
Using the timer

Learn how to set the timer to delay shooting.

1. Rotate the drive mode dial to 2 or 10.

   ▲ Capture a photo after a 2-second delay.
   ▲ Capture a photo after a 10-second delay.

2. Press [Shutter] to start the timer.
   • The AF-assist light/timer lamp blinks. The camera will automatically capture a photo after the specified time has elapsed.
   • Press [Shutter] to cancel the timer.
   • Depending on the Face Detection options you selected, the timer function may not be available.
Shooting in the dark

Learn how to capture photos at night or in low light conditions.

Preventing red-eye

If the flash fires when you capture a photo of a person in the dark, a red glow may appear in the person's eyes. To prevent this, select Red-eye or Red-eye Fix. Refer to flash options in “Using the flash.”

![Before correction](image1)

![After correction](image2)

How to use the flash

Slide the flash release to pop the flash up when it is need.

![Flash release](image3)

When the flash unit is closed, the flash does not fire regardless of the selected option. When the flash unit pops up, the flash fires according to the selected option.

- While not in use, keep the flash unit closed to prevent damage.
- Forcing open the flash unit may cause damage to your camera.

Press down gently to close.
Shooting in the dark

Using the flash  SMART P A S M

Use the flash when you capture photos in the dark or when you need more light in your photos.

1. Slide the flash release to pop the flash up when it is needed.

2. In Shooting mode, press [F].

3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Off: | • The flash will not fire.  
• The camera will display the shake warning (晃) when you are shooting in low light. |
| Auto: | The camera will select a proper flash setting for the scene it detects in Smart Auto mode. |

Available options may differ depending on the shooting conditions.
Shooting options

Shooting in the dark

- Flash options are not available if you select Self-Portrait or Blink Detection.
- Make sure that your subjects are within the recommended distance from the flash. (p. 174)
- If light from the flash is reflected or there is a substantial amount of dust in the air, tiny spots may appear in your photo.
- You cannot use this function when the drive mode dial is set to Continuous, Precapture, or Bracket.
- In some modes, you can also set the flash option by pressing [MENU], and then selecting 📸 → Flash.

Adjusting the flash intensity

Adjust the flash intensity to avoid over-exposed or under-exposed photos.

1. In Shooting mode, press [Flash].
2. Scroll to an option.
3. Press [DISP].

4. Rotate the navigation button or press [Flash/Flash] to adjust the intensity.

5. Press [OK] to save your settings.

- Adjusting the flash intensity may not be effective if:
  - the subject is too close to the camera
  - you set a high ISO sensitivity
  - the exposure value is too big or too small
- In some shooting modes, you cannot use this function.
Shooting in the dark

Adjusting the ISO sensitivity  P A S M

The ISO sensitivity is the measure of a film’s sensitivity to light as defined by the International Organization for Standardization (ISO). The higher ISO sensitivity you select, the more sensitive to light your camera becomes. Use a higher ISO sensitivity to capture better photos and reduce camera shake when not using the flash.

1 In Shooting mode, press [MENU].

2 Select  ISO.

3 Select an option.
   • Select to use an appropriate ISO sensitivity based on the brightness of the subject and lighting.

Higher ISO sensitivities may result in more image noise.

Extending the ISO sensitivity

You can extend the ISO sensitivity to ISO 12800.

1 In Shooting mode, press [MENU].

2 Select  ISO Expansion → On.

   At ISO 12800, the resolution is automatically set to 3m.
Changing the camera’s focus
Learn how to adjust the camera’s focus to suit the subject and the shooting conditions.

Using macro
Use macro to capture close-up photos of subjects, such as flowers or insects.

Using auto focus
To capture sharp photos, select the appropriate focus option according to your distance from the subject.

1. In Shooting mode, press [ ].

• Try to hold the camera firmly to prevent blurry photos.
• Turn off the flash if the distance to the subject is less than 50 cm.
Changing the camera’s focus

2 Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Auto Focus (Normal)" /></td>
<td><strong>Auto Focus (Normal):</strong> Focus on a subject farther than 40 cm away. Farther than 100 cm away when you use the zoom.</td>
</tr>
<tr>
<td><img src="image" alt="Manual Focus" /></td>
<td><strong>Manual Focus:</strong> Focus on a subject by adjusting the focus distance manually. (p. 73)</td>
</tr>
<tr>
<td><img src="image" alt="Macro" /></td>
<td><strong>Macro:</strong> Manually focus on a subject that is 1–40 cm from the camera. 40–100 cm when you use the zoom.</td>
</tr>
</tbody>
</table>
| ![Auto Macro](image) | **Auto Macro:**  
  • Focus on a subject farther than 1 cm away. Farther than 40 cm away when you use the zoom.  
  • This option is set automatically in some modes. You cannot set it manually. |

Available options may differ depending on the shooting conditions.

- **Adjusting the focus distance manually**

1. In Shooting mode, press [ ].
2. Scroll to **Manual Focus**.
3. Press [DISP].
4. Rotate the navigation button or press [ ] to adjust the focus distance.

5. Press [OK] to save your settings.

- When you adjust the focus distance manually and the subject is out of focus, the photo may become blurry.
- If you use this function, you cannot set focus area options, Face Detection options, and Smart Zoom option.
Changing the camera’s focus

Focusing on a selected area

You can focus on an area that you have selected.

1 In Shooting mode, press [MENU].
2 Select 📷 → Focus Area → Selection AF.
3 Press [MENU] to return to Shooting mode.
4 Press [OK], and then rotate the navigation button or press [DISP/ DISP/ DISP/ DISP] to move the frame to a desired area.

5 Press [OK].
6 Press [Shutter] to capture the photo.
   • Press [OK] to change the focus area.

   • If you use this function, you cannot set Face Detection options, Smart zoom options, and Smart Filter effects.
   • You can use this function only when the drive mode dial is set to Single.
Using tracking auto focus

Tracking AF allows you to track and auto focus on your subject, even when you are moving.

1. In Shooting mode, press [MENU].
2. Select 📷 → Focus Area → Tracking AF.
3. Press [MENU] to return to Shooting mode.
4. Focus on the subject you want to track, and then press [OK].
   • A focus frame appears on the subject and follows the subject as you move the camera.

5. Press [Shutter] to capture the photo.

- If you do not select a focus area, the focus frame will appear in the center of the screen.
- Tracking a subject may fail when:
  - the subject is too small
  - the subject moves excessively
  - the subject is backlight or you are shooting in a dark place
  - colors or patterns on the subject and the background are the same
  - the subject includes horizontal patterns, such as blinds
  - the camera shakes excessively
- When tracking a subject fails, the focus frame will appear as a white single-line frame (■).
- If the camera fails to track the subject, you must reselect the subject to track.
- If the camera fails to focus, the focus frame will change to a red single-line frame (■).
- If you use this function, you cannot set Face Detection options, Smart zoom, and Smart Filter effects.
- You can use this function only when the drive mode dial is set to Single.
Changing the camera’s focus

Adjusting the focus area  P A S M

You can get clearer photos by selecting an appropriate focus area according to your subject’s location in the scene.

1 In Shooting mode, press [MENU].

2 Select  📷 → Focus Area.

3 Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷+</td>
<td>Center AF: Focus on the center of the frame (suitable when subjects are located at or near the center).</td>
</tr>
<tr>
<td>📷iPad</td>
<td>Multi AF: Focus on one or more of 9 possible areas.</td>
</tr>
<tr>
<td>📷+</td>
<td>Selection AF: Focus on the area that you select. (p. 74)</td>
</tr>
<tr>
<td>📷iPad</td>
<td>Tracking AF: Focus on and track the subject. (p. 75)</td>
</tr>
</tbody>
</table>

Available shooting options may differ depending on the shooting mode.
Using Face Detection

If you use Face Detection options, your camera can automatically detect a human face. When you focus on a human face, the camera adjusts the exposure automatically. Use Blink Detection to detect closed eyes or Smile Shot to capture a smiling face. You can also use Smart Face Recognition to register faces and prioritize the focus on them.

Detecting faces
Your camera automatically detects up to 10 human faces in one scene.

1. In Shooting mode, press [MENU].
2. Select [ ] → Face Detection → Normal.
3. Press [MENU] to return to Shooting mode.

Capturing a self portrait shot
Capture photos of yourself. The camera sets the focus distance to close-up, and then emits a beep when ready.

1. In Shooting mode, press [MENU].
2. Select [ ] → Face Detection → Self-Portrait.
3. Press [MENU] to return to Shooting mode.
4. Compose your shot with the lens facing you.

The closer you are to the subjects, the quicker your camera will detect faces.
5 When you hear a quick beep, press [Shutter].

Capturing a smile shot

The camera automatically releases the shutter when it detects a smiling face.

1 In Shooting mode, press [MENU].

2 Select 📸 → Face Detection → Smile Shot.

3 Press [MENU] to return to Shooting mode.

4 Compose your shot.
   • The camera automatically releases the shutter when it detects a smiling face.

If you turn Volume off in the sound settings, the camera will not emit a beep. (p. 150)

When your subject smiles broadly, your camera can detect the smile more easily.
Detecting eye blinking
If your camera detects closed eyes, it will automatically capture 2 photos in succession.

1. In Shooting mode, press [MENU].
2. Select ( Camera ) → Face Detection → Blink Detection.
3. Press [MENU] to return to Shooting mode.

Using Smart Face Recognition
The camera automatically registers faces that you frequently photograph. The Smart Face Recognition feature will automatically prioritize the focus on those faces and on favorite faces.

1. In Shooting mode, press [MENU].
2. Select ( Camera ) → Face Detection → Smart Face Recognition.

- □: Faces that you have registered as favorites.
  (To register faces as favorites, refer to page 80.)
- □: Faces that the camera has automatically registered.

- The camera may recognize and register faces incorrectly depending on lighting conditions, drastic changes in the subject’s pose or face, and whether or not the subject is wearing glasses.
- The camera can automatically register up to 12 faces. If the camera recognizes a new face when 12 faces have already been registered, it will replace the lowest priority face with the new one.
Registering faces as your favorites (My Star)

You can register your favorite faces to prioritize the focus and exposure on those faces.

1. In Shooting mode, press [MENU].

2. Select 📷 → Smart FR Edit → My Star.

3. Align your subject’s face with the oval guideline, and then press [Shutter] to register the face.

4. Press [OK] to register the face.
   - When you are finished registering the photos, the face list appears.
   - Your favorite faces are indicated with a ★ on the face list.

   - You can register up to 8 favorite faces.
   - The flash will not fire when you register a favorite face.
   - If you register the same face twice, you can delete one of the faces in the face list.
   - The newly registered face appears at the top of the list.

Changing the rank of your favorite faces

1. In Shooting mode, press [MENU].

2. Select 📷 → Smart FR Edit → Face List.

3. Press [Fn], and then select Edit Ranking.

4. Select a favorite face, and then press [OK].

5. Rotate the navigation button or press [Fn/W] to change the rank, and then press [Fn].

To change the rank of your favorite faces in Playback mode, refer to “Ranking your favorite faces” on page 97.
Using Face Detection

Deleting a favorite face

1 In Shooting mode, press [MENU].
2 Select 📷 → Smart FR Edit → Face List.
3 Press [Fn], and then select Cancel My Star.
4 Select a favorite face, and then press [OK].
5 Press [ahi].
6 When the pop-up message appears, select Yes.

Tips for detecting faces

- When your camera detects a face, it tracks the detected face automatically.
- Face Detection may not be effective when:
  - the subject is far from the camera (The focus frame will appear orange for Smile Shot and Blink Detection.)
  - it is too bright or too dark
  - the subject is not facing the camera
  - the subject is wearing sunglasses or a mask
  - the subject’s facial expression changes drastically
  - the subject is backlit or the lighting conditions are unstable
- Face Detection is not available when you set Smart Filter effects, Image adjustment, Smart Zoom, Selection AF, Tracking AF, or Manual Focus.
- When you set Face Detection options, the AF area is automatically set to Multi AF.
- You cannot use this function when the drive mode dial is set to Continuous, Precapture, or Bracket.
- When you capture photos of detected faces, they will be registered in the face list.
- You can view registered faces in order of priority in Playback mode. (p. 97) Even though faces are registered successfully, they may not be classified in Playback mode.
- A face detected in Shooting mode may not appear in the face list or Smart Album.

To delete a favorite face in Playback mode, refer to "Deleting favorite faces" on page 98.
Adjusting brightness and color

Learn how to adjust the brightness and color for better image quality.

Adjusting the exposure manually (EV)

Depending on the intensity of the ambient light, your photos may be too bright or dark. In these cases, you can adjust the exposure to get a better photo.

1. In Shooting mode, press [MENU].
2. Select 📸 or 📹 → EV.
3. Select a value to adjust the exposure.
   - The photo will be brighter as the exposure value increases.

   - Once you adjust the exposure, the setting will be stored automatically. You may need to change the exposure value later to avoid overexposure or underexposure.
   - If you cannot decide on an appropriate exposure, select the AE BKT (Auto Exposure Bracket) option (p. 89), and then capture bracketed photos. The camera will capture 3 consecutive photos, each with a different exposure: normal, underexposed, and overexposed. (p. 88)
Adjusting brightness and color

Adjusting the exposure using the front wheel

1 In Shooting mode, press the front wheel.

2 Rotate the front wheel to adjust the exposure.

3 Press the front wheel again or [OK] to save your settings.

Locking the exposure value

The adjusted exposure value locks when [AEL] is pressed, and remains locked until [AEL] is pressed again.

1 Adjust the exposure manually. (p. 82)

2 Press [AEL].
   • The AEL icon turns on.
Adjusting brightness and color

Changing the metering option

The metering mode refers to the way in which a camera measures the quantity of light. The brightness and lighting of your photos will vary depending on the metering mode you select.

1. In Shooting mode, press [MENU].
2. Select 📷 or 📷 → Metering.
3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷</td>
<td><strong>Multi:</strong></td>
</tr>
<tr>
<td></td>
<td>• Your camera divides the frame into several areas, and then measures the light intensity of each area.</td>
</tr>
<tr>
<td></td>
<td>• Suitable for general photos.</td>
</tr>
</tbody>
</table>

| 📷   | **Spot:**  |
|      | • Your camera measures only the light intensity at the very center of the frame. |
|      | • If a subject is not in the center of the frame, your photo may be improperly exposed. |
|      | • Suitable for a subject with backlighting. |

| 📷   | **Center-weighted:** |
|      | • Your camera averages the meter reading of the entire frame with emphasis placed on the center. |
|      | • Suitable for photos with subjects in the center of the frame. |

Selecting a White Balance setting

The color of your photo depends on the type and quality of the light source. If you want the color of your photo to be realistic, select a White Balance setting that is appropriate for the lighting conditions, such as Auto WB, Daylight, Cloudy, or Tungsten.

- Auto WB
- Daylight
- Cloudy
- Tungsten
Adjusting brightness and color

1 In Shooting mode, press [MENU].
2 Select 😄 or 😎 → White Balance.
3 Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🕵️‍♂️</td>
<td><strong>Auto WB</strong>: Automatically set the White Balance based on the lighting conditions.</td>
</tr>
<tr>
<td>☀️</td>
<td><strong>Daylight</strong>: For outdoor photos on a sunny day.</td>
</tr>
<tr>
<td>🌬️</td>
<td><strong>Cloudy</strong>: For outdoor photos on a cloudy day or in shadows.</td>
</tr>
<tr>
<td>🌈</td>
<td><strong>Fluorescent_H</strong>: For shooting under a daylight fluorescent or 3-way fluorescent light.</td>
</tr>
<tr>
<td>🌈</td>
<td><strong>Fluorescent_L</strong>: For shooting under white fluorescent light.</td>
</tr>
<tr>
<td>🕯️</td>
<td><strong>Tungsten</strong>: For shooting indoor photos under incandescent bulbs or halogen lamps.</td>
</tr>
<tr>
<td>🚨</td>
<td><strong>Custom Set</strong>: To use White Balance settings that you define. (p. 86)</td>
</tr>
<tr>
<td>℃</td>
<td><strong>Color Temp.</strong>: To adjust the color temperature of the light source. (p. 86)</td>
</tr>
</tbody>
</table>

Customizing preset White Balance options

You can customize preset White Balance options except Auto WB and Custom Set.

1 In Shooting mode, press [MENU].
2 Select 😄 or 😎 → White Balance.
3 Scroll to a desired option.
4 Press [DISP].
5 Rotate the navigation button or press [DISP/泖/_tD/тся] to adjust the value on the coordinates.

- G: Green
- A: Amber
- M: Magenta
- B: Blue

6 Press [OK] to save your settings.
Adjusting brightness and color

Customizing your own White Balance
You can customize the White Balance by capturing a photo of a white surface, such as a piece of paper, under the lighting conditions in which you intend to capture a photo. The White Balance feature will help you to match the colors in your photo with the actual scene.

1 In Shooting mode, press [MENU].
2 Select 📸 or 📺 → White Balance.
3 Scroll to Custom Set.
4 Aim the lens at a piece of white paper, and then press [Shutter].

Adjusting color temperature

1 In Shooting mode, press [MENU].
2 Select 📸 or 📺 → White Balance.
3 Scroll to Color Temp..
4 Press [DISP].
5 Rotate the navigation button or press [ר/נ] to adjust the color temperature to match your light source.
   • You can capture a warmer photo with a higher color temperature setting (more yellow/red), and a cooler photo with a lower color temperature setting (more blue).
6 Press [OK] to save your settings.
Using burst modes

It can be difficult to capture photos of fast-moving subjects or capture natural facial expressions and gestures of your subjects in photos. Also, it can be difficult to adjust the exposure correctly and select a proper light source. In these cases, select one of the burst modes.

Capturing photos in the High-speed burst mode

1. Rotate the drive mode dial.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Single: Capture a single photo. <strong>Single</strong> is not a high-speed burst option.</td>
</tr>
<tr>
<td><img src="icon" alt="Icon" /></td>
<td>Continuous (3 fps): Capture 3 photos per second continuously. (You can capture up to 10 photos in one burst.)</td>
</tr>
<tr>
<td><img src="icon" alt="Icon" /></td>
<td>Continuous (5 fps): Capture 5 photos per second continuously. (You can capture up to 10 photos in one burst.)</td>
</tr>
<tr>
<td><img src="icon" alt="Icon" /></td>
<td>Continuous (10 fps): Capture 10 photos per second continuously. (You can capture up to 10 photos in one burst.)</td>
</tr>
</tbody>
</table>

2. Align your subject in the frame, and then half-press [Shutter] to focus.

3. Press and hold [Shutter].
   - While you are pressing [Shutter], the camera captures photos continuously.

- You cannot use the flash, Smart Zoom, Face Detection options, and Smart Filter options when the drive mode dial is set to Continuous, Precapture, or Bracket.
- It may take longer to save the photos depending on the memory card capacity and performance.
- The camera always displays captured photos before returning to Shooting mode.
Capturing photos in the Precapture mode
In Precapture mode, the camera starts shooting before you even press the shutter all the way down. If you do not want to miss the first couple of important shots, simply use this mode and select the photo with the best results after shooting.

1 Rotate the drive mode dial to ⏩.

2 Align your subject in the frame, and then half-press [Shutter] to focus.
   • The camera captures 9 photos continuously. If you release [Shutter] too fast, the camera captures less than 9 photos.

3 Press [Shutter].
   • The camera captures the last photo and automatically saves all 10 photos while you are half-pressing [Shutter].
   • If you do not press [Shutter] all the way down, the photos captured while you are half-pressing [Shutter] will not be saved.

Capturing bracketed photos
You can use the automatic bracketing feature to capture multiple photos of the same subject with different setting values slightly modified, such as exposure or white balance.

1 Rotate the drive mode dial to BKT.

2 Align your subject in the frame, and then half-press [Shutter] to focus.

3 Press [Shutter].
   • The camera captures 3 photos continuously.

⚠️ It may take longer to capture the photo. Use a tripod for best results.
Using burst modes

Selecting a bracketing option

1 In Shooting mode, press [MENU].
2 Select 📸 → Bracket.
3 Select a bracketing option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📸 WB BKT:</td>
<td>Capture 3 photos with different white balance.</td>
</tr>
<tr>
<td>📸 AE BKT:</td>
<td>Capture 3 photos with selected exposures.</td>
</tr>
</tbody>
</table>

4 Adjust the color for the selected light source (white balance) or select an exposure value.
5 Press [OK] to save your settings.
 Applying Smart Filter effects

Apply various filter effects to your photos and videos to create unique images.

**Available filters in Program, Aperture Priority, Shutter Priority, and Manual modes**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>No effect</td>
</tr>
<tr>
<td>Miniature</td>
<td>Apply a tilt-shift effect to make the subject appear in miniature.</td>
</tr>
<tr>
<td>Vignetting</td>
<td>Apply the retro-looking colors, high contrast, and strong vignette effect of Lomo cameras.</td>
</tr>
<tr>
<td>Ink Painting</td>
<td>Apply a watercolor painting effect.</td>
</tr>
<tr>
<td>Oil Painting</td>
<td>Apply an oil painting effect.</td>
</tr>
<tr>
<td>Cartoon</td>
<td>Apply a cartoon painting effect.</td>
</tr>
<tr>
<td>Cross Filter</td>
<td>Add lines that radiate outward from bright objects to imitate the visual effect of a cross filter.</td>
</tr>
<tr>
<td>Sketch</td>
<td>Apply a pen sketch effect.</td>
</tr>
<tr>
<td>Soft Focus</td>
<td>Hide facial imperfections or apply dreamy effects.</td>
</tr>
<tr>
<td>Fish-eye</td>
<td>Distort close objects to imitate the visual effect of a fisheye lens.</td>
</tr>
<tr>
<td>Old Film</td>
<td>Apply a vintage film effect.</td>
</tr>
<tr>
<td>Half Tone Dot</td>
<td>Apply a halftone effect.</td>
</tr>
<tr>
<td>Classic</td>
<td>Apply a black and white effect.</td>
</tr>
</tbody>
</table>

**Steps:**

1. In Shooting mode, press [MENU].
2. Select 📷 or 🎥 → Smart Filter.
3. Select an effect.
## Applying Smart Filter effects

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retro</td>
<td>Apply a sepia tone effect.</td>
</tr>
<tr>
<td>Zooming Shot</td>
<td>Blur the edges of a photo to emphasize the subjects in the center.</td>
</tr>
</tbody>
</table>

### Available filters in Movie mode

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>No effect</td>
</tr>
<tr>
<td>Palette Effect 1</td>
<td>Create a vivid look with sharp contrast and strong color.</td>
</tr>
<tr>
<td>Palette Effect 2</td>
<td>Make scenes clean and clear.</td>
</tr>
<tr>
<td>Palette Effect 3</td>
<td>Apply a soft brown tone.</td>
</tr>
<tr>
<td>Palette Effect 4</td>
<td>Create a cold and monotone effect.</td>
</tr>
<tr>
<td>Miniature</td>
<td>Apply a tilt-shift effect to make the subject appear in miniature.</td>
</tr>
<tr>
<td>Vignetting</td>
<td>Apply the retro-looking colors, high contrast, and strong vignette effect of Lomo cameras.</td>
</tr>
<tr>
<td>Half Tone Dot</td>
<td>Apply a halftone effect.</td>
</tr>
<tr>
<td>Sketch</td>
<td>Apply a pen sketch effect.</td>
</tr>
<tr>
<td>Fish-eye</td>
<td>Distort close objects to imitate the visual effect of a fisheye lens.</td>
</tr>
</tbody>
</table>

- Depending on the option you select, the resolution may change to or smaller automatically.
- If you select **Miniature**, the miniature recording time is also displayed and is shorter than the real recording time.
- If you select **Miniature** you cannot record the video sound or capture still images while recording a video.
- Depending on the option you select, the recording speed may change to and the recording resolution may change to or smaller automatically.
- If you set Smart Filter effects, you cannot set Smart Zoom, Face Detection options, Image Adjustment options, Tracking AF, or Selection AF.
- You cannot use this function when the drive mode dial is set to **Continuous**, **Precapture**, or **Bracket**.
Applying the ND filter effect

Use the ND (Neutral Density) filter to reduce the light intensity while retaining the original color. The ND filter is useful when you capture photos in bright places with a large aperture value or slow shutter speed.

1. In Shooting mode, press [MENU].

2. Select 📷 or 🌡️ → ND Filter.

3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷</td>
<td>Off: The ND filter is not active.</td>
</tr>
<tr>
<td>🌡️</td>
<td>On: The ND filter is active.</td>
</tr>
</tbody>
</table>
Adjusting your photos

Adjust the sharpness, saturation, or contrast of your photos.

1. In Shooting mode, press [MENU].

2. Select 📸 → Image Adjust.

3. Select an option.
   - Contrast
   - Sharpness
   - Saturation

4. Rotate the navigation button or the front wheel, or press [.glide] to adjust each value.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contrast</td>
<td>- Decrease the color and brightness.</td>
</tr>
<tr>
<td></td>
<td>+ Increase the color and brightness.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>- Soften the edges on your photos (suitable for editing the photos on your computer).</td>
</tr>
<tr>
<td></td>
<td>+ Sharpen the edges to improve the clarity of your photos. This may also increase the noise in your photos.</td>
</tr>
<tr>
<td>Saturation</td>
<td>- Decrease the saturation.</td>
</tr>
<tr>
<td></td>
<td>+ Increase the saturation.</td>
</tr>
</tbody>
</table>

5. Press [OK] to save your settings.

- Select 0 if you do not want to apply any effects (suitable for printing).
- If you set Image Adjustment options, you cannot set Smart Filter effects or Face Detection options.
Reducing the sound of the zoom

When you use the zoom while recording videos, the camera can record the sound of the zoom. Use the Sound Alive function to reduce zoom noise.

1. In Shooting mode, press [MENU].

2. Select "Voice."

3. Select an option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td><strong>Sound Alive On</strong>: Turn on the Sound Alive function to reduce the zoom noise.</td>
</tr>
<tr>
<td>🎤</td>
<td><strong>Sound Alive Off</strong>: Turn off the Sound Alive function. The camera can record the zoom noise.</td>
</tr>
<tr>
<td>🎤</td>
<td><strong>Mute</strong>: Do not record sounds.</td>
</tr>
</tbody>
</table>

- Do not block the microphone when you use the Sound Alive function.
- Recordings made with Sound Alive may differ from actual sounds.
Playback/Editing

Learn how to play back photos or videos, and edit photos or videos. Also, learn how to connect your camera to your computer, TV, HDTV, or 3D TV.

Viewing photos or videos in

- **Playback mode** ........................................ 96
  - Starting Playback mode  ......................... 96
  - Viewing photos  .................................. 102
  - Playing a video  ................................. 105

- **Editing a photo** ................................... 107
  - Resizing photos  ................................. 107
  - Rotating a photo  ............................... 107
  - Applying Smart Filter effects .............. 108
  - Adjusting your photos  ....................... 109
  - Creating a print order (DPOF) ............. 110

Viewing files on a TV, HDTV, or 3D TV .............................. 112

Transferring files to your computer .......................... 115
  - Transferring files to your Windows OS computer .......................... 115
  - Transferring files to your Mac OS computer ........................................... 116

Using programs on the computer .......................... 117
  - Installing CD-provided programs ............ 117
  - Using iLauncher  .................................. 118
  - Using Samsung RAW Converter ............ 121
Viewing photos or videos in Playback mode

Learn how to play back photos or videos and how to manage files.

Starting Playback mode

View photos or play videos stored in your camera.

1. Press [ ].
   - The most recent file will be displayed.
   - If the camera is off, it will turn on and display the most recent file.

2. Rotate the navigation button or press [ ] to scroll through files.
   - Press and hold [ ] to scroll through files quickly.

You may not be able to edit or play back files that were captured with other cameras, due to unsupported sizes or codecs. Use a computer or another device to edit or play back these files.

Starting Playback mode

View photos or play videos stored in your camera.

1. Press [ ].
   - The most recent file will be displayed.
   - If the camera is off, it will turn on and display the most recent file.

2. Rotate the navigation button or press [ ] to scroll through files.
   - Press and hold [ ] to scroll through files quickly.

You may not be able to edit or play back files that were captured with other cameras, due to unsupported sizes or codecs. Use a computer or another device to edit or play back these files.

Photo file information

Icon Description

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/2</td>
<td>Current file/Total files</td>
</tr>
<tr>
<td>F3.2</td>
<td>Aperture value</td>
</tr>
<tr>
<td>1/30</td>
<td>Shutter speed</td>
</tr>
<tr>
<td>100-0001</td>
<td>Folder name–File name</td>
</tr>
<tr>
<td>3D</td>
<td>Photo captured in 3D Photo mode</td>
</tr>
<tr>
<td>H5</td>
<td>Photo captured in a High-speed burst mode or in Precapture mode (See Viewing files as a folder, p. 98)</td>
</tr>
<tr>
<td>On</td>
<td>Protected file</td>
</tr>
<tr>
<td>☐</td>
<td>Print order has been set (DPOF)</td>
</tr>
</tbody>
</table>

To display file information on the screen, press [ DISP ].
Viewing photos or videos in Playback mode

**Video file information**

![Video file information image]

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/2</td>
<td>Current file/Total files</td>
</tr>
<tr>
<td>100-0002</td>
<td>Folder name-File name</td>
</tr>
<tr>
<td>00:00</td>
<td>Current playback time</td>
</tr>
<tr>
<td>00:20</td>
<td>Video length</td>
</tr>
<tr>
<td></td>
<td>Video file</td>
</tr>
<tr>
<td></td>
<td>Video includes images captured while recording</td>
</tr>
<tr>
<td></td>
<td>Video made in Creative Movie Maker mode</td>
</tr>
<tr>
<td></td>
<td>Protected file</td>
</tr>
<tr>
<td></td>
<td>Image captured while recording a video</td>
</tr>
</tbody>
</table>

**Ranking your favorite faces**

You can rank your favorite faces.

1. In Playback mode, press [MENU].
2. Select 📸 → Face List Edit → Edit Ranking.
3. Select a face from the list, and then press [OK].
4. Rotate the navigation button or press [leftright] to change the ranking of the face, and then press [Fn].

To display file information on the screen, press [DISP].
Viewing photos or videos in Playback mode

**Deleting favorite faces**
You can delete your favorite faces.

1. In Playback mode, press [MENU].
2. Select 📅 → Face List Edit → Cancel My Star.
3. Select a face, and then press [OK].
4. Press [Esc].
5. When the pop-up message appears, select Yes.

**Viewing files as a folder**
Photos captured in a High-speed burst mode or in Precapture mode appear as a folder.

1. In Playback mode, rotate the navigation button or press [ قناص / صناعه ] to scroll to a desired folder.
   - The camera will automatically play back photos in the folder.

2. Press [OK] to open the folder.
3. Rotate the navigation button or press [ قناص / صناعه ] to scroll through the files.
4. Press [OK] to return to Playback mode.
### Viewing photos or videos in Playback mode

**Viewing files by category in Smart Album**
View files by category, such as date, face, or file type.

1. In Playback mode, rotate [Zoom] to the left.
2. Press [MENU].
3. Select Filter → a category.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>View files by the file type.</td>
</tr>
<tr>
<td>Date</td>
<td>View files by the date they were saved.</td>
</tr>
<tr>
<td>Week</td>
<td>View files by the day of the week they were saved.</td>
</tr>
<tr>
<td>Face</td>
<td>View files by recognized faces and favorite faces. (Up to 20 people)</td>
</tr>
</tbody>
</table>

4. Rotate the navigation button or press [F / T] to scroll through the files.
   - Press and hold [F / T] to scroll through files quickly.

5. Rotate [Zoom] to the right or press [OK] to return to Playback mode.

It may take some time for the camera to open Smart Album, change the category, or reorganize files.
Viewing photos or videos in Playback mode

Viewing files as thumbnails
Scan thumbnails of files.

In Playback mode, rotate [Zoom] to the left to view thumbnails (3 at a time). Rotate [Zoom] to the left once or twice more to display more thumbnails (15 or 40 at a time). Rotate [Zoom] to the right to return to the previous view.

<table>
<thead>
<tr>
<th>To</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll through files</td>
<td>Rotate the navigation button or press [DISP/ mesmerizing]</td>
</tr>
<tr>
<td>Delete files</td>
<td>Press [FORMAT], and then select Yes.</td>
</tr>
</tbody>
</table>

When you scroll to a video file or folder in the thumbnails view, the camera will automatically play back the video or the photos in the folder.

Protecting files
Protect your files from accidental deletion.

1 In Playback mode, press [MENU].
2 Select  
   \Protect  \Select.
   - To protect all files, select All \Lock.
3 Scroll to the file you want to protect, and then press [OK].
   - Press [OK] again to cancel your selection.
4 Press [Fn].
   - You cannot delete or rotate a protected file.
   - In Playback mode, you can protect the file by pressing [AEL].
Deleting files
Select files to delete in Playback mode.

Deleting a single file
You can select one file, and then delete it.

1. In Playback mode, select a file, and then press [ ].
2. When the pop-up message appears, select Yes.

- When viewing files in Smart Album or thumbnails view, press [ ] to delete a file.
- While viewing files as a folder, press [ ] to delete all photos in the folder.
- To delete a specific photo in a folder, open the folder, select a file, and then press [ ].

Deleting multiple files
You can select multiple files, and then delete them at once.

1. In Playback mode, press [ ].
2. When the pop-up message appears, select Multiple Delete.
   - You can also delete multiple files in Playback mode by pressing [MENU], and then selecting → Delete → Select.
3. Scroll to each file you want to delete, and then press [ ].
   - Press [ ] again to cancel your selection.
4. Press [ ].
5. When the pop-up message appears, select Yes.
Viewing photos or videos in Playback mode

Deleting all files
You can select all files, and then delete them at once.

1 In Playback mode, press [MENU].

2 Select 📄 → Delete → All.

3 When the pop-up message appears, select Yes.
   • All unprotected files are deleted.

Viewing photos
Enlarge part of a photo or view photos as a slide show.

Enlarging a photo
In Playback mode, rotate [Zoom] to the right to enlarge a portion of the photo. Rotate [Zoom] to the left to zoom out.

Enlarged area
Zoom ratio (The maximum zoom ratio differs depending on the photo resolution.)
Viewing photos or videos in Playback mode

<table>
<thead>
<tr>
<th>To</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the enlarged area</td>
<td>Press [DISP/_DIRECTORY/PLAY/SEARCH].</td>
</tr>
<tr>
<td>Trim the enlarged photo</td>
<td>Press [OK], and then select Yes. (The trimmed photo will be saved as a new file. The original photo is retained in its original form.)</td>
</tr>
</tbody>
</table>

When you view photos that were captured by another camera, the zoom ratio may differ.

Viewing panoramic photos

View photos captured in Panorama mode.

1. In Playback mode, rotate the navigation button or press [DISP/_DIRECTORY/PLAY/SEARCH] to scroll to a desired panoramic photo.
   - The entire panoramic photo appears on the screen.

2. Press [OK].
   - The camera automatically scrolls through the photo from left to right for a horizontal panoramic photo and from top to bottom for a vertical panoramic photo. The camera then switches to Playback mode.
   - While playing back a panoramic photo, press [OK] to pause or resume.
   - After you have paused the playback of a panoramic photo, press [DISP/_DIRECTORY/PLAY/SEARCH] to move the photo horizontally or vertically, depending on the direction you moved when capturing the photo.

3. Press [MENU] to return to Playback mode.

- The camera automatically scrolls through the panoramic photo only if the longest side of the photo is two or more times longer than the shortest side.
- On your camera’s display, a photo captured in 3D Panorama mode appears as a 2D panoramic photo. To see the 3D effect, connect your camera to a 3D TV or 3D monitor. (p. 114)
Viewing photos or videos in Playback mode

Playing a slide show
Apply effects and audio to a slide show of your photos. The slide show function does not work for videos.

1. In Playback mode, press [MENU].
2. Select 📅.
3. Select a slide show effect option.
   - Skip to step 4 to start a slide show with the default effects.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start</strong></td>
<td>Set whether or not to repeat the slide show. (Play*, Repeat)</td>
</tr>
</tbody>
</table>
| **Images** | Set the photos you want to view as a slide show.  
* All*: View all photos in a slide show.  
* Date*: View photos captured on a specific date in a slide show.  
* Select*: View selected photos in a slide show. |
| **Interval** | Set the interval between photos.  
(1 sec*, 3 sec, 5 sec, 10 sec)  
* You must set the Effect option to Off to set the interval. |

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Effect** | • Set a scene change effect between photos.  
(Off, Calm*, Shine, Relax, Lively, Sweet)  
* Default |
| **Music** | Set background audio. |

4. Select Start → Play.
   - Select Repeat to loop the slide show.
5. View the slide show.
   - Press [OK] to pause the slide show.  
   - Press [OK] again to resume the slide show.

- Press [OK], and then press [충전 표시등] to stop the slide show and return to Playback mode.  
- Rotate [Zoom] to the left or right to adjust the volume level.
Viewing photos or videos in Playback mode

Playing a video
In Playback mode, you can view a video, and then capture or trim parts of the playing video. You can save the captured or trimmed segments as new files.

1. In Playback mode, select a video, and then press [OK].
2. View the video.

Trimming a video

1. While viewing a video, press [OK] at the point where you want the trimming to begin.
2. Rotate [Zoom] to the right, and then press [OK].
3. Press [OK] at the point where you want the trimming to end.
4. Rotate [Zoom] to the right.
5. When the pop-up message appears, select Yes.

• The original video should be at least 10 seconds long.
• The camera will save the edited video as new files.

<table>
<thead>
<tr>
<th>To</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan backward</td>
<td>Press [ ]. Each time you press [ ], you change the scan speed in this order: 2X, 4X, 8X.</td>
</tr>
<tr>
<td>Pause or resume playback</td>
<td>Press [OK].</td>
</tr>
<tr>
<td>Scan forward</td>
<td>Press [ ]. Each time you press [ ], you change the scan speed in this order: 2X, 4X, 8X.</td>
</tr>
<tr>
<td>Adjust the volume level</td>
<td>Rotate [Zoom] to the left or right.</td>
</tr>
</tbody>
</table>
Viewing photos or videos in Playback mode

Capting an image from video

1 While viewing a video, press [OK] at the point where you want to capture an image.

2 Press [capturing button].

- The resolution of the captured image will be the same as the original video.
- The captured image is saved as a new file.
## Editing a photo

Learn how to edit photos.

- The camera will save edited photos as new files.
- When you edit photos, the camera will automatically convert them to a lower resolution. Photos that you rotate or resize manually are not automatically converted to a lower resolution.
- You cannot edit a photo while viewing a folder. To edit a photo in a folder, press [OK] to open the folder, and then scroll to the photo.
- You cannot edit photos captured in Panorama mode or 3D Photo mode, and RAW format files.

### Resizing photos

Change the size of a photo and save it as a new file.

1. In Playback mode, select a photo, and then press [MENU].
2. Select \(\rightarrow\) Resize.
3. Select an option.

- Resize: 2592 × 1944
- Rotate: 1984 × 1488
- Smart Filter: 1024 × 768
- Image Adjust

Available resize options differ depending on the original size of the photo.

### Rotating a photo

1. In Playback mode, select a photo, and then press [MENU].
2. Select \(\rightarrow\) Rotate.
3. Select an option.

The camera will overwrite the original file.
Editing a photo

Applying Smart Filter effects
Apply special effects to your photos.

1. In Playback mode, select a photo, and then press [MENU].
2. Select '→ Smart Filter'.
3. Select an effect.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cartoon</td>
<td>Apply a cartoon painting effect.</td>
</tr>
<tr>
<td>Cross Filter</td>
<td>Add lines that radiate outward from bright objects to imitate the visual effect of a cross filter.</td>
</tr>
<tr>
<td>Sketch</td>
<td>Apply a pen sketch effect.</td>
</tr>
<tr>
<td>Soft Focus</td>
<td>Hide facial imperfections or apply dreamy effects.</td>
</tr>
<tr>
<td>Vignetting</td>
<td>Apply the retro-looking colors, high contrast, and strong vignette effect of Lomo cameras.</td>
</tr>
<tr>
<td>Fish-eye</td>
<td>Distort close objects to imitate the visual effect of a fisheye lens.</td>
</tr>
<tr>
<td>Old Film</td>
<td>Apply a vintage film effect.</td>
</tr>
<tr>
<td>Half Tone Dot</td>
<td>Apply a halftone effect.</td>
</tr>
<tr>
<td>Classic</td>
<td>Apply a black and white effect.</td>
</tr>
<tr>
<td>Retro</td>
<td>Apply a sepia tone effect.</td>
</tr>
<tr>
<td>Zooming Shot</td>
<td>Blur the edges of a photo to emphasize the subjects in the center.</td>
</tr>
</tbody>
</table>
Editing a photo

Adjusting your photos
Learn how to correct red-eye, adjust the skin tone, and adjust the brightness, contrast, or saturation. The camera will save an edited photo as a new file, but may convert it to a lower resolution.

Removing red-eye

1 In Playback mode, select a photo, and then press [MENU].
2 Select \( \text{Image Adjust} \rightarrow \text{Red-eye Fix} \).
3 Press [OK] to save your settings.

Retouching faces

1 In Playback mode, select a photo, and then press [MENU].
2 Select \( \text{Image Adjust} \rightarrow \text{Face Retouch} \).
3 Scroll to Face Retouch.
4 Press [DISP].
5 Rotate the navigation button or press \( [\text{ Flash} / \text{ Wi-Fi}] \) to adjust the skin tone.
   • As the number increases, the skin tone becomes brighter.
6 Press [OK] to save your settings.
Editing a photo

Adjusting brightness, contrast, or saturation

1. In Playback mode, select a photo, and then press [MENU].
2. Select  → Image Adjust.
3. Scroll to an adjusting option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☀</td>
<td>Brightness</td>
</tr>
<tr>
<td>🔁</td>
<td>Contrast</td>
</tr>
<tr>
<td>🌞</td>
<td>Saturation</td>
</tr>
</tbody>
</table>

4. Press [DISP].
5. Rotate the navigation button or press [📸] to adjust the option.

Adding noise to the photo

1. In Playback mode, select a photo, and then press [MENU].
2. Select  → Image Adjust → Add Noise.

Creating a print order (DPOF)

Select photos to print and save print options in the Digital Print Order Format (DPOF). This information is saved in the MISC folder on your memory card for convenient printing on DPOF-compatible printers.

1. In Playback mode, press [MENU].
2. Select  → DPOF → Standard → Select.
   - Select All to print all photos.
3 Scroll to a photo you want to print, rotate [Zoom] to the left or right to select the number of copies, and then press [Fn].
   • If you select All, press [DISP/ ё] to select the number of copies, and then press [OK].

4 Press [MENU].

5 Select 📷 → DPOF → Size → Select.
   • Select All to choose the print size for all photos.

6 Scroll to a photo you want to print, rotate [Zoom] to the left or right to select the print size, and then press [Fn].
   • If you select All, press [DISP/ ё] to select the print size, and then press [OK].

---

### Printing photos as thumbnails

Print photos as thumbnails to check all the photos at once.

1 In Playback mode, press [MENU].

2 Select 📷 → DPOF → Index.

3 When the pop-up message appears, select Yes.

- You can take the memory card to a print shop that supports DPOF (Digital Print Order Format) or you can print photos directly through a DPOF-compatible printer at home.
- Photos with dimensions that are wider than the paper may be cut off on the left and right edges. Ensure that your photo dimensions are compatible with the paper you select.
- If you specify the print size, you can print photos only with DPOF 1.1-compatible printers.
Viewing files on a TV, HDTV, or 3D TV

Play back photos or videos by connecting your camera to a TV with the A/V cable.

1 In Shooting or Playback mode, press [MENU].
2 Select 🎥→ Video Out.
3 Select the video signal output for your country or region. (p. 153)
4 Turn off your camera and TV.
5 Connect your camera to your TV with the A/V cable.
6 Turn on your TV, and then select the A/V video source with the TV remote control.
7 Turn on your camera.
   • The camera automatically enters into Playback mode when you connect it to a TV.
8 View photos or play videos using the camera buttons.

⚠️ Depending on the TV model, you may see some digital noise or part of an image may not appear.
• Images may not be centered on the TV screen depending on your TV settings.
Viewing files on an HDTV
You can view high-quality and uncompressed photos or videos on an HDTV using the optional HDMI cable. HDMI (High Definition Multimedia Interface) is supported by most HDTVs.

1. In Shooting or Playback mode, press [MENU].
2. Select HDMI Size.
3. Select an HDMI resolution. (p. 153)
4. Turn off your camera and HDTV.
5. Connect your camera to your HDTV with the optional HDMI cable.

6. Turn on your camera.
   - If you have an Anynet+ compatible Samsung HDTV and you have turned on your camera’s Anynet+ function, the HDTV turns on automatically and displays the camera screen, while the camera automatically enters Playback mode.
   - If Anynet+ is off in your camera or your TV does not have Anynet+, the TV does not turn on automatically. Turn the TV on manually.

7. View files using the buttons on your camera or, if the TV has Anynet+, the remote control of your HDTV.

   • If your HDTV supports the Anynet+(CEC) profile, turn Anynet+ on in the camera’s settings menu (p. 152) to control the camera and TV with the TV’s remote control.
   • Anynet+ lets you control all connected Samsung A/V devices with the TV remote control.
   • The time it takes for the camera to connect to your HDTV may vary with the type of a memory card you use. A faster memory card will not necessarily result in a faster HDMI transfer, because the main function of the card is to improve the transfer rate during shooting.
Viewing files on a 3D TV
You can view photos captured in 3D Photo or 3D Panorama mode on a 3D TV.

1 In Shooting or Playback mode, press [MENU].
2 Select 🎥 → HDMI Size.
3 Select an HDMI resolution. (p. 153)
4 Turn off your camera and 3D TV.
5 Connect your camera to your 3D TV with the optional HDMI cable.

6 Turn on your camera.
   • If you have an Anynet+ compatible Samsung 3D TV and you have turned on your camera’s Anynet+ function, the 3D TV turns on automatically and displays the camera screen, while the camera automatically enters Playback mode.
   • If Anynet+ is off in your camera or your TV does not have Anynet+, the TV does not turn on automatically. Turn the TV on manually.

7 Press [esture] to switch to 3D TV Mode.
   • Press [esture] again to switch to 2D TV Mode.

8 Turn on your TV’s 3D function.
   • Refer to your TV’s user manual for more details.

9 View 3D photos with the buttons on your camera or, if the TV has Anynet+, the remote control of your 3D TV.

   • You cannot view an MPO file in 3D on TVs that do not support the file format.
   • Use proper 3D glasses when you view an MPO file on a 3D TV.

   Do not view the 3D images captured by your camera on a 3D TV or 3D monitor for an extended period of time. It may cause unpleasant symptoms, such as eyestrain, fatigue, nausea, and dizziness.
Transferring files to your Windows OS computer
Connect the camera to your computer as a removable disk.

Your computer must be running Windows XP, Windows Vista, or Windows 7 for you to connect the camera as a removable disk.

1 Turn off the camera.
2 Connect the camera to your computer with the USB cable.
   - You must plug the small end of the USB cable into your camera. If the cable is reversed, it may damage your files. The manufacturer is not responsible for any loss of data.
3 Turn on the camera.
   - The computer recognizes the camera automatically.
4 On your computer, select My Computer → Removable Disk → DCIM → 100PHOTO.
5 Drag or save files to your computer.

Disconnecting the camera (for Windows XP)
With Windows Vista and Windows 7, the methods for disconnecting the camera are similar.

1 If the status lamp on your camera is blinking, wait until it stops.
2 Click on the tool bar at the bottom right of your computer screen.
3 Click the pop-up message.
4 Click the message box that indicates the camera can be removed safely.
5 Remove the USB cable.

Transferring files to your computer
Connect the camera to the computer, to transfer files from the camera's memory card to the computer.
Transferring files to your Mac OS computer

When you connect the camera to a Macintosh computer, the computer will automatically recognize the device. You can transfer files directly from the camera to the computer without installing any programs.

- Mac OS 10.5 or later is supported.

1. Turn off the camera.
2. Connect your camera to a Macintosh computer with the USB cable.
3. Turn on the camera.
   - The computer recognizes the camera automatically and displays a removable disk icon.
4. Double-click the removable disk icon.
5. Drag or save files to your computer.

You must plug the small end of the USB cable into your camera. If the cable is reversed, it may damage your files. The manufacturer is not responsible for any loss of data.
Using programs on the computer

You can view and edit files using the provided programs. You can also send the files to a PC wirelessly.

Installing CD-provided programs

1. Insert the installation CD in a compatible CD-ROM drive.
2. Select a language to install.
3. Select a program to install.
4. Follow the on-screen instructions.
5. Click Exit to complete the installation, and then restart your computer.

<table>
<thead>
<tr>
<th>Programs contained on the CD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
</tr>
<tr>
<td>iLauncher</td>
</tr>
<tr>
<td>PC Auto Backup</td>
</tr>
<tr>
<td>Samsung RAW Converter</td>
</tr>
</tbody>
</table>
Using programs on the computer

Using iLauncher

iLauncher allows you to play back files with Multimedia Viewer and provides a link to download the PC Auto Backup program.

### Windows OS requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel® Core™ 2 Duo 1.66 GHz or higher/ AMD Athlon X2 Dual-Core 2.2 GHz or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum 512 MB RAM (1 GB or more recommended)</td>
</tr>
<tr>
<td>OS*</td>
<td>Windows XP SP2, Windows Vista, or Windows 7</td>
</tr>
<tr>
<td>Hard disk capacity</td>
<td>250 MB or more (1 GB and above recommended)</td>
</tr>
<tr>
<td>Others</td>
<td>• CD-ROM drive</td>
</tr>
<tr>
<td></td>
<td>• 1024 X 768 pixels, 16-bit color display compatible monitor (1280 X 1024 pixels, 32-bit color display recommended)</td>
</tr>
<tr>
<td></td>
<td>• USB 2.0 port</td>
</tr>
<tr>
<td></td>
<td>• nVIDIA GeForce 7600GT or higher/ ATI X1600 series or higher</td>
</tr>
<tr>
<td></td>
<td>• Microsoft DirectX 9.0c or higher</td>
</tr>
</tbody>
</table>

* A 32-bit version of iLauncher will be installed—even on 64-bit editions of Windows XP, Windows Vista, and Windows 7.

### Mac OS requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>Mac OS 10.5 or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum 256 MB RAM (512 MB or more recommended)</td>
</tr>
<tr>
<td>Hard disk capacity</td>
<td>Minimum 110 MB</td>
</tr>
<tr>
<td>Others</td>
<td>USB port, CD-ROM drive</td>
</tr>
</tbody>
</table>

If you use Mac OS computer, only Firmware Upgrade is available.

### Opening iLauncher

On your computer, select Start → All Programs → Samsung → iLauncher → Samsung iLauncher. Or, click Applications → Samsung → iLauncher on your Mac OS computer.

- The requirements are recommendation only. iLauncher may not work properly even when the computer meets the requirements, depending on the condition of your computer.
- If your computer does not meet the requirements, videos may not play correctly.

The manufacturer is not responsible for any damage that results from using unqualified computers such as a computer you assembled yourself.
Using programs on the computer

Using Multimedia Viewer
Multimedia Viewer allows you to play back files. From the Samsung iLauncher screen, double-click Multimedia Viewer.

- Multimedia Viewer supports the following formats:
  - Videos: MP4 (Video: H.264, Audio: AAC), WMV (WMV 7/8/9), AVI (MJPEG)
  - Photos: JPG, GIF, BMP, PNG, TIFF, MPO
- Files that have been recorded with other manufacturers’ devices may not play back smoothly.

Viewing photos

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>File name</td>
</tr>
<tr>
<td>2</td>
<td>Enlarged area</td>
</tr>
<tr>
<td>3</td>
<td>Histogram</td>
</tr>
<tr>
<td>4</td>
<td>Open the selected file.</td>
</tr>
<tr>
<td>5</td>
<td>Histogram button</td>
</tr>
<tr>
<td>6</td>
<td>Rotate to the left/Rotate to the right.</td>
</tr>
<tr>
<td>7</td>
<td>Move to the previous file/Move to the next file.</td>
</tr>
<tr>
<td>8</td>
<td>View the photo in the screen size.</td>
</tr>
<tr>
<td>9</td>
<td>View the photo in the original size.</td>
</tr>
<tr>
<td>10</td>
<td>Zoom in/Zoom out</td>
</tr>
<tr>
<td>11</td>
<td>Switches between 2D and 3D mode.</td>
</tr>
</tbody>
</table>
Using programs on the computer

Viewing videos

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>File name</td>
</tr>
<tr>
<td>2</td>
<td>Adjust volume.</td>
</tr>
<tr>
<td>3</td>
<td>Open the selected file.</td>
</tr>
<tr>
<td>4</td>
<td>Move to the next file.</td>
</tr>
<tr>
<td>5</td>
<td>Stop</td>
</tr>
<tr>
<td>6</td>
<td>Pause</td>
</tr>
<tr>
<td>7</td>
<td>Move to the previous file.</td>
</tr>
<tr>
<td>8</td>
<td>Progress bar</td>
</tr>
</tbody>
</table>
Using programs on the computer

**Updating the firmware**
From the Samsung iLauncher screen, double-click **Firmware Upgrade**.

**Downloading the PC Auto Backup program**
From the Samsung iLauncher screen, double-click **PC Auto Backup**. For information about installing the PC Auto Backup program, refer to page 141.

**Using Samsung RAW Converter**
Photos captured by a camera are often transformed to JPEG formats and stored in the memory according to the settings of the camera at the time of shooting. RAW files are not transformed to JPEG formats and are stored in the memory without any changes. With Samsung RAW Converter, you can calibrate exposures, white balances, tones, contrasts, and colors of photos.

**Opening Samsung RAW Converter**
On your computer, select **Start → All Programs → Samsung RAW Converter → Samsung RAW Converter**.
Using programs on the computer

**Using the Samsung RAW Converter Interface**
For details about using Samsung RAW Converter, click Help → Open software manual.

![Samsung RAW Converter Interface Diagram]

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Menu</td>
</tr>
<tr>
<td>2</td>
<td>Toolbar</td>
</tr>
<tr>
<td>3</td>
<td>Editing tools</td>
</tr>
<tr>
<td>4</td>
<td>Open/Close the fine adjustment window for the editing tools</td>
</tr>
</tbody>
</table>

Playback/Editing 122
Using programs on the computer

**Editing RAW format files**

If you edit the RAW format files with the Samsung RAW Converter, you can maintain high image quality. You can also edit JPEG and TIFF format files.

To adjust the exposure of an image

1. Select **File → Open file** and open a file.
2. From the editing tools, select 📜.
3. Adjust the exposure with the scroll bar.

• You can view the brightness of the image from the histogram window.

![Original image](image1)

![Changed image after correcting the exposure](image2)

![Original image](image3)

![Changed image after correcting the exposure](image4)
To adjust the tone of an image

1 Select File → Open file and open a file.
2 From the editing tools, select [ ].
3 Adjust the tone with the scroll bar.

▲ Original image
P Mode, Aperture: f=8, Shutter Speed: 1/15 sec, ISO=100

▲ Changed image after correcting the contrast
Using programs on the computer

**Saving RAW files as JPEG/TIFF formats**

1. Select **File → Open file** and open a file.
2. Select **File → One scene development**.
3. Select a file format (JPEG or TIFF) and select **Development**.

![Image of One scene development window](image-url)
Wireless network

Learn how to connect to wireless local area networks (WLANs) and use functions.

Connecting to a WLAN and configuring network settings .................................. 127
  Connecting to a WLAN .................................. 127
  Using the login browser ................................. 129
  Network connection tips ............................... 129
  Entering text ........................................... 130

Sending photos or videos to a smart phone .................................................. 132

Using a smart phone as a remote shutter release ........................................ 133

Using photo or video sharing websites ..................................................... 135
  Accessing a website ..................................... 135
  Uploading photos or videos .............................. 135

Sending photos or videos via email ...................................................... 137
  Changing email settings .................................. 137
  Sending photos or videos via email ..................... 139

Uploading photos to a cloud server .................................................... 140

Using Auto Backup to send photos or videos ........................................ 141
  Installing the program for Auto Backup on your PC .................................. 141
  Sending photos or videos to a PC ....................... 141

Viewing photos or videos on a TV Link-enabled TV ................................... 143

Sending photos using Wi-Fi Direct .................................................... 145

About the Wake on LAN (WOL) feature ................................................ 146
Connecting to a WLAN and configuring network settings

Learn to connect via an access point (AP) when you are in a range of a WLAN. You can also configure network settings.

Connecting to a WLAN

1. Rotate the mode dial to Wi-Fi.
2. Select 🌐, 📡, 📲, 📚, or 📹.
3. Press [MENU], and then select Wi-Fi Setting.
   - In some modes, press [MENU] or follow the on-screen instructions until the AP Setting screen appears.
   - The camera automatically searches for available AP devices.
4. Select an AP.

   ![Wi-Fi Setting]

   - Select WPS button connection to connect to a WPS AP.
   - Select Refresh to refresh connectable APs.
   - Select Add wireless network to add an AP manually.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>WPS AP</td>
</tr>
<tr>
<td>🗝️</td>
<td>Secured AP</td>
</tr>
<tr>
<td>🔊</td>
<td>Signal strength</td>
</tr>
<tr>
<td>➡️</td>
<td>Press [WiFi] to open AP setting options</td>
</tr>
</tbody>
</table>

- When you select a secured AP, a pop-up window appears. Enter the required passwords to connect to the WLAN. For information about entering text, refer to "Entering text". (p. 130)
- When a login page appears, refer to "Using the login browser". (p. 129)
- When you select an unsecured AP, the camera will connect to the WLAN.
- If you select a WPS profile supported AP, select WPS PIN, and then enter a PIN on the AP device. You can also connect to a WPS profile supported AP by selecting WPS button connection on the camera, and then pushing the WPS button on the AP device.
Connecting to a WLAN and configuring network settings

**Setting network options**

1. In the AP Setting screen, move to an AP, and then press [Wi-Fi].

2. Select each option, and then enter the required information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>Select a network authentication type.</td>
</tr>
<tr>
<td>Data Encryption</td>
<td>Select an encryption type.</td>
</tr>
<tr>
<td>Network Password</td>
<td>Enter the network password.</td>
</tr>
<tr>
<td>IP Setting</td>
<td>Set the IP address manually.</td>
</tr>
<tr>
<td>WPS PIN</td>
<td>Enter a PIN on the AP device.</td>
</tr>
</tbody>
</table>

**Manually setting the IP address**

1. In the AP Setting screen, move to an AP, and then press [Wi-Fi].

2. Select **IP Setting → Manual**.

3. Select each option, and then enter the required information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP</td>
<td>Enter the static IP address.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Enter the subnet mask.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Enter the gateway.</td>
</tr>
<tr>
<td>DNS Server</td>
<td>Enter the DNS address.</td>
</tr>
</tbody>
</table>
Connecting to a WLAN and configuring network settings

Using the login browser
You can enter your login information via the login browser when connecting to some APs, sharing sites, or cloud servers.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[DISP/०/५/४]</td>
<td>Move to an item or scroll the page.</td>
</tr>
<tr>
<td>[OK]</td>
<td>Select an item.</td>
</tr>
<tr>
<td>[MENU]</td>
<td>Access the following options:</td>
</tr>
<tr>
<td></td>
<td>• Previous Page: Move to the previous page.</td>
</tr>
<tr>
<td></td>
<td>• Next Page: Move to the next page.</td>
</tr>
<tr>
<td></td>
<td>• Reload: Reload the page.</td>
</tr>
<tr>
<td></td>
<td>• Stop: Stop loading the page.</td>
</tr>
<tr>
<td></td>
<td>• Exit: Close the login browser.</td>
</tr>
<tr>
<td>[●]</td>
<td>Close the login browser.</td>
</tr>
</tbody>
</table>

Network connection tips
• The quality of the network connection will be determined by the AP.
• The further the distance between your camera and the AP, the longer it will take to connect to the network.
• If a nearby device is using the same radio frequency signal as your camera, it may interrupt your connection.
• If your AP name is not in English, the camera may not be able to locate the device or the name may appear incorrectly.
• For network settings or a password, contact your network administrator or network service provider.
• If a WLAN requires authentication from the service provider, you may not be able to connect to it. To connect the WLAN, contact your network service provider.
• Depending on the encryption type, the number of digits in the password may differ.
• A WLAN connection may not be possible in all surroundings.
• The camera may display a WLAN enabled printer on the AP List. You cannot connect to a network via a printer.
• You cannot connect your camera to a network and a TV simultaneously. Also, you cannot view photos or videos on a TV while connected to a network.
• Connecting to a network may incur additional charges. Costs will vary based on the conditions of your contract.
Connecting to a WLAN and configuring network settings

- If you cannot connect to a WLAN, try another AP from the available AP list.
- You can also connect to free WLANs in some foreign countries.
- A login page may appear when you select free WLANs provided by some network service providers. Enter your ID and password to connect to the WLAN. For information about registering or the service, contact the network service providers.
- Be cautious when you enter personal information for an AP connection. Do not enter any payment or credit card information on your camera. The manufacturer is not liable for any problem caused by entering such information.
- Available network connections may differ by country.
- The WLAN feature of your camera must comply with radio transmission laws in your region. To ensure compliance, use the WLAN feature only in the country where you purchased the camera.
- The process for adjusting network settings may differ, depending on network conditions.
- Do not access a network that you are not authorized to use.
- Before you connect to a network, ensure your battery is fully charged.
- When a DHCP server is not available you must make an autoip.txt file and copy it to the inserted memory card to connect to the network using Auto IP.
- You cannot upload or send files captured in 3D Photo, 3D Panorama modes.
- Files that you transfer to another device may not be supported by the device. In this case, use a computer to playback the files.

Entering text
Learn how to enter text. The icons in the table below let you move the cursor, change the case, etc. Rotate the navigation button or press [DISP/�能/@/[WiFi]] to move to a desired key, and then press [OK] to enter the key.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Delete the last letter.</td>
</tr>
<tr>
<td>◄ ►</td>
<td>Move the cursor.</td>
</tr>
<tr>
<td>↑</td>
<td>In ABC mode, change the case.</td>
</tr>
<tr>
<td>.com</td>
<td>Enter &quot;.com&quot;.</td>
</tr>
<tr>
<td>!@#</td>
<td>Switch to Symbol mode.</td>
</tr>
</tbody>
</table>
Connecting to a WLAN and configuring network settings

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td>Switch to ABC mode.</td>
</tr>
<tr>
<td></td>
<td>Enter a space.</td>
</tr>
<tr>
<td>Done</td>
<td>Save the displayed text.</td>
</tr>
<tr>
<td>🎉</td>
<td>View the entering text guide.</td>
</tr>
</tbody>
</table>

- You can use only the English alphabet, regardless of the display language.
- To move to Done directly, press [enter].
- You can enter up to 128 characters.
Sending photos or videos to a smart phone

The camera connects to a smart phone that supports the MobileLink feature via a WLAN. You can easily send photos or videos to your smart phone.

- The MobileLink feature is supported by Galaxy series smart phones with the Android 2.2 OS or higher. If your smart phone uses the Android 2.1 OS, upgrade your smart phone to Android 2.2 or higher. This feature is also supported by the 7 and 10.1 inch Galaxy Tab. This feature may be supported by other devices with Android 2.2 or higher, but Samsung makes no guarantee of its functionality.
- You should install the Samsung MobileLink application on your phone or device before using this feature. You can download the application from Samsung Apps or Play Store.
- When there are no files in the camera memory, you cannot use this feature.
- You can view up to 1,000 files and send up to 100 files at a time.

1. On the camera, rotate the mode dial to Wi-Fi.
2. On the camera, select 📱.
   - If the pop-up message that prompts you to download the application appears, select Next.
3. On the camera, select All Images or Selected Images to select files to share with the smart phone.
   - Only the selected files will be displayed on the smart phone.
   - If you selected Selected Images, select Share on the camera after selecting files to share.
4. On the smart phone, turn on the Samsung MobileLink application.
   - Read the on-screen instructions carefully to select and connect to your camera.
   - The smart phone can connect to only one camera at a time.
5. On the camera, select Yes.
6. On the smart phone, select files to send from the camera to the smart phone.
7. On the smart phone, select Copy.
   - The camera will send the files.
Wireless network 133

Using a smart phone as a remote shutter release

The camera connects to a smart phone via a WLAN. Use the smart phone as a remote shutter release with the Remote Viewfinder feature. The captured photo will display on the smart phone.

- The Remote Viewfinder feature is supported by Galaxy series smart phones with the Android 2.2 OS or higher. If your smart phone uses the Android 2.1 OS, upgrade your smart phone to Android 2.2 or higher. This feature is also supported by the 7 and 10.1 inch Galaxy Tab. This feature may be supported by other devices with Android 2.2 or higher, but Samsung makes no guarantee of its functionality.
- You should install the Remote Viewfinder application on your phone or device before using this feature. You can download the application from Samsung Apps or Play Store.

1. On the camera, rotate the mode dial to **Wi-Fi**.

2. On the camera, select 📷.
   - If the pop-up message that prompts you to download the application appears, select **Next**.

3. On the smart phone, turn on the Remote Viewfinder application.
   - Read the on-screen instructions carefully to select and connect to your camera.
   - The smart phone can connect to only one camera at a time.

4. On the smart phone, set the following shooting options.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔆</td>
<td>Flash option</td>
</tr>
<tr>
<td>⏰</td>
<td>Timer option</td>
</tr>
<tr>
<td>📷</td>
<td>Photo size</td>
</tr>
</tbody>
</table>

- While using this feature, some buttons are not available on your camera.
- The zoom button and the shutter button on your smart phone will not function when using this feature.
- Remote Viewfinder mode supports the 📷 and 📷 photo sizes only.
Using a smart phone as a remote shutter release

5 On the smart phone, touch and hold (셔터) to focus.
   • The focus is automatically set to multi-AF.

6 Release (셔터) to capture the photo.
   • The photo will be saved in your camera.
   • Touch the photo in the bottom of the screen to save it to the
     smart phone. The photo will be resized to 640 X 360.

   • When you use this feature, the ideal distance between the camera
     and the smart phone may vary, depending on your surroundings.
   • The smart phone must be within 7 m of the camera to use this feature.
   • It will take some time to capture the photo after you release (셔터) on the
     smart phone.
   • The Remote Viewfinder function will deactivate when:
     - there is an incoming call on the smart phone
     - either the camera or the smart phone turns off
     - the memory is full
     - either device loses its connection to the WLAN
     - the Wi-Fi connection is poor or unstable
Using photo or video sharing websites

Upload your photos or videos to file sharing websites. Available websites will be displayed on your camera.

Accessing a website

1. Rotate the mode dial to **Wi-Fi**.
2. Select 🌍.
3. Select a website.
   - The camera will automatically attempt to connect to a WLAN via the most recently connected AP device.
   - If the camera has not previously been connected to a WLAN, it will search for available AP devices. (p. 127)
4. Enter your ID and password, and then select **Login**.
   - For information about entering text, refer to "Entering text". (p. 130)
   - To select an ID from the list, select ▼ → an ID.
   - If you have previously logged in to the website, you may be logged in automatically.

You must have an existing account on the file sharing website to use this feature.

Uploading photos or videos

1. Access the website with your camera.
2. Scroll to the files you want to upload, and then press [OK].
   - You can select up to 20 files. The total size must be 10 MB or less.
3. Select **Upload**.
   - If you connected to the Facebook, select **Upload → Upload**.
   - If you connected to the Facebook, you can enter your comments by selecting the **Comment** box. For information about entering text, refer to "Entering text". (p. 130)
Using photo or video sharing websites

• You cannot upload files if the file size exceeds the limit. The maximum photo resolution you can upload is 2M, and the longest video you can upload is a video recorded using [ ] . If the selected photo resolution is higher than 2M, it will be automatically resized to a lower resolution.
• The method of uploading photos or videos may differ and some functions may not be available depending on the selected website.
• If you cannot access a website because of firewall or user authentication settings, contact your network administrator or network service provider.
• Uploaded photos or videos may be automatically titled with the date they were captured.
• The speed of your internet connection may affect how quickly photos upload or web pages open.
• When there are no files in the camera memory, you cannot use this feature.
• You can also upload photos or videos to file sharing websites in Playback mode by pressing [MENU], and then selecting → a desired website.
• Your camera’s model name will be the album title.
Sending photos or videos via email

You can change settings in the email menu, and send photos or videos stored on the camera via email.

Changing email settings

In the email menu, you can change settings for storing your information. You can also set or change the email password. For information about entering text, refer to "Entering text". (p. 130)

Storing your information

1. Rotate the mode dial to Wi-Fi.
2. Select [Wireless].
   - The camera will automatically attempt to connect to a WLAN via the most recently connected AP device.
   - If the camera has not previously been connected to a WLAN, it will search for available AP devices. (p. 127)
3. Press [MENU].
4. Select Sender Setting.
5. Select the Name box, enter your name, and then select Done.
6. Select the Email box, enter your email address, and then select Done.
7. Select Save to save your changes.
   - To delete your information, select Reset.
Sending photos or videos via email

**Setting an email password**

1. Rotate the mode dial to **Wi-Fi**.
2. Select 
   - The camera will automatically attempt to connect to a WLAN via the most recently connected AP device.
   - If the camera has not previously been connected to a WLAN, it will search for available AP devices. (p. 127)
3. Press [MENU].
4. Select **Setting Password → On**.
   - To deactivate the password, select **Off**.
5. When the pop-up appears, press [OK].
6. Enter a 4-digit password.
7. Enter the password again.
8. When the pop-up appears, press [OK].

   If you lost your password, you can reset it by selecting **Reset** on the password input screen. When you reset the information, previously saved user's setting information, email address, and recently sent email list will be deleted.

**Changing the email password**

1. Rotate the mode dial to **Wi-Fi**.
2. Select 
   - The camera will automatically attempt to connect to a WLAN via the most recently connected AP device.
   - If the camera has not previously been connected to a WLAN, it will search for available AP devices. (p. 127)
3. Press [MENU].
4. Select **Change Password**.
5. Enter your current 4-digit password.
6. Enter a new 4-digit password.
7. Enter the new password again.
8. When the pop-up appears, press [OK].
Sending photos or videos via email

You can send photos or videos stored on the camera via email. For information about entering text, refer to "Entering text".  
(p. 130)

1 Rotate the mode dial to Wi-Fi.

2 Select \( \text{ } \).  
   • The camera will automatically attempt to connect to a WLAN via the most recently connected AP device.  
   • If the camera has not previously been connected to a WLAN, it will search for available AP devices. (p. 127)

3 Select the Sender box, enter your email address, and then select Done.  
   • If you have previously saved your information, it will be inserted automatically. (p. 137)

4 Select the Recipient box, enter an email address, and then select Done.  
   • To use an address from the list of previous recipients, select \( \text{ } \) an address.  
   • Select \( \text{ } \) to add additional recipients. You can input up to 30 recipients.  
   • Select \( \times \) to delete an address from the list.

5 Select Next.

6 Scroll to files to send, and then press [OK].  
   • You can select up to 20 files. The total size must be 7 MB or less.

7 Select Next.

8 Select the Comment box, enter your comments, and then select Done.

9 Select Send.

• Even if a photo appears to have transferred successfully, errors with the recipient's email account may cause the photo to be rejected or recognized as spam.  
• You may not be able to send an email if no network connection is available or if your email account settings are incorrect.  
• You cannot send an email if the file size exceeds the limit. The maximum photo resolution you can send is 2M, and the longest video you can upload is a video recorded using \( \text{ } \). If the selected photo resolution is higher than 2M, it will be automatically resized to a lower resolution.  
• If you cannot send an email because of firewall or user authentication settings, contact your network administrator or network service provider.  
• When there are no files in the camera memory, you cannot use this feature.  
• You can also send an email in Playback mode by pressing [MENU], and then selecting \( \text{ } \) Email.
Uploading photos to a cloud server

You can upload your photos to SkyDrive. To upload photos, you must visit the Microsoft website and register before connecting your camera.

1 Rotate the mode dial to **Wi-Fi**.

2 Select 📷.

3 Select **SkyDrive**.
   - If the pop-up message that prompts you to create an account appears, select **OK**.
   - The camera will attempt to connect to a WLAN via the most recently connected AP.
   - If the camera has not previously been connected to a WLAN, it will search for available AP devices. (p. 127)

4 Login with your ID and password.
   - For information about entering text, refer to "Entering text". (p. 130)
   - If you connected to SkyDrive, refer to "Using the login browser". (p. 129)

5 Scroll to the photos you want to upload, and then press **Upload**.

   • You can also upload photos to a cloud server in Playback mode by pressing [MENU], and then select 📷 ➔ a cloud server.
   • When there are no photos in the camera memory, you cannot use this feature.
   • When you upload photos to SkyDrive, they will be resized to 2M while maintaining its aspect ratio.
Using Auto Backup to send photos or videos

You can send photos or videos that you captured with the camera to a PC wirelessly. The Auto Backup feature works only with the Windows OS.

Installing the program for Auto Backup on your PC

1. Install iLauncher on the PC. (p. 117)
2. Connect the camera to the PC with the USB cable.
3. When the Auto Backup program icon appears, double-click it.
   • The Auto Backup program is installed on the PC. Follow the on-screen instructions to complete the installation.
4. Remove the USB cable.
5. Connect the camera to the PC again with the USB cable.
   • The camera stores information about the PC, so that the camera can send files to the PC.

Sending photos or videos to a PC

1. Rotate the mode dial to Wi-Fi.
2. Select ⏳.
   • If the guide message appears, press [OK].
   • To turn off your PC automatically after the transfer is complete, select Shut down PC after backup → On.
4. Press [OK] to start the backup.
   • To cancel sending, press [OK].
   • You cannot select individual files to backup. This function backs up only new files on the camera.
   • The backup’s progress will be shown on the PC monitor.
   • When the transfer is completed, the camera will turn off automatically in approximately 30 seconds. Select Cancel to return to the previous screen and prevent the camera from turning off automatically.

Before installing the program, ensure that the PC is connected to a network. If no internet connection is available, you must install the program from the provided CD.
Using Auto Backup to send photos or videos

- If the PC supports the Wake on LAN (WOL) feature, you can turn on the PC automatically by searching for the PC from your camera. (p. 146)
- When you connect the camera to the WLAN, select the AP that is connected to the PC.
- The camera will search for available access points even if you are connecting to the same access point again.
- If you turn off the camera or remove the battery while sending files, the file transfer will be interrupted.
- You can connect only one camera to the PC at a time for sending files.
- The backup may be canceled due to network conditions.
- Photos or videos can be sent to a PC one time only. Files cannot be sent again even if you reconnect your camera to another PC.
- When there are no files in the camera memory, you cannot use this feature.
- You must turn off Windows Firewall and any other firewalls before using this feature.
- You can send up to 1,000 files.
- On the PC software, the server name must be entered in the Latin alphabet and can contain no more than 48 characters.
Viewing photos or videos on a TV Link-enabled TV

TV Link is a technology for sharing media files between a camera and TV connected to the same AP device. With this technology, you can view your photos or videos on a widescreen TV.

1 Rotate the mode dial to Wi-Fi.

2 Select √.
   • If the guide message appears, press [OK].
   • The camera will automatically attempt to connect to a WLAN via the most recently connected AP device.
   • If the camera has not previously been connected to a WLAN, it will search for available AP devices. (p. 127)

3 Connect your TV to a wireless network via an AP device.
   • Refer to your TV’s user manual for more information.

4 On the TV, search for the camera and browse the shared photos or videos.
   • For information about searching for the camera and browsing the photos or videos on the TV, refer to the TV user manual.
   • Videos may not play smoothly depending on the type of TV or network condition. If this happens, re-record the video in VGA or SD quality and play it again. If videos do not play smoothly on your TV over the wireless connection, try connecting the camera to the TV with an A/V cable.
Viewing photos or videos on a TV Link-enabled TV

- You can share up to 1,000 photos or videos.
- On a TV screen, you can view only photos or videos captured with your camera.
- The range of the wireless connection between your camera and a TV may vary depending on the specifications of the AP.
- If the camera is connected to 2 TVs, playback may be slower.
- Photos or videos will be shared in their original sizes.
- You can use this feature only with TV Link-enabled TVs.
- Shared photos or videos will not be stored on the TV, but they can be stored in the camera to meet the TV’s specifications.
- Transferring photos or videos to the TV may take some time depending on the network connection, the number of files to be shared, or sizes of the files.
- If you power off the camera abnormally while viewing photos or videos on a TV (for example, by removing the battery), the TV considers the camera to still be connected.
- The order of photos or videos on the camera may be different than on the TV.
- Depending on the number of photos or videos you want to share, it may take some time to load your photos or videos and complete the initial set-up process.

- While viewing photos or videos on the TV, continuously using the TV remote or performing additional operations on the TV may prevent this feature from working properly.
- If you reorder or sort files on the camera while viewing them on a TV, you must repeat the initial set-up process to update the list of files on the TV.
- When there are no files in the camera memory, you cannot use this feature.
- We recommend you use a network cable to connect your TV to your AP. This will minimize any video ‘Stuttering’ you may experience when streaming content.
Sending photos using Wi-Fi Direct

When the camera connects via a WLAN to a device that supports the Wi-Fi Direct function, you can send photos to the device. This feature may not be supported on some devices.

1. On the device, turn on the Wi-Fi Direct option.

2. On the camera, in Playback mode, scroll to a photo.

3. Press [MENU], and then select → Wi-Fi Direct.
   - When in the single image view, you can send only one photo at a time.
   - When in thumbnails view, you can select multiple photos by scrolling to thumbnails, and then pressing [OK]. Select Next when you are finished selecting photos.

4. Select the device from the camera’s list of Wi-Fi Direct devices.
   - Ensure that the device’s Wi-Fi Direct option is turned on.
   - You can also select your camera from the device’s list of Wi-Fi Direct devices.

5. On the device, allow the camera to connect to the device.
   - The photo will be sent to the device.

   - When there are no photos in the camera memory, you cannot use this feature.
   - If you cannot connect to a Wi-Fi Direct device, update the device with the latest firmware. This feature may not be supported on some devices.
About the Wake on LAN (WOL) feature

With the WOL feature, you can automatically turn on or wake up a PC with your camera. This feature has been available for Samsung desktop PCs for the last 5 years (not available for all-in-one PCs).

Any changes to your PC's BIOS settings other than the ones described below may damage your PC. The manufacturer is not responsible for damage caused by your changing your PC’s BIOS settings.

1 Click Start, and then open the Control Panel.

2 Configure the network connection.
   - Windows 7:
     Click Network and Internet → Network and Sharing Center → Change adapter settings.
   - Windows Vista:
     Click Network and Internet → Network and Sharing Center → Manage network connections.
   - Windows XP:
     Click Network and Internet Connection → Network Connection.

3 Right click Local Area, and then click Properties.

4 Click Configure → the Power manage tab → Allow this device to wake the computer.

5 Click OK.

6 Restart the PC.
Setting the PC to turn on

1. Turn on the PC, and then press F2 while the PC is booting.
   • The BIOS setting menu will appear.

2. Select **Advanced tab → Power management Setup**.

3. Select **Resume on PME → Enabled**.

4. Press F10 to save your changes, and then continue booting.

5. Click **Start**, and then open the **Control Panel**.

6. Configure the network connection.
   • Windows 7:
     Click **Network and Internet → Network and Sharing Center → Change adapter settings**.

   • Windows Vista:
     Click **Network and Internet → Network and Sharing Center → Manage network connections**.

   • Windows XP:
     Click **Network and Internet Connection → Network Connection**.

7. Select the drivers for the network adapter.

8. Click the **Advanced tab**, and then set the WOL menus.

   • You cannot use this feature across a firewall or if a security program has been installed.

   • To turn on the PC with the WOL feature, the PC must have an active connection to the LAN. Ensure that the indicator light on the PC’s LAN port is on indicating that the LAN connection is active.

   • Depending on your PC model, the camera may only be able to wake the PC.

   • Depending on your PC’s OS or drivers, the names of the WOL setting menu may vary.
     - examples of setting menu names: Enable PME, Wake on LAN, etc.
     - examples of setting menu values: Enable, Magic packet, etc.
Settings
Refer to options to configure your camera’s settings.

Settings menu ................................................. 149
  Accessing the settings menu ......................... 149
  Using the settings menu ................................. 150
Settings menu

Learn to configure your camera’s settings.

Accessing the settings menu

1 In Shooting or Playback mode, press [MENU].
2 Select an item.

3 Select an option.

4 Press [MENU] to return to the previous screen.
### Using the settings menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Sounds</strong></td>
<td>Set various camera sounds and the volume.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Volume</strong>: Set the volume of all sounds.</td>
</tr>
<tr>
<td></td>
<td>- (Off, Low, Medium*, High)</td>
</tr>
<tr>
<td></td>
<td>- <strong>Start Sound</strong>: Set to emit a sound when you turn on your camera.</td>
</tr>
<tr>
<td></td>
<td>- (Off*, On)</td>
</tr>
<tr>
<td></td>
<td>- <strong>Shutter Sound</strong>: Set to emit a sound when you press the shutter button.</td>
</tr>
<tr>
<td></td>
<td>- (Off, On*)</td>
</tr>
<tr>
<td></td>
<td>- <strong>Beep Sound</strong>: Set to emit a sound when you press the buttons or switch modes.</td>
</tr>
<tr>
<td></td>
<td>- (Off, On*)</td>
</tr>
<tr>
<td></td>
<td>- <strong>AF Sound</strong>: Set to emit a sound when you half-press the shutter button.</td>
</tr>
<tr>
<td></td>
<td>- (Off, On*)</td>
</tr>
<tr>
<td><strong>Help Guide Display</strong></td>
<td>Display a brief description of an option or a menu.</td>
</tr>
<tr>
<td></td>
<td>- (Off, On*)</td>
</tr>
<tr>
<td><strong>Guide Line</strong></td>
<td>Select a guide to help you compose a scene.</td>
</tr>
<tr>
<td></td>
<td>- (Off*, 3 X 3, 2 X 2, Cross, Diagonal)</td>
</tr>
<tr>
<td><strong>Date/Time Display</strong></td>
<td>Set whether or not to display the date and time on the camera’s display.</td>
</tr>
<tr>
<td></td>
<td>- (Off*, On)</td>
</tr>
<tr>
<td><strong>Display Brightness</strong></td>
<td>Adjust the brightness of the screen.</td>
</tr>
<tr>
<td></td>
<td>- (Auto*, Dark, Normal, Bright)</td>
</tr>
<tr>
<td></td>
<td>- Normal is fixed in Playback mode even if you have selected Auto.</td>
</tr>
<tr>
<td><strong>Quick View</strong></td>
<td>Set the duration for reviewing a captured image before returning to the Shooting mode.</td>
</tr>
<tr>
<td></td>
<td>- (Off, 1 sec*, 3 sec)</td>
</tr>
<tr>
<td><strong>Auto Display Off</strong></td>
<td>If you perform no operations for 60 seconds, the camera screen turns off automatically and the status lamp blinks.</td>
</tr>
<tr>
<td></td>
<td>- (Off, On*)</td>
</tr>
<tr>
<td></td>
<td>- When the screen turns off automatically, press any button other than [POWER] to resume using the camera.</td>
</tr>
<tr>
<td></td>
<td>- Even if you do not set this function, the screen will dim 60 seconds after the last operation to save power.</td>
</tr>
<tr>
<td><strong>Network Information</strong></td>
<td>See the Mac address and serial number of your camera.</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>Set a language for the display text.</td>
</tr>
</tbody>
</table>
### Date and Time

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time Zone</strong></td>
<td>Set the time zone for your location. When you travel to another country, select Visit, and then select the appropriate time zone. (Home*, Visit)</td>
</tr>
<tr>
<td><strong>Date/Time Set</strong></td>
<td>Set the date and time.</td>
</tr>
<tr>
<td><strong>Date Type</strong></td>
<td>Set a date format. (YYYY/MM/DD, MM/DD/YYYY*, DD/MM/YYYY)</td>
</tr>
<tr>
<td></td>
<td>The default date type may differ depending on the language selected.</td>
</tr>
<tr>
<td><strong>Time Type</strong></td>
<td>Set a time format. (12 Hr*, 24 Hr)</td>
</tr>
<tr>
<td><strong>Imprint</strong></td>
<td>Set whether or not to display the date and time on captured photos. (Off*, Date, Date &amp; Time)</td>
</tr>
<tr>
<td></td>
<td>• The date and time will be displayed on the bottom right corner of the photo.</td>
</tr>
<tr>
<td></td>
<td>• Some printer models may not print the date and time properly.</td>
</tr>
<tr>
<td></td>
<td>• The photo will not display the date and time if you take shots in some Scene mode, Panorama mode, or Picture in Picture mode.</td>
</tr>
</tbody>
</table>

### File No.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specify how to name files.</td>
</tr>
<tr>
<td><strong>Reset</strong></td>
<td>Set the file number to start from 0001 when you insert a new memory card, format a memory card, or delete all files.</td>
</tr>
<tr>
<td><strong>Series</strong></td>
<td>Set the file number to resume from the previous file number when you insert a new memory card, format a memory card, or delete all files.</td>
</tr>
<tr>
<td></td>
<td>• The default name of the first folder is 100PHOTO and the default name of the first file is SAM_0001.</td>
</tr>
<tr>
<td></td>
<td>• The file number increases one at a time from SAM_0001 to SAM_9999.</td>
</tr>
<tr>
<td></td>
<td>• The folder numbers increase one at a time from 100PHOTO(SAM_0001<del>SAM_0999) to 999PHOTO(SAM_9000</del>SAM_9999).</td>
</tr>
<tr>
<td></td>
<td>• The maximum number of files that can be stored in one folder is 1,000.</td>
</tr>
<tr>
<td></td>
<td>• The camera defines file names according to the Design rule for Camera File system (DCF) standard. If you intentionally change file names, the camera may not play back the files.</td>
</tr>
</tbody>
</table>
## Settings menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Power Off</td>
<td>Set the camera to automatically turn off when you perform no operations for a specified period. <em>(Off, 1 min, 3 min</em>, 5 min, 10 min)*</td>
</tr>
<tr>
<td></td>
<td>• Your settings will not change when you replace the battery.</td>
</tr>
<tr>
<td></td>
<td>• The camera will not automatically turn off when the camera is connected to a computer or WLAN, and when you are playing a slide show or videos.</td>
</tr>
<tr>
<td>Smart Link (Wi-Fi Button)</td>
<td>Set a Wi-Fi function to launch when you press [ ]. <em>(MobileLink</em>, Remote Viewfinder, Social Sharing, Email, Cloud, Auto Backup, TV Link)*</td>
</tr>
<tr>
<td>AF Lamp</td>
<td>Set a light to automatically turn on in dark places to help you focus. <em>(Off, On)</em></td>
</tr>
<tr>
<td>Conversion lens</td>
<td>Set to use optional conversion lens. <em>(Off</em>, On)*</td>
</tr>
<tr>
<td>Format</td>
<td>Format the memory card. Formatting will delete all files, including protected files. <em>(Yes, No)</em></td>
</tr>
<tr>
<td></td>
<td>Errors can occur if you use a memory card formatted by another brand of camera, a memory card reader, or a computer. Please format memory cards in the camera before using them to capture photos.</td>
</tr>
<tr>
<td>Reset</td>
<td>Reset menus and shooting options. Date, time, language, and video output settings will not be reset. <em>(Yes, No)</em></td>
</tr>
<tr>
<td>Anynet+ (HDMI-CEC)</td>
<td>Turn on to control the camera with a TV remote control when you connect it to an HDTV that supports the Anynet+(CEC) profile.</td>
</tr>
<tr>
<td></td>
<td>• Off: View files without using an HDTV remote control.</td>
</tr>
<tr>
<td></td>
<td>• On*: Control the camera with an HDTV remote control.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **HDMI Size**   | Set the resolution of photos when the camera plays back files on an HDTV via the HDMI cable. (NTSC: **1080i**, **720p**, **480p**/PAL: **1080i**, **720p**, **576p**)
* If the HDTV does not support the selected resolution, the HDTV automatically selects the next lower resolution.
* If you select **480p** or **576p**, the playback menus and Smart Album will not be available when you connect the camera to a TV. |
| **Video Out**   | Set the video signal output for your region.                                 |
* **NTSC**: USA, Canada, Japan, Korea, Taiwan, Mexico, etc
* **PAL** (supports only BDGHI): Australia, Austria, Belgium, China, Denmark, England, Finland, France, Germany, Italy, Kuwait, Malaysia, Netherlands, New Zealand, Norway, Singapore, Spain, Sweden, Switzerland, Thailand, etc |
| **Open Source Licenses** | Show the Open source licenses information.                               |
Appendixes

Get information about error messages, specifications, and maintenance.

Error messages ................................................. 155
Camera maintenance ........................................... 157
  Cleaning your camera ...................................... 157
  Using or storing the camera ............................... 158
  About memory cards ...................................... 160
  About the battery .......................................... 163
Using optional accessories ................................. 167
  Using optional flash units ................................ 167
  Using an optional optical viewfinder .................. 167
  Using an optional conversion lens ...................... 168
  Using the shutter release ............................... 169
  Using the microphone .................................... 169
Before contacting a service center .................... 170
Camera specifications ....................................... 173
Glossary ......................................................... 178
FCC notice ....................................................... 183
Declaration sentence in official languages ........... 186
Index ............................................................. 188
# Error messages

When the following error messages appear, try these remedies.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Suggested remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Error</td>
<td>• Turn off your camera, and then turn it on again.</td>
</tr>
<tr>
<td></td>
<td>• Remove your memory card, and then insert it again.</td>
</tr>
<tr>
<td></td>
<td>• Format your memory card.</td>
</tr>
<tr>
<td>Card Locked</td>
<td>You can lock an SD, SDHC, or SDXC card to prevent files from being deleted. Unlock the card when shooting.</td>
</tr>
<tr>
<td>Card not supported.</td>
<td>The inserted memory card is not supported by your camera. Insert a SD, SDHC, or SDXC memory card.</td>
</tr>
<tr>
<td>Connection failed.</td>
<td>• The camera cannot connect to the network using the selected access point. Select another AP and try again.</td>
</tr>
<tr>
<td></td>
<td>• The camera has failed to connect to the other devices. Try connecting again.</td>
</tr>
<tr>
<td>DCF Full Error</td>
<td>File names do not match the DCF standard. Transfer the files from the memory card to your computer and format the card. Then, open the Settings menu and select <strong>File No. → Reset</strong>. (p. 151)</td>
</tr>
<tr>
<td>Device disconnected.</td>
<td>Network connection disconnected while transferring photos. Select a TV Link device again.</td>
</tr>
<tr>
<td>File Error</td>
<td>Delete the damaged file or contact a service center.</td>
</tr>
<tr>
<td>File system not supported.</td>
<td>Your camera does not support the FAT file structure of the inserted memory card. Format the memory card on the camera.</td>
</tr>
<tr>
<td>Initialization failed.</td>
<td>• Turn on TV Link enabled devices on the network.</td>
</tr>
<tr>
<td></td>
<td>• The camera has failed to locate a TV Link-enabled device.</td>
</tr>
<tr>
<td>Invalid password.</td>
<td>The password for transferring files to another camera is wrong. Enter the correct password again.</td>
</tr>
</tbody>
</table>
## Error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Suggested remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Battery</td>
<td>Insert a charged battery or recharge the battery.</td>
</tr>
<tr>
<td>Memory Full</td>
<td>Delete unnecessary files or insert a new memory card.</td>
</tr>
<tr>
<td>No Image File</td>
<td>Capture photos or insert a memory card that contains some photos.</td>
</tr>
<tr>
<td>Photo transfer failed.</td>
<td>Network connection disconnected while transferring photos. Try turning on the TV Link feature again.</td>
</tr>
<tr>
<td>Transfer failed.</td>
<td>• The camera has failed to send a photo to the other devices. Try sending again.</td>
</tr>
<tr>
<td></td>
<td>• The camera has failed to send an email or transfer a photo to a TV Link device. Check the network connection and try again.</td>
</tr>
</tbody>
</table>
Camera maintenance

Cleaning your camera

**Camera lens and display**
Use a blower brush to remove dust and wipe the lens gently with a soft cloth. If any dust remains, apply lens cleaning liquid to a piece of lens cleaning paper and wipe gently.

**Camera body**
Wipe gently with a soft, dry cloth.

- Never use benzene, thinners, or alcohol to clean the device. These solutions can damage the camera or cause it to malfunction.
- Do not press on the lens cover or use a blower brush on the lens cover.
Using or storing the camera

**Inappropriate places to use or store the camera**

- Avoid exposing the camera to very cold or very hot temperatures.
- Avoid using your camera in areas with extremely high humidity, or where the humidity changes drastically.
- Avoid exposing the camera to direct sunlight and storing it in hot, poorly-ventilated areas, such as in a car during summer time.
- Protect your camera and the display from impact, rough handling, and excessive vibration to avoid serious damage.
- Avoid using or storing your camera in dusty, dirty, humid, or poorly-ventilated areas to prevent damage to moving parts and internal components.
- Do not use your camera near fuels, combustibles, or flammable chemicals. Do not store or carry flammable liquids, gases, or explosive materials in the same compartment as the camera or its accessories.
- Do not store the camera where there are mothballs.

**Using on beaches or shores**

- Protect your camera from sand and dirt when you use it on beaches or in similar areas.
- Your camera is not waterproof. Do not handle the battery, adapter, or memory card with wet hands. Operating the camera with wet hands may cause damage to your camera.

**Storing for extended period of time**

- When you store the camera for an extended period, place it in a sealed container with an absorbent material, such as silica gel.
- Remove the batteries from your camera when storing it for an extended period. Installed batteries may leak or corrode over time and cause serious damage to your camera.
- Over time, unused batteries will discharge and must be recharged before use.
- The present date and time can be initialized when the camera is turned on after the camera and battery have been separated for over 40 hours.
Camera maintenance

**Using the camera with caution in humid environments**
When you transfer the camera from a cold environment to a warm one, condensation can form on the lens or internal components of the camera. In this situation, turn off the camera and wait for at least 1 hour. If condensation forms on the memory card, remove the memory card from the camera and wait until all moisture has evaporated before reinserting it.

**Other cautions**
- Do not swing your camera by the strap. This may cause injury to yourself or others or damage to your camera.
- Do not paint your camera, as paint can clog moving parts and prevent proper operation.
- Turn off the camera when not using it.
- Your camera contains delicate parts. Avoid impacts to the camera.
- Protect the display from external force by keeping it in the case when not in use. Protect the camera from scratches by keeping it away from sand, sharp implements, or loose change.
- Do not use the camera if the screen is cracked or broken. Broken glass or acrylic could cause injury to your hands and face. Take the camera to a Samsung service center to have it repaired.
- Never place cameras, batteries, chargers, or accessories near, on, or in heating devices, such as microwave ovens, stoves, or radiators. These devices may be deformed and can overheat and cause a fire or explosion.
- Do not expose the lens to direct sunlight, as this may discolor the image sensor or cause it to malfunction.
- Protect the lens from fingerprints and scratches. Clean the lens with a soft, clean, debris-free lens cloth.
- The camera may turn off if struck or dropped. This is to protect the memory card. Turn on the camera to use it again.
- While you use the camera, it may heat up. This is normal and should not affect your camera’s lifespan or performance.
- When you use the camera in low temperatures, it may take some time to turn on, the color of the display may be changed temporarily, or after-images may appear. These conditions are not malfunctions and they will correct themselves when the camera is returned to milder temperatures.
- Paint or metal on the outside of the camera may cause allergies, itchy skin, eczema, or swelling for people with sensitive skin. If you experience any of these symptoms, stop using the camera immediately and consult a doctor.
- Do not insert foreign objects into any of your camera’s compartments, slots, or access points. Damage due to improper use may not be covered by your warranty.
- Do not allow unqualified personnel to service the camera or attempt to service the camera yourself. Any damage that results from unqualified service is not covered by your warranty.
Camera maintenance

About memory cards

**Supported memory cards**

This product supports SD (Secure Digital), SDHC (Secure Digital High Capacity), SDXC (Secure Digital eXtended Capacity), microSD, microSDHC, or microSDXC memory cards.

You can prevent files from being deleted by using the write-protect switch on an SD, SDHC, or SDXC card. Slide the switch down to lock or slide it up to unlock. Unlock the card when capturing photos and videos.

To use micro memory cards with this product, a PC, or a memory card reader, insert the card into an adapter.

### Memory card capacity

The memory capacity may differ depending on shooting scenes, shooting conditions, or a memory card. These capacities are based on a 2 GB SD card:

<table>
<thead>
<tr>
<th>Photo</th>
<th>Size</th>
<th>Super Fine</th>
<th>Fine</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 GB</td>
<td>277</td>
<td>313</td>
<td>503</td>
<td></td>
</tr>
<tr>
<td>10 GB</td>
<td>254</td>
<td>349</td>
<td>558</td>
<td></td>
</tr>
<tr>
<td>9 GB</td>
<td>286</td>
<td>392</td>
<td>623</td>
<td></td>
</tr>
<tr>
<td>8 GB</td>
<td>335</td>
<td>457</td>
<td>721</td>
<td></td>
</tr>
<tr>
<td>5 GB</td>
<td>333</td>
<td>456</td>
<td>719</td>
<td></td>
</tr>
<tr>
<td>3 GB</td>
<td>512</td>
<td>691</td>
<td>1,060</td>
<td></td>
</tr>
<tr>
<td>2 GB</td>
<td>819</td>
<td>1,081</td>
<td>1,588</td>
<td></td>
</tr>
<tr>
<td>1 GB</td>
<td>1,095</td>
<td>1,418</td>
<td>2,009</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2,165</td>
<td>2,610</td>
<td>3,284</td>
<td></td>
</tr>
</tbody>
</table>
Camera maintenance

<table>
<thead>
<tr>
<th>Size</th>
<th>RAW</th>
<th>RAW + S.Fine</th>
<th>RAW + Fine</th>
<th>RAW + Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>12m</td>
<td>73</td>
<td>51</td>
<td>59</td>
<td>69</td>
</tr>
<tr>
<td>10m</td>
<td>74</td>
<td>54</td>
<td>61</td>
<td>71</td>
</tr>
<tr>
<td>7m</td>
<td>76</td>
<td>57</td>
<td>64</td>
<td>73</td>
</tr>
<tr>
<td>6m</td>
<td>78</td>
<td>60</td>
<td>67</td>
<td>75</td>
</tr>
<tr>
<td>5m</td>
<td>78</td>
<td>60</td>
<td>67</td>
<td>75</td>
</tr>
<tr>
<td>3m</td>
<td>83</td>
<td>69</td>
<td>74</td>
<td>80</td>
</tr>
<tr>
<td>2m</td>
<td>87</td>
<td>77</td>
<td>81</td>
<td>85</td>
</tr>
<tr>
<td>1m</td>
<td>89</td>
<td>81</td>
<td>84</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>91</td>
<td>87</td>
<td>88</td>
<td>90</td>
</tr>
</tbody>
</table>

The figures above are measured without using the zoom function. Available recording time may vary if you use the zoom. Several videos were recorded in succession to determine the total recording time.

### Video

<table>
<thead>
<tr>
<th>Size</th>
<th>480fps</th>
<th>240fps</th>
<th>120fps</th>
<th>30fps</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 X 1080</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Approx. 19' 05&quot;</td>
</tr>
<tr>
<td>1280 X 720</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Approx. 29' 38&quot;</td>
</tr>
<tr>
<td>640 X 480</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Approx. 57' 16&quot;</td>
</tr>
<tr>
<td>For Sharing</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Approx. 716' 50&quot;</td>
</tr>
<tr>
<td>640 X 480</td>
<td>-</td>
<td>-</td>
<td>Approx. 24' 52&quot;</td>
<td>-</td>
</tr>
<tr>
<td>384 X 288</td>
<td>-</td>
<td>Approx. 32' 49&quot;</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>192 X 144</td>
<td>Approx. 26' 02&quot;</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
Appendixes 162

Camera maintenance

Cautions when using memory cards

- Avoid exposing memory cards to very cold or very hot temperatures (below 0 °C/32 °F or above 40 °C/104 °F). Extreme temperatures can cause memory cards to malfunction.
- Insert a memory card in the correct direction. Inserting a memory card in the wrong direction may damage your camera and memory card.
- Do not use memory cards that have been formatted by other cameras or by a computer. Reformat the memory card with your camera.
- Turn off the camera when you insert or remove the memory card.
- Do not remove the memory card or turn off your camera while the lamp is blinking, as this may damage your data.
- When the lifespan of a memory card has expired, you cannot store any more photos on the card. Use a new memory card.
- Do not bend, drop, or subject memory cards to heavy impact or pressure.
- Avoid using or storing memory cards near strong magnetic fields.
- Avoid using or keeping memory cards in areas with high temperature, high humidity, or corrosive substances.
- Prevent memory cards from making contact with liquids, dirt, or foreign substances. If dirty, wipe the memory card clean with a soft cloth before you insert the memory card in your camera.
- Do not allow liquids, dirt, or foreign substances to come in contact with memory cards or the memory card slot. Doing so may cause memory cards or the camera to malfunction.
- When you carry a memory card, use a case to protect the card from electrostatic discharges.
- Transfer important data to other media, such as a hard disk, CD, or DVD.
- When you use the camera for an extended period, the memory card may become warm. This is normal and does not indicate a malfunction.

⚠️ The manufacturer is not responsible for any loss of data.
About the battery
Use only Samsung-approved batteries.

Battery specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>SLB-10A</td>
</tr>
<tr>
<td>Type</td>
<td>Lithium-ion battery</td>
</tr>
<tr>
<td>Cell capacity</td>
<td>1,030 mAh</td>
</tr>
<tr>
<td>Voltage</td>
<td>3.7 V</td>
</tr>
<tr>
<td>Charging time* (when the camera is switched off)</td>
<td>Approximately 240 min</td>
</tr>
</tbody>
</table>

* Charging the battery by connecting it to a computer may take longer.

Battery life

<table>
<thead>
<tr>
<th>Average shooting time/ Number of photos</th>
<th>Test conditions (when the battery is fully charged)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photos</td>
<td>The battery life was measured under the following conditions: in P mode, in darkness, resolution, Fine quality, OIS on.</td>
</tr>
<tr>
<td>Approximately 120 min/ Approximately 240 photos</td>
<td>1. Set the flash option to Fill in, take a single shot, and zoom in or out.</td>
</tr>
<tr>
<td></td>
<td>2. Set the flash option to Off, take a single shot, and zoom in or out.</td>
</tr>
<tr>
<td></td>
<td>3. Perform steps 1 and 2, waiting 30 seconds between each step. Repeat the process for 5 minutes, and then turn off the camera for 1 minute.</td>
</tr>
<tr>
<td></td>
<td>4. Repeat steps 1 to 3.</td>
</tr>
<tr>
<td>Videos</td>
<td>Record videos at resolution and 30 FPS.</td>
</tr>
<tr>
<td>Approximately 90 min</td>
<td></td>
</tr>
</tbody>
</table>

- The figures above are measured by Samsung’s standards. Your results may differ, depending on your actual usage.
- Several videos were recorded in succession to determine the total recording time.
- When using network functions, the battery will be depleted more quickly.
Camera maintenance

**Low battery message**
When the battery has fully discharged, the battery icon will turn red and the "Low Battery" message will appear.

**Notes about using the battery**
- Avoid exposing batteries to very cold or very hot temperatures (below 0 °C/32 °F or above 40 °C/104 °F). Extreme temperatures can reduce the charging capacity of your batteries.
- When you use the camera for an extended period, the area around the battery chamber may become warm. This does not affect the normal use of the camera.
- Do not pull the power supply cord to disconnect the plug from the power outlet, as this may cause a fire or electric shock.
- In temperatures below 0 °C/32 °F, battery capacity and battery life may decrease.
- Battery capacity may decrease in low temperatures but will return to normal in milder temperatures.

**Cautions about using the battery**

Protect batteries, chargers, and memory cards from damage
Prevent batteries from making contact with metal objects, as this can create a connection between the + and – terminals of your battery and lead to temporary or permanent battery damage and may cause a fire or electric shock.

**Notes about charging the battery**
- If the indicator light is off, make sure that the battery is inserted correctly.
- If the camera is on while charging, the battery will not charge. Turn off the camera before charging the battery.
- Do not use your camera when you charge the battery. This may cause a fire or electric shock.
- Do not pull the power supply cord to disconnect the plug from the power outlet, as this may cause a fire or electric shock.
- Let the battery charge for at least 10 minutes before turning on the camera.
- If you connect the camera to an external power source while the battery is depleted, using some high energy-consuming functions will cause the camera to turn off. To use the camera normally, recharge the battery.
Camera maintenance

- If you reconnect the power cable when the battery is fully charged, the status lamp turns on for approximately 30 minutes.
- Using the flash or recording videos depletes the battery quickly. Charge the battery until the red status lamp turns off.
- If the status lamp blinks in red, reconnect the cable, or remove the battery and insert it again.
- If you charge the battery when the cable is overheated or the temperature is too high, the status lamp may blink in red. Charging will start when the battery cools down.
- Overcharging batteries may shorten battery life. After charging is finished, disconnect the cable from your camera.
- Do not bend or place heavy objects on the AC cable. Doing so may damage the cable.

Notes about charging with a computer connected
- Use only the provided USB cable.
- The battery may not charge when:
  - you use a USB hub
  - other USB devices are connected to your computer
  - you connect the cable to the port on the front side of your computer
  - the USB port of your computer does not support the power output standard (5 V, 500 mA)

Handling and disposing of batteries and chargers with care
- Never dispose of batteries in a fire. Follow all local regulations when you dispose of used batteries.
- Never place batteries or cameras on or in heating devices, such as microwave ovens, stoves, or radiators. Batteries may explode when they are overheated.
Camera maintenance

⚠ Personal injury or death can occur if the battery is handled carelessly or improperly. For your safety, follow these instructions for proper battery handling:
  • The battery can ignite or explode if not handled properly. If you notice any deformities, cracks, or other abnormalities in the battery, immediately discontinue use of the battery and contact a service center.
  • Use only authentic, manufacturer-recommend battery chargers and adapters and charge the battery only by the methods described in this user manual.
  • Do not place the battery near heating devices or expose it to excessively warm environments, such as the inside of an enclosed car in the summertime.
  • Do not place the battery in a microwave oven.
  • Avoid storing or using the battery in hot, humid places, such as spas or shower enclosures.
  • Do not rest the device on flammable surfaces, such as bedding, carpets, or electric blankets for a prolonged period.
  • When the device is switched on, do not leave it in any confined space for a prolonged period.
  • Do not allow battery terminals to come in contact with metallic objects, such as necklaces, coins, keys, or watches.
  • Use only authentic, manufacturer-recommended, Lithium-ion replacement batteries.

• Do not disassemble or puncture the battery with any sharp object.
• Avoid exposing the battery to high pressure or crushing forces.
• Avoid exposing the battery to major impacts, such as dropping it from high places.
• Do not expose the battery to temperatures of 60 °C (140 °F) or above.
• Do not allow the battery to come in contact with moisture or liquids.
• Do not expose the battery to sources of excessive heat such as sunshine, fire or the like.

Disposal guidelines
  • Dispose of the battery with care.
  • Do not dispose of the battery in a fire.
  • Disposal regulations may differ by country or region. Dispose of the battery in accordance with all local and federal regulations.

Guidelines for charging the battery
Charge the battery only by the method described in this user manual. The battery can ignite or explode if not charged properly.
Using optional accessories

Using optional flash units
Attach an optional flash unit to the camera accessory shoe. Remove the accessory shoe cover and mount the flash unit on the accessory shoe.

- Your camera is compatible with the following types of flash units: SEF42A
- For details about the flash unit, see the manual provided with the flash unit.
- When the optional flash unit is attached, do not pop the default flash up.

Using an optional optical viewfinder
Attach an optional optical viewfinder to the camera accessory shoe. Remove the accessory shoe cover and mount the optical viewfinder on the accessory shoe.
Using optional accessories

Using an optional conversion lens
You can increase your camera's range and depth of field by attaching an optional conversion lens designed only for Samsung cameras.

1. Remove the stock camera ring by turning it counterclockwise.

2. Mount the conversion lens by turning it clockwise until it locks into place.

3. In Shooting or Playback mode, press [MENU].

4. Select  
   Conversion lens  →  On.

- After setting to use the conversion lens, the optical and digital zooms are not available.
- If you do not set Conversion lens to On after attaching the conversion lens, rotating [Zoom] left or right will turn your camera off.
Using optional accessories

**Using the shutter release**
Use an optional shutter release to minimize camera shake and allow you to capture clearer photos at slower shutter speeds. For details about the shutter release, see the manual provided with the shutter release.

**Using the microphone**
Use an optional microphone to reduce noise surroundings. For details about the microphone, see the manual provided with the microphone.
## Before contacting a service center

If you are having trouble with your camera, try these troubleshooting procedures before you contact a service center. If you have attempted the suggested remedy and are still having problems with your device, contact your local dealer or service center.

![Tip] When you leave your camera at a service center, be sure to also leave the other components that may have contributed to the malfunction, such as the memory card and battery.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Suggested remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot turn on the camera</td>
<td>• Ensure that the battery is inserted.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the battery is inserted correctly. (p. 22)</td>
</tr>
<tr>
<td></td>
<td>• Charge the battery.</td>
</tr>
<tr>
<td>The power turns off suddenly</td>
<td>• Charge the battery.</td>
</tr>
<tr>
<td></td>
<td>• Your camera may be in Auto power off mode. (p. 152)</td>
</tr>
<tr>
<td></td>
<td>• The camera may turn off to prevent the memory card from being damaged due to an impact. Turn on your camera again.</td>
</tr>
<tr>
<td>The camera is losing battery power quickly</td>
<td>• The battery may lose power more quickly in low temperatures (below 0 °C/32 °F). Keep the battery warm by putting it into your pocket.</td>
</tr>
<tr>
<td></td>
<td>• Using the flash or recording videos depletes the battery quickly. Recharge if needed.</td>
</tr>
<tr>
<td></td>
<td>• Batteries are consumable parts that must be replaced over time. Get a new battery if the battery life is diminishing quickly.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Situation</th>
<th>Suggested remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot capture photos</td>
<td>• There is no space on the memory card. Delete unnecessary files or insert a new card.</td>
</tr>
<tr>
<td></td>
<td>• Format the memory card.</td>
</tr>
<tr>
<td></td>
<td>• The memory card is defective. Get a new memory card.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the camera is switched on.</td>
</tr>
<tr>
<td></td>
<td>• Charge the battery.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the battery is inserted correctly.</td>
</tr>
<tr>
<td>The camera freezes</td>
<td>Remove the battery and insert it again.</td>
</tr>
<tr>
<td>The camera heats up</td>
<td>While you use the camera, it may heat up. This is normal and should not affect your camera’s lifespan or performance.</td>
</tr>
<tr>
<td>The flash does not work</td>
<td>• Pop the flash up by sliding the flash release.</td>
</tr>
<tr>
<td></td>
<td>• The flash option may be set to Off. (p. 69)</td>
</tr>
<tr>
<td></td>
<td>• You cannot use the flash in some modes.</td>
</tr>
</tbody>
</table>
Before contacting a service center

<table>
<thead>
<tr>
<th>Situation</th>
<th>Suggested remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>The flash fires unexpectedly</td>
<td>The flash may fire due to static electricity. The camera is not malfunctioning.</td>
</tr>
<tr>
<td>The date and time are incorrect</td>
<td>Set the date and time in the display settings. (p. 151)</td>
</tr>
<tr>
<td>The display or buttons do not work</td>
<td>Remove the battery, and then insert it again.</td>
</tr>
<tr>
<td>The camera display responds poorly</td>
<td>If you use your camera at very low temperatures, it may cause the camera screen to malfunction or discolor. For better performance of your camera screen, use your camera in moderate temperatures.</td>
</tr>
<tr>
<td>The memory card has an error</td>
<td>• Turn off your camera, and then turn it on again.</td>
</tr>
<tr>
<td></td>
<td>• Remove your memory card, and then insert it again.</td>
</tr>
<tr>
<td></td>
<td>• Format your memory card. See “Cautions when using memory cards” for more detail. (p. 162)</td>
</tr>
<tr>
<td>Cannot play back files</td>
<td>If you change the name of a file, your camera may not play the file (the name of the file should meet the DCF standard). If you encounter this situation, play back the files on your computer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Situation</th>
<th>Suggested remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>The photo is blurry</td>
<td>• Make sure that the focus option you set is suitable for close-up shots. (p. 72)</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the lens is clean. If not, clean the lens. (p. 157)</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the subject is within range of the flash. (p. 174)</td>
</tr>
<tr>
<td>The colors in the photo do not match the actual scene</td>
<td>An incorrect White Balance can create unrealistic color. Select the proper White Balance option to suit the light source. (p. 84)</td>
</tr>
<tr>
<td>The photo is too bright</td>
<td>Your photo is overexposed.</td>
</tr>
<tr>
<td></td>
<td>• Turn off the flash. (p. 69)</td>
</tr>
<tr>
<td></td>
<td>• Adjust the ISO sensitivity. (p. 71)</td>
</tr>
<tr>
<td></td>
<td>• Adjust the exposure value. (p. 82)</td>
</tr>
<tr>
<td>The photo is too dark</td>
<td>Your photo is underexposed.</td>
</tr>
<tr>
<td></td>
<td>• Turn on the flash. (p. 69)</td>
</tr>
<tr>
<td></td>
<td>• Adjust the ISO sensitivity. (p. 71)</td>
</tr>
<tr>
<td></td>
<td>• Adjust the exposure value. (p. 82)</td>
</tr>
<tr>
<td>The TV does not display your photos</td>
<td>• Make sure that the camera is correctly connected to the TV with the A/V cable.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that your memory card contains photos.</td>
</tr>
</tbody>
</table>
### Before contacting a service center

<table>
<thead>
<tr>
<th>Situation</th>
<th>Suggested remedies</th>
</tr>
</thead>
</table>
| Your computer does not recognize your camera                             | • Make sure that the USB cable is connected correctly.  
• Make sure that your camera is switched on.  
• Make sure that you are using a supported operating system.                                                                                                                                                                                                                             |
| Your computer disconnects the camera while transferring files            | The file transmission may be interrupted by static electricity. Disconnect the USB cable and connect it again.                                                                                                                                                                                                                                       |
| Your computer cannot play videos                                         | Videos may not play on some video player programs. To play video files captured with your camera, use the Multimedia Viewer program that you can install with the iLauncher program on your computer. (p. 117)                                                                                                                                                  |
| iLauncher is not functioning properly                                   | • End iLauncher and restart the program.  
• Depending on your computer’s specifications and environment, the program may not launch automatically. In this case, click **Start** → **All Programs** → **Samsung** → **iLauncher** → **Samsung iLauncher** on your Windows OS computer. Or, click **Applications** → **Samsung** → **iLauncher** on your Mac OS computer. |

<table>
<thead>
<tr>
<th>Situation</th>
<th>Suggested remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your TV or computer cannot display photos and videos that are stored on an SDXC memory card</td>
<td>SDXC memory cards use the exFAT file system. Ensure that the external device is compatible with the exFAT file system before connecting the camera to the device.</td>
</tr>
<tr>
<td>Your computer does not recognize an SDXC memory card</td>
<td>SDXC memory cards use the exFAT file system. To use SDXC memory cards on a Windows XP computer, download and update the exFAT file system driver from the Microsoft website.</td>
</tr>
<tr>
<td>Cannot set the DPOF for RAW files</td>
<td>You cannot set the DPOF for RAW files.</td>
</tr>
<tr>
<td>Cannot lock the exposure value by pressing [AEL]</td>
<td>You cannot lock the exposure value in some shooting modes.</td>
</tr>
<tr>
<td>External flash or microphone does not work</td>
<td>Ensure that the external device is properly mounted and turned on.</td>
</tr>
</tbody>
</table>
## Camera specifications

### Image sensor
- **Type**: 1/1.7" (Approximately 9.33 mm) BSI CMOS
- **Effective pixels**: Approximately 12.4 mega-pixels
- **Total pixels**: Approximately 12.76 mega-pixels

### Lens
- **Focal length**: Schneider-KREUZNACH Lens f = 5.2–17.2 mm (35 mm film equivalent: 24–80 mm)
- **F-stop range**: F1.4 (W)–F2.7 (T), Include ND filter
- **Digital zoom**: Still image mode: 1.0–4.0X (Smart zoom: 1.33X, Optical zoom: 3.3X)

### Display
- **Type**: AMOLED
- **Feature**: 3.0" (7.6 cm) VGA, 614k dots (PenTile), Rotating

### Focusing
- **Type**: TTL auto focus (Multi AF, Center AF, Selection AF, Face Detection AF, Tracking AF, Smart Face Recognition AF), Manual Focus

### Range
<table>
<thead>
<tr>
<th></th>
<th>Wide (W)</th>
<th>Tele (T)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (AF)</td>
<td>40 cm–infinity</td>
<td>100 cm–infinity</td>
</tr>
<tr>
<td>Macro</td>
<td>1–40 cm</td>
<td>40–100 cm</td>
</tr>
<tr>
<td>Auto Macro</td>
<td>1 cm–infinity</td>
<td>40 cm–infinity</td>
</tr>
<tr>
<td>Manual Focus</td>
<td>1 cm–infinity</td>
<td>40 cm–infinity</td>
</tr>
</tbody>
</table>

### Shutter speed
<table>
<thead>
<tr>
<th></th>
<th>Wide (W)</th>
<th>Tele (T)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>1/8–1/2,000 sec.</td>
<td>1/8–1/4,000 sec.</td>
</tr>
<tr>
<td>Program</td>
<td>1–1/2,000 sec.</td>
<td>1–1/4,000 sec.</td>
</tr>
<tr>
<td>Night</td>
<td>8–1/2,000 sec.</td>
<td>8–1/4,000 sec.</td>
</tr>
<tr>
<td>Manual</td>
<td>30–1/2,000 sec.</td>
<td>30–1/4,000 sec.</td>
</tr>
</tbody>
</table>

### Exposure
- **Control**: Program AE, Shutter Priority AE, Aperture Priority AE, Manual Exposure
- **Metering**: Multi, Spot, Center-weighted, Face Detection
- **Compensation**: ±2EV (1/3 EV Step)
### Camera specifications

| ISO equivalent | Auto, ISO 80, ISO 100, ISO 200, ISO 400, ISO 800, ISO 1600, ISO 3200, ISO 6400*, ISO 12800*  
|                | * Available only when ISO Expansion is activated. |

<table>
<thead>
<tr>
<th><strong>Flash</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
<td>Auto, Red-eye, Fill in, Slow Sync, Off, Red-eye Fix</td>
</tr>
</tbody>
</table>
| **Range** | • Wide: 0.9–7.8 m (ISO Auto)  
|           | • Tele: 0.8–4.1 m (ISO Auto) |
| **Flash Compensation** | ±1EV (1/2 EV Step) |
| **Recharging time** | Approximately 4 sec. |

| **Shake reduction** | DUAL IS [Optical Image Stabilization (OIS) + Digital Image Stabilization (DIS)] |

<table>
<thead>
<tr>
<th><strong>Effect</strong></th>
<th></th>
</tr>
</thead>
</table>
| **Photo Shooting mode** | • Smart Filter: Normal, Miniature, Vignetting, Soft Focus, Old Film, Half Tone Dot, Sketch, Fish-eye, Classic, Retro, Oil Painting, Cartoon, Ink Painting, Cross Filter, Zooming Shot  
|           | • Artistic Brush  
|           | • Image Adjust: Contrast, Sharpness, Saturation |

| **Video Shooting mode** | Smart Filter: Normal, Palette Effect 1, Palette Effect 2, Palette Effect 3, Palette Effect 4, Miniature, Vignetting, Half Tone Dot, Sketch, Fish-eye, Classic, Retro |

<table>
<thead>
<tr>
<th><strong>White Balance</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
<td>Auto WB, Daylight, Cloudy, Fluorescent_H, Fluorescent_L, Tungsten, Custom Set, Color Temp.</td>
</tr>
<tr>
<td><strong>Micro adjustment</strong></td>
<td>Each 7 steps in Amber/Blue/Green/Magenta axis</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Date Imprinting</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date &amp; Time, Date, Off</strong></td>
<td></td>
</tr>
</tbody>
</table>
## Camera specifications

### Shooting

<table>
<thead>
<tr>
<th>Photos</th>
<th>Videos</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Modes: Smart Auto (Portrait, Night Portrait, Backlight Portrait, Night, Backlight, Landscape, White, Natural Green, Blue Sky, Sunset, Macro, Macro text, Macro Color, Tripod, Action, Fireworks, Candle, Spotlight, Spotlight (Macro), Spotlight (Portrait)), Program, Aperture Priority, Shutter Priority, Manual, Scene (Beauty Shot, Night, Landscape, Text, Sunset, Dawn, Backlight, Beach &amp; Snow, 3D Photo), Magic Plus (Panorama, Magic Frame, Split Shot, Picture in Picture, Artistic Brush, HDR)</td>
<td>• Modes: Smart Scene Detection (Landscape, Blue Sky, Natural Green, Sunset), Movie, Magic Plus (Picture in Picture)</td>
</tr>
<tr>
<td>• Burst: Single, High-speed (10fps, 5fps, 3fps), Precapture, Bracket (WB, AE), Timer</td>
<td>• Format: MP4 (H.264) (Max recording time: 20 min)</td>
</tr>
<tr>
<td>• Timer: 10 Sec, 2 Sec</td>
<td>• Size: 1920 X 1080, 1280 X 720, 640 X 480, 320 X 240</td>
</tr>
<tr>
<td>• ND Filter effect: On, Off</td>
<td>• High-speed: 480fps (192 X 144), 240fps (384 X 288), 120fps (640 X 480)</td>
</tr>
</tbody>
</table>

### Playback

<table>
<thead>
<tr>
<th>Photos</th>
<th>Videos</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: Single image, Thumbnails, Multi Slide Show with Music and Effect, Movie clip, Smart Album*, Creative Movie Maker</td>
<td>Edit: Creative Movie Maker, Still image capture, Time trimming</td>
</tr>
<tr>
<td>• Edit: Resize, Rotate, Image Adjust, Smart Filter, Trim</td>
<td></td>
</tr>
<tr>
<td>• Effect: Image Adjust (Red-eye Fix, Face Retouch, Brightness, Contrast, Saturation, Add Noise), Smart Filter (Normal, Miniature, Vignetting, Soft Focus, Old Film, Half Tone Dot, Sketch, Fish-eye, Classic, Retro, Oil Painting, Cartoon, Ink Painting, Cross Filter, Zooming Shot)</td>
<td></td>
</tr>
</tbody>
</table>

### Storage

<table>
<thead>
<tr>
<th>Media</th>
<th>File format</th>
</tr>
</thead>
<tbody>
<tr>
<td>External memory (Optional): SD card (1–2 GB guaranteed), SDHC card (up to 32 GB guaranteed), SDXC card (up to 64 GB guaranteed)</td>
<td>• Still Image: JPEG (DCF), EXIF 2.21, DPOF 1.1</td>
</tr>
<tr>
<td></td>
<td>• Movie Clip: MP4 (Video: MPEG-4.AVC/H.264, Audio: AAC)</td>
</tr>
</tbody>
</table>
## Camera specifications

### For 2 GB SD: Number of photos

<table>
<thead>
<tr>
<th>Image size</th>
<th>Super Fine</th>
<th>Fine</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000 X 3000</td>
<td>277</td>
<td>313</td>
<td>503</td>
</tr>
<tr>
<td>4000 X 2672</td>
<td>254</td>
<td>349</td>
<td>558</td>
</tr>
<tr>
<td>4000 X 2248</td>
<td>286</td>
<td>392</td>
<td>623</td>
</tr>
<tr>
<td>3264 X 2448</td>
<td>335</td>
<td>457</td>
<td>721</td>
</tr>
<tr>
<td>2832 X 2832</td>
<td>333</td>
<td>456</td>
<td>719</td>
</tr>
<tr>
<td>2592 X 1944</td>
<td>512</td>
<td>691</td>
<td>1,060</td>
</tr>
<tr>
<td>1984 X 1488</td>
<td>819</td>
<td>1,081</td>
<td>1,588</td>
</tr>
<tr>
<td>1920 X 1080</td>
<td>1,095</td>
<td>1,418</td>
<td>2,009</td>
</tr>
<tr>
<td>1024 X 768</td>
<td>2,165</td>
<td>2,610</td>
<td>3,284</td>
</tr>
</tbody>
</table>

### Wireless network

- Mobile Link, Remote Viewfinder, Social Sharing, Email, Cloud, Auto Backup, TV Link, Wi-Fi Direct

### Interface

- **Digital output connector**: USB 2.0
- **Audio input/output**: Internal speaker (Mono), Microphone (Stereo)
- **Video output**:
  - AV: NTSC, PAL (selectable)
  - HDMI 1.4: NTSC, PAL (selectable)
- **DC power input connector**: 5 V

### Power source

- **Rechargeable battery**: Lithium-ion battery (SLB-10A, 1,030 mAh)
- **Connector type**: Micro USB (7 pin)

These figures are measured under Samsung’s standard conditions. Your results may vary depending on the shooting conditions and camera settings.
Camera specifications

<table>
<thead>
<tr>
<th><strong>Dimensions (W X H X D)</strong></th>
<th>112.1 X 62.4 X 27.55 mm (without protrusions)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weight</strong></td>
<td>286 g (without battery and memory card)</td>
</tr>
<tr>
<td><strong>Operating Temperature</strong></td>
<td>0–40 °C</td>
</tr>
<tr>
<td><strong>Operating Humidity</strong></td>
<td>5–85 %</td>
</tr>
<tr>
<td><strong>Software</strong></td>
<td>iLauncher, Samsung RAW Converter</td>
</tr>
</tbody>
</table>

Specifications may change without notice to improve performance.
Glossary

AEB (Auto Exposure Bracket)
This feature automatically captures several images at different exposures to help you capture a properly-exposed image.

AF (Auto Focus)
A system that automatically focuses the camera lens on the subject. Your camera uses the contrast to focus automatically.

Aperture
The aperture controls the amount of light that reaches the camera’s sensor.

Camera shake (Blur)
If the camera is moved while the shutter is open, the entire image may appear blurred. This occurs more often when the shutter speed is slow. Prevent camera shake by raising the sensitivity, using the flash, or using a faster shutter speed. Alternately, use a tripod, the DIS or OIS function to stabilize the camera.

Composition
Composition in photography means arranging objects in a photo. Usually, abiding by the rule of thirds leads to a good composition.

DCF (Design rule for Camera File system)
A specification to define a file format and file system for digital cameras created by the Japan Electronics and Information Technology Industries Association (JEITA).

Depth of field
The distance between the nearest and farthest points that can be acceptably focused in a photograph. Depth of field varies with lens aperture, focal length, and distance from the camera to the subject. Selecting a smaller aperture, for example, will increase the depth of field and blur the background of a composition.

Digital zoom
A feature that artificially increases the amount of zoom available with a zoom lens (Optical zoom). When using the Digital zoom, the image quality will deteriorate as the magnification increases.

DPOF (Digital Print Order Format)
A format for writing printing information, such as selected images and number of prints, on a memory card. DPOF-compatible printers, sometimes available at photo shops, can read the information from the card for convenient printing.
Glossary

EV Compensation
All the combinations of the camera’s shutter speed and lens aperture that result in the same exposure.

EV (Exposure Value)
This feature allows you to quickly adjust the exposure value measured by the camera, in limited increments, to improve the exposure of your photos. Set the EV compensation to -1.0 EV to adjust the value one step darker and 1.0 EV to one step brighter.

Exif (Exchangeable Image File Format)
A specification to define an image file format for digital cameras created by the Japan Electronic Industries Development Association (JEIDA).

Exposure
The amount of light allowed to reach the camera’s sensor. Exposure is controlled by a combination of the shutter speed, the aperture value, and ISO sensitivity.

Flash
A speed light that helps to create adequate exposure in low-light conditions.

Focal length
The distance from the middle of the lens to its focal point (in millimeters). Longer focal lengths result in narrower angles of view and the subject is magnified. Shorter focal lengths result in wider angles of view.

Histogram
A graphical representation of the brightness of an image. The horizontal axis represents the brightness and the vertical axis represents the number of pixels. High points at the left (too dark) and right (too bright) on the histogram indicate a photo that is improperly exposed.

H.264/MPEG-4
A high-compression video format established by international standard organizations ISO-IEC and ITU-T and developed by the Joint Video Team (JVT). This codec is capable of providing good video quality at low bit rates.

Image sensor
The physical part of a digital camera that contains a photosite for each pixel in the image. Each photosite records the brightness of the light that strikes it during an exposure. Common sensor types are CCD (Charge-coupled Device) and CMOS (Complementary Metal Oxide Semiconductor).
ISO sensitivity
The sensitivity of the camera to light, based on the equivalent film speed used in a film camera. At higher ISO sensitivity settings, the camera uses a higher shutter speed, which can reduce blur caused by camera shake and low light. However, images with high sensitivity are more susceptible to noise.

JPEG (Joint Photographic Experts Group)
A lossy method of compression for digital images. JPEG images are compressed to reduce their overall file size with minimal deterioration of the image resolution.

LCD (Liquid Crystal Display)
A visual display commonly used in consumer electronics. This display needs a separate backlight, such as CCFL or LED, to reproduce colors.

Macro
This feature allows you to capture close-up photos of very small objects. When using the macro feature, the camera can maintain a sharp focus on small objects at a near life-size ratio (1:1).

Metering
The metering refers to the way in which the camera measures the quantity of light to set the exposure.

MJPEG (Motion JPEG)
A video format which is compressed as a JPEG image.

MPO (Multi Picture Object)
An image file format that contains multiple images in a file. An MPO file provides a 3D effect on MPO-compatible displays, such as 3D TVs or 3D monitors.

Noise
Misinterpreted pixels in a digital image that may appear as misplaced or random, bright pixels. Noise usually occurs when photos are shot with a high sensitivity or when a sensitivity is automatically set in a dark place.

OIS (Optical Image Stabilization)
This feature compensates in real-time for shaking and vibrating while shooting. There is no image degradation compared to Digital Image Stabilization feature.

Optical zoom
This is a general zoom which can enlarge images with a lens and does not deteriorate quality of images.
Glossary

Quality
An expression of the rate of compression used in a digital image. Higher quality images have a lower rate of compression, which usually results in a larger file size.

Resolution
The number of pixels present in a digital image. High resolution images contain more pixels and typically show more detail than low resolution images.

Shutter speed
Shutter speed refers to the amount of time it takes to open and close the shutter, and it is an important factor in the brightness of a photo, as it controls the amount of light which passes through the aperture before it reaches the image sensor. A fast shutter speed allows less time to let light in and the photo becomes darker and more easily freezes subjects in motion.

Smart zoom
Smart zoom lets you zoom in with less degradation of picture quality than the optical zoom and digital zoom.

Vignetting
A reduction of an image’s brightness or saturation at the periphery (outer edges) compared to the center of the image. Vignetting can draw interest to subjects positioned in the center of an image.

White balance (color balance)
An adjustment of the intensities of colors (typically the primary colors red, green, and blue), in an image. The goal of adjusting the white balance, or color balance, is to correctly render the colors in an image.
Correct Disposal of This Product
(Waste Electrical & Electronic Equipment)
(Applicable in countries with separate collection systems)

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to promote the sustainable reuse of material resources.

Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and how they can take these items for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic accessories should not be mixed with other commercial wastes for disposal.

Correct disposal of batteries in this product
(Applicable in countries with separate collection systems)

This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed of with other household waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to human health or the environment.

To protect natural resources and to promote material reuse, please separate batteries from other types of waste and recycle them through your local, free battery return system.

This Class [B] digital apparatus complies with Canadian ICES-003.

PlanetFirst represents Samsung Electronics’ commitment to sustainable development and social responsibility through eco-driven business and management activities.

Dispose unwanted electronics through an approved recycler. To find the nearest recycling location, go to our website: www.samsung.com/recyclingdirect Or call, (877) 278 - 0799
FCC notice

Caution:
Any changes or modifications in construction of this device which are not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

NOTE:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorientate or relocate the receiving antenna.
- Increase the distance between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

• Declaration of Conformity
  Trade Name: Samsung Electronics America, Inc.
  Model No.: Samsung EX2F
  Responsible Party: Samsung Electronics America, Inc.
  Address: 85 Challenger Road, Ridgefield Park, NJ 07660
  Telephone No.: 1-800-SAMSUNG (726-7864)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

FCC ID: A3LEX2F

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

RF exposure statements:
This device is for handheld operation only. The antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all persons and must not be co-located or operating in conjunction with any other antenna or transmitter.
CAUTION
RISK OF EXPLOSION IF BATTERY IS REPLACED BY AN INCORRECT TYPE.
DISPOSE OF USED BATTERIES ACCORDING TO THE INSTRUCTIONS.

Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause undesired operation.

Caution:
Any changes or modifications to the equipment not expressly approved by the party responsible for compliance could void user’s authority to operate the equipment.
IC: 649E-EX2F

This equipment may be operated in all EU countries. In France, this equipment may only be used indoors.
Declaration of Conformity

Product details

For the following

Product: DIGITAL CAMERA
Model(s): EX2F

Declaration & Applicable standards

We hereby declare that the product(s) above is(are) in compliance with the essential requirements and other provisions of the R&TTE Directive (1999/5/EC), the Low Voltage Directive (2006/95/EC) and the Electromagnetic Compatibility Directive (2004/108/EC) by application of:

EN 60950-1:2006+A1:2010
EN 61000-3-3:2008
EN 300 328 v1.7.1
EN 301 489-1 v1.8.1
EN 301 489-17 V2.1.1
EN62311 :2008


Representative in the EU

Samsung Electronics Euro QA Lab.
Blackbushe Business Park
Saxony Way, Yateley, Hampshire
GU46 6GG, UK

26 June, 2012

Joong-Hoon Choi / Lab. Manager

(YEAR TO BEGIN AFFIXING CE MARKING 2012)

(Name and signature of authorized person)

* This is not the address of Samsung Service Centre. For the address or the phone number of Samsung Service Centre, see the warranty card or contact the retailer where you purchased your product.
<table>
<thead>
<tr>
<th>Nation</th>
<th>Declaration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cesky</td>
<td>Samsung Electronics tímto prohlašuje, že tento digitální fotoaparát je ve shodě se základními požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.</td>
</tr>
<tr>
<td>Dansk</td>
<td>Samsung Electronics erklærer herved, at digitale kameraer overholder de væsentlige krav og øvrige relevante krav i direktiv 1999/5/EF.</td>
</tr>
<tr>
<td>Deutsch</td>
<td>Hiermit erklärt Samsung Electronic, dass sich die Digitalkamera in Übereinstimmung mit den grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG befindet.</td>
</tr>
<tr>
<td>Eesti</td>
<td>Käesolevaga kinnitab Samsung Electronics digitaalkaamera vastavust direktiivi 1999/5/EÜ põhinõuetele ja nimetatud direktiivist tulenevatele teistele asjakohastele sättetele.</td>
</tr>
<tr>
<td>English</td>
<td>Hereby, Samsung Electronics declares that this digital camera is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.</td>
</tr>
<tr>
<td>Español</td>
<td>Por medio de la presente Samsung Electronics declara que la cámara digital cumple con los requisitos esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.</td>
</tr>
<tr>
<td>Ελληνική</td>
<td>ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ η Samsung Electronics ΔΗΛΩΝΕΙ ΟΤΙ η ψηφιακή φωτογραφική μηχανή ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.</td>
</tr>
<tr>
<td>Français</td>
<td>Par la présente Samsung Electronic déclare que l’appareil photo numérique est conforme aux exigences essentielles et aux autres dispositions pertinentes de la directive 1999/5/CE.</td>
</tr>
<tr>
<td>Italiano</td>
<td>Con la presente Samsung Electronics dichiara che questa fotocamera digitale è conforme ai requisiti essenziali e alle altre disposizioni stabilite dalla Direttiva 1999/5/CE.</td>
</tr>
<tr>
<td>Latviski</td>
<td>Ar šo Samsung Electronics deklarē, ka digitālā kamera atbilst Direktīvas 1999/5/EK būtiskajām prasībām un cītiem ar to saistītajiem noteikumiem.</td>
</tr>
<tr>
<td>Nederlands</td>
<td>Hierbij verklaart Samsung Electronics dat de digitale camera in overeenstemming is met de essentiële eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.</td>
</tr>
<tr>
<td>Nation</td>
<td>Declaration</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Malti</td>
<td>Hawnekk, Samsung Electronics, tiddikjara li din il-kamera digitali hi konformi mar-rekwiżiti essenzjali u ma' dispożizzjonijiet rilevanti oħrajn ta' Direttiva 1999/5/KE.</td>
</tr>
<tr>
<td>Magyar</td>
<td>A Samsung Electronics kijelenti, hogy ez a digitális fényképezőgép megfelel az 1999/5/EK irányelv alapvető követelményeinek és egyéb vonatkozó előírásainak.</td>
</tr>
<tr>
<td>Polski</td>
<td>Niniejszym firma Samsung Electronics oświadcz, że ten aparat cyfrowy jest zgodny z zasadniczymi wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/WE.</td>
</tr>
<tr>
<td>Português</td>
<td>Samsung Electronics declara que esta câmera digital está conforme os requisitos essenciais e outras disposições da Directiva 1999/5/CE.</td>
</tr>
<tr>
<td>Slovensko</td>
<td>Samsung Electronics izjavlja, da je ta digitalni fotoaparat v skladu z bistvenimi zahtevami in ostalimi relevantnimi določili direktive 1999/5/ES.</td>
</tr>
<tr>
<td>Slovensky</td>
<td>Samsung Electronics týmto vyhlasuje, že tento digitálny fotoaparát spĺňa základné požiadavky a všetky príslušné ustanovenia Smernice 1999/5/ES.</td>
</tr>
<tr>
<td>Suomi</td>
<td>Samsung Electronics vakuuttaa täten että tämä digitaalikamera on direktiivin 1999/5/EY oleellisten vaatimusten ja sitä koskevien direktiivin muiden ehtojen mukainen.</td>
</tr>
<tr>
<td>Svenska</td>
<td>Härmed intygar Samsung Electronicsatt dessa digtalkameror står i överensstämme med de väsentliga egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.</td>
</tr>
<tr>
<td>Български</td>
<td>С настоящото Samsung Electronics декларира, че този цифров фотоапарат е в съответствие със съществените изисквания и другите приложими разпоредби на Директива 1999/5/EK.</td>
</tr>
<tr>
<td>Română</td>
<td>Prin prezenta, Samsung Electronics, declară că această cameră foto digitală este în conformitate cu cerințele esențiale și alte prevederi relevante ale Directivei 1999/5/CE.</td>
</tr>
<tr>
<td>Norsk</td>
<td>Samsung Electronicserklærer herved at dette digitalkameraet er i samsvar med de grunnleggende krav og øvrige relevante krav i direktiv 1999/5/EF.</td>
</tr>
<tr>
<td>Türkçe</td>
<td>Bu belge ile, Samsung Electronics bu dijital kameranın 1999/5/EC Yönetmeliginin temel gerekliliklerine ve ilgili hükümlerine uygun olduğunu beyan eder.</td>
</tr>
<tr>
<td>Íslenska</td>
<td>Hér með lýsir Samsung Electronics því yfir að þessi stafræna myndavél sé í samræmi við grunnkröfur og önnur ákvæði tilskipunar 1999/5/EB.</td>
</tr>
</tbody>
</table>
Index

A

AF-assist light
Location 16
Settings 152

AF Lamp 152

AF Sound 150

Anynet+ 152

Aperture Priority mode 45

Aperture value 44

Auto Backup 141

Auto Exposure Bracket (AEB) 89

A/V port 17

B

Battery
Caution 164
Charging 23
Inserting 22

Beauty Shot mode 49

Blink Detection 79

Brightness
Playback mode 110
Shooting mode 82

Burst modes
Bracket 88
High-speed 87
Precapture 88

C

Camera maintenance 157

Camera specifications 173

Capturing an image from video 106

Charging 23

Cleaning
Camera body 157
Display 157
Lens 157

Connecting to a computer
Mac 116
Windows 118

Contrast
Playback mode 110
Shooting mode 93

D

Date/Time Set 151

Deleting files 101

Digital Print Order Format (DOF) 110

Digital zoom 35

Disconnecting the camera 115

Display brightness 150

Display type 32

Drive mode dial 19

E

Editing photos 107

Editing videos
Capturing 106
Trimming 105

Enlarging 102

Error messages 155

Exposure 82

F

Face Detection 77

Flash
Auto 69
Fill in 69
Intensity 70
Off 69
Red-eye 69
Red-eye Fix 69
Slow Sync 69
Index

Focus area
- Center AF 76
- Multi AF 76
- Selection AF 76
- Tracking AF 76

Formatting 152
Function button 18

G
Grid Line 150

H
Half-press shutter 38
HDMI Size 153
HDTV 113

I
Icons
- Playback mode 96
- Shooting mode 26

iLauncher 118

Image Adjustment
- Add Noise 110
- Brightness
  - Playback mode 110
  - Shooting mode 82
- Contrast
  - Playback mode 110
  - Shooting mode 93
- Red-eye 109
- Saturation
  - Playback mode 110
  - Shooting mode 93
- Sharpness 93

Image quality 66
Image Stabilization 37
Imprint 151
ISO sensitivity 71

L
Language settings 150

M
Macro
- Auto Macro 73
- Macro 73
- Manual Focus 73

Magic Plus mode
- Artistic Brush 56
- Creative Movie Maker 58
- HDR 57
- Magic Frame 53
- Picture in Picture 55
- Split Shot 54

Manual mode 47
Memory card
- Caution 162
- Insert 22

Menu button 18

N
ND filter 92

O
Optional accessories 15

Metering
- Center-weighted 84
- Multi 84
- Spot 84

Mode dial 18
Movie mode 60
My star
- Cancelling 98
- Ranking 97
- Registering 80
Appendixes 190

Index

P
Panorama 3D Panorama 50 Action Panorama 52 Live Panorama 50
Playback button 18 Playback mode 96 Power button 16 Program mode 43 Protecting files 100

Q
Quick view 150

R
Red-eye
  Playback mode 109
  Shooting mode 68
Remote Viewfinder 133
Reset 152
Resolution
  Playback mode 107
  Shooting mode 65
Retouching faces
  Playback mode 109
  Shooting mode 49
Rotating 107

S
Saturation
  Playback mode 110
  Shooting mode 93
Scene mode 48
Self portrait 77
Service center 170
Sharpness 93
Shooting portraits
  Beauty Shot mode 49
  Blink Detection 79
  Face Detection 77
  Red-eye 69
  Red-eye fix 69
  Self portrait 77
  Smart Face Recognition 79
  Smile Shot 78
Shutter button 16
Shutter Priority mode 46
Slide show 104
Smart Album 99
Smart Auto mode 41
Smart Face Recognition 79
Smart Filter
  Photo shooting mode 90
  Playback mode 108
  Video recording mode 91
Smart Scene Detection mode 63
Smart zoom 36
Smile Shot 78
Sound settings 33
Status lamp 17
**Index**

<table>
<thead>
<tr>
<th><strong>T</strong></th>
<th><strong>V</strong></th>
<th><strong>Z</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnails 100</td>
<td>Video 105</td>
<td>Zoom 35</td>
</tr>
<tr>
<td>Timer 67</td>
<td>Video out 153</td>
<td>Using the zoom 35</td>
</tr>
<tr>
<td>Shooting mode 67</td>
<td>Shooting mode 60</td>
<td>Zoom button 17</td>
</tr>
<tr>
<td>Time zone settings 24, 151</td>
<td>Viewing files 98</td>
<td>Zoom sound settings 60</td>
</tr>
<tr>
<td>Transferring files 141</td>
<td>Folder 98</td>
<td>3D Photo mode 50</td>
</tr>
<tr>
<td>Auto Backup 141</td>
<td>Slide show 104</td>
<td>3D TV 114</td>
</tr>
<tr>
<td>Email 137</td>
<td>Smart Album 99</td>
<td></td>
</tr>
<tr>
<td>Mac 116</td>
<td>Thumbnails 100</td>
<td></td>
</tr>
<tr>
<td>Windows 118</td>
<td>TV 112</td>
<td></td>
</tr>
<tr>
<td>Tripod mount 16</td>
<td><strong>W</strong></td>
<td></td>
</tr>
<tr>
<td>TV Link 143</td>
<td>Website 135</td>
<td></td>
</tr>
<tr>
<td><strong>U</strong></td>
<td>Accessing 135</td>
<td></td>
</tr>
<tr>
<td>Unpacking 15</td>
<td>Uploading photos or videos 135</td>
<td></td>
</tr>
<tr>
<td>USB port 17</td>
<td>White Balance 84</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wireless network 127</td>
<td></td>
</tr>
</tbody>
</table>
Please refer to the warranty that came with your product or visit our website, www.samsung.com, for after-sales service or inquiries.